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Welcome To TraceCalc Pro 2 

 

TraceCalc® Pro design software 

brings you the latest advances in 

automated heat-tracing design 

capabilities. It sets new standards in 

the features you need for simple or 

sophisticated designs. With its new 

intuitive user-friendly interface, you 

can create a heat-tracing design 

quickly and accurately. 

TraceCalc Pro provides design calculations such as pipe heat loss, number of 

circuits, electrical loads and maximum temperatures; and automated heating cable 

and component selection; and recommendations for control and monitoring 

selection, and much more. It provides easy-to-use standard reports; and last but not 

least, its powerful features help you obtain the best heat-tracing solution for your 

particular project. 

With TraceCalc Pro, Pentair Thermal Management provides you with an 

unprecedented design tool that lets you select heat-tracing products from world-class 

brands such as Raychem, DigiTrace, Tracer, and Pyrotenax—giving you an optimal 

heat-tracing solution.  

What Is TraceCalc Pro? 

Easy-to-use user interface – Designed for ease-of-use, TraceCalc Pro’s user 

interface is intuitive, easy to navigate, user friendly, and employs state-of-the-art 

technology. The project window displays three panes at a glance: the Project 

Explorer Pane for managing your design elements, the Design Pane for entering line 

parameters and design data, and the Calculated Results Pane for a quick view of 

calculated results. TraceCalc Pro is built on a database compatible with Microsoft 

Access, which simplifies the exchange of data to other applications. 

Various heater technologies in a single design program – TraceCalc Pro supports 

designs using self-regulating, power-limiting, and series heating cables, such as 

polymer and mineral insulated, in a single design program. It also supports the 

selection of more sophisticated control and monitoring devices.  

Complex circuit connectivity – TraceCalc Pro supports heat tracing for complex 

piping configurations and their electrical connectivity, such as tees, loops, splices, 

line continuations, and so on. Using the easy-to-manage Project Explorer Pane, 
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TraceCalc Pro now lets you create complex circuits with the ability to drag-and-drop 

pipe segments and their related attributes to other lines and associated areas. A pipe 

can now also have changing design parameters for the same heater circuit, for 

example, changes to diameters, insulation thickness, or other parameters. 

Multi-user design input – TraceCalc Pro allows multiple users to work 

simultaneously on a design project, which is very useful for large projects. 

Multiple valve and support types on a single line – TraceCalc Pro supports up to 

three different valve and support types on a single line that more accurately reflects 

real piping configurations. 

Automatically displays calculated design results – TraceCalc Pro lets you quickly 

view your design’s calculated results in the always-visible Calculated Results Pane.  
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1  Vital Information 

This help manual has been compiled based on version 2.0. As Pentair Thermal 

Management is continuously improving this software, the software you are using 

may include new features which are not documented in this help manual. Always 

refer to the release notes (readme.txt) which are shown during the installation 

process and also permanently stored in the directory of TraceCalc Pro (typically 

C:\Program Files\Pentair Thermal Management\TraceCalc Pro). You may direct 

questions about this software to PTM-info@pentair.com. 

Important: All information, including illustrations, is believed to be reliable. Users, 

however, should independently evaluate the suitability of each product for their 

particular application. Pentair Thermal Management makes no warranties as to the 

accuracy or completeness of the information, and disclaims any liability regarding its 

use. Pentair Thermal Management's only obligations are those in the Pentair Thermal 

Management Standard Terms and Conditions of Sale for this product, and in no case 

will Pentair Thermal Management or its distributors be liable for any incidental, 

indirect, or consequential damages arising from the sale, resale, use, or misuse of the 

product. Specifications are subject to change without notice. In addition, Pentair 

Thermal Management reserves the right to make changes—without notification to 

Buyer—to processing or materials that do not affect compliance with any applicable 

specification. 

License Agreement 
 TraceCalc Pro Program License Agreement  

This agreement is a legal agreement between you, "the end user" and Pentair 

Thermal Management, LLC ("Pentair Thermal Management"). BY INSTALLING 

OR OTHERWISE ACCESSING THIS PROGRAM, YOU ARE AGREEING TO 

BECOME BOUND BY THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT 

AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR 

ACCESS THIS PROGRAM, AND PROMPTLY RETURN THE DISK AND ALL 

OTHER ITEMS RECEIVED WITH THE DISK (INCLUDING WRITTEN 

MATERIALS OR OTHER CONTAINERS) TO THE PLACE WHERE YOU 

OBTAINED THEM. 

1. GRANT OF LICENSE   The TraceCalc Pro program is licensed, not 

sold, to you for use only under the terms of this Agreement, and Pentair 

Thermal Management reserves any rights not expressly granted to you.  

Pentair Thermal Management grants to you, the end user, the right to 

use this copy, including written materials if any, of the TraceCalc Pro 

program on a single computer at the location (company and address) to 

which Pentair Thermal Management issued this copy of the TraceCalc 

mailto:PTM-info@pentair.com
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Pro program.  The TraceCalc Pro program is owned by Pentair Thermal 

Management LLC and is protected by United States copyright laws and 

international treaty provisions.  You agree not to alter, merge, duplicate 

distribute, decompile or reverse engineer, create derivative works, copy 

for use on any other computer or at any other location, or otherwise 

make this program available to any person or entity outside this 

location.  All copies made by you are subject to the terms and 

conditions of this Agreement. 

2. OTHER RESTRICTIONS 

 You may not sublicense, rent or lease the TraceCalc Pro program 

to anyone. 

 You agree to notify Pentair Thermal Management promptly if 

“bugs” or seemingly incorrect or anomalous results are discovered 

or produced by the use of the TraceCalc Pro program. 

 You agree that the TraceCalc Pro program, including written 

materials (if any) and all copies in whole or in part, will be 

destroyed or returned to Pentair Thermal Management at the 

written request of the Pentair Thermal Management Product 

Manager. 

 By installing or otherwise accessing the TraceCalc Pro program, 

you acknowledge that you have read and understood Pentair 

Thermal Management’s Disclaimer of Warranty and Limitation of 

Liability, set forth below. 

 You agree to use reasonable efforts to protect against the 

unauthorized copying and use the TraceCalc Pro program by 

others.  

 You agree to register the TraceCalc Pro program within 30 days 

following its installation. If the trial period expires, you understand 

that until the registration process is completed the program will no 

longer function and you will not receive updates, patches, and 

correspondence which may affect the reliability of the program or 

the validity of its output. You further understand that if registration 

is not completed within 60 days following the expiration of the 30-

day trial period the license granted herein will terminate. 

3. DISCLAIMER OF WARRANTY   THE TRACECALC PRO 

PROGRAM AND ACCOMPANYING WRITTEN MATERIALS ARE 

PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND.  

THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 

OF THE TRACECALC PRO PROGRAM IS ASSUMED BY YOU.  

PENTAIR THERMAL MANAGEMENT DOES NOT WARRANT 

THAT THE FUNCTIONS CONTAINED IN THE TRACECALC PRO 

PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT THE 

OPERATION OF THE TRACECALC PRO PROGRAM WILL BE 

UNINTERRUPTED OR ERROR-FREE, OR THAT PROGRAM 

DEFECTS WILL BE CORRECTED.  It is assumed that the user of the 

TraceCalc Pro program is an expert in the engineering design of heat-

tracing systems.  Pentair Thermal Management has not verified the 

results produced by the TraceCalc Pro program for all conceivable 

design or analysis cases.  You must judge the reasonableness of the 

results obtained by using your engineering expertise, and should 
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independently evaluate the suitability of each calculated result for your 

specific application. 

4. LIMITED WARRANTY – MEDIA   THE MEDIUM ON WHICH 

THE PROGRAM IS ENCODED IS WARRANTED TO BE FREE 

FROM DEFECTS IN MATERIAL AND WORKMANSHIP UNDER 

NORMAL USE FOR A PERIOD OF SIXTY (60) DAYS FROM THE 

DATE OF DELIVERY TO YOU AS EVIDENCED BY A COPY OF 

YOUR RECEIPT.  ALTHOUGH PENTAIR THERMAL 

MANAGEMENT BELIEVES THE MEDIA AND THE PROGRAM 

TO BE FREE OF VIRUSES, THE MEDIUM AND THE PROGRAM 

ARE NOT WARRANTED TO BE VIRUS FREE. PENTAIR 

THERMAL MANAGEMENT’S LIABILITY AND YOUR 

EXCLUSIVE REMEDY IF THE MEDIUM IS DEFECTIVE OR 

INCLUDES ANY VIRUS SHALL BE PROMPT REPLACEMENT 

OF THE MEDIUM WITH A NEW TRACECALC PRO-ENCODED 

DISC. 

5. EXCLUSION OF ALL OTHER WARRANTIES   EXCEPT AS 

EXPRESSLY PROVIDED ABOVE, PENTAIR THERMAL 

MANAGEMENT DISCLAIMS ALL WARRANTIES, EITHER 

EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT 

LIMITED TO ANY WARRANTY OF MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE, EVEN IF PENTAIR 

THERMAL MANAGEMENT HAS BEEN ADVISED OF SUCH 

PURPOSE.  THIS AGREEMENT GIVES YOU SPECIFIC LEGAL 

RIGHTS. SOME STATES OR COUNTRIES DO NOT ALLOW THE 

EXCLUSION OF WARRANTIES SO THE ABOVE EXCLUSION 

MAY NOT APPLY TO YOU. 

6. LIMITATION OF LIABILITY   PENTAIR THERMAL 

MANAGEMENT SHALL NOT BE LIABLE FOR ANY LOSS, 

DAMAGE OR DELAY DURING SHIPMENT OR FOR ANY LOSS 

OF PROFITS, LOSS OF USE, INTERRUPTION OF BUSINESS, 

NOR FOR INDIRECT, SPECIAL, INCIDENTAL OR 

CONSEQUENTIAL DAMAGES OF ANY KIND WHATEVER 

UNDER THIS AGREEMENT OR OTHERWISE, WHETHER OR 

NOT PENTAIR THERMAL MANAGEMENT HAS BEEN 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

7. TERMINATION   The license granted herein will automatically 

terminate without notice from Pentair Thermal Management if you fail 

to comply with any term or condition of this Agreement or fail to 

register the TraceCalc Pro program as required by paragraph 2(f).  You 

agree, upon such termination, to remove the TraceCalc Pro program 

from any memory and/or storage media or device, and to return the 

TraceCalc Pro program, including all media and written materials, or 

destroy the same and certify such destruction to Pentair Thermal 

Management, along with any backup or other copies in your 

possession. 

8. COMPLETE AGREEMENT – MODIFICATION IN WRITING   
This Agreement constitutes the sole and complete understanding 

between the parties with respect to the TraceCalc Pro program and its 

use, and may not be varied except by a writing signed by an officer of 

Pentair Thermal Management.  You agree that you may not rely on any 

representations concerning the TraceCalc Pro program to the extent 
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they vary from this Agreement, and such representations, if any, will 

neither add to nor vary the terms of this Agreement. 

9. CHOICE OF LAWS   This Agreement is governed by the laws of the 

State of Texas and the United States, including U.S. Copyright Laws. 

10. EXPORT LAWS   The TraceCalc Pro program may require a license 

from the U.S. Department of Commerce or other governmental agency 

before it may be exported.  The term “export” includes many acts (such 

as transferring the TraceCalc Pro program to a foreign citizen within 

the United States), in addition to sending or taking the TraceCalc Pro 

program outside the United States.  You agree to ascertain the 

necessary licensing procedures and obtain any required licenses before 

exporting the TraceCalc Pro program.  You also agree to indemnify 

Pentair Thermal Management and assume all financial responsibility 

for any losses it may suffer if you do not comply with this paragraph. 

11. Government Restricted Rights.  User acknowledges that the 

TraceCalc Pro program has been developed at private expense and is 

provided with “Restricted Rights.”  Use, duplication or disclosure by 

the Government is subject to restrictions as set forth in subparagraph 

(b)(3) and paragraph (c) of the Rights in Technical Data clause at 48 

C.F.R. 252.227-7013, or subparagraphs (c)(1) and (2) of the 

Commercial Computer Software – Restricted Rights clause at 48 

C.F.R. 52.227-19, as applicable. This provision applies to the 

TraceCalc Pro program acquired directly or indirectly by or on behalf 

of any government.  The TraceCalc Pro program is a commercial 

product, licensed on the open market at market prices, and was 

developed entirely at private expense and without the use of any 

government funds.  Any use, modification, reproduction, release, 

performance, display, or disclosure of the TraceCalc Pro program by 

any government shall be governed solely by the terms of this 

Agreement and shall be prohibited except to the extent expressly 

permitted by the terms of this Agreement, and no license to the 

TraceCalc Pro program is granted to any government requiring 

different terms. 

12. ASSIGNMENT   You may neither assign any right nor delegate any 

obligation under this Agreement and attempted assignment or 

delegation shall be void.  Pentair Thermal Management may freely 

assign this agreement and its rights and obligations thereunder to any 

third party.   

13. INVALID PROVISIONS   If any of the provisions of this License 

Agreement are invalid under any applicable statute or rule of law, they 

are to that extent deemed omitted. 

Should you have any questions concerning this Agreement, or if you desire to 

contact Pentair Thermal Management for any reason, please write to: 

Pentair Thermal Management 

7433 Harwin Drive 

Houston, TX 77036 

USA 
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Copyright and Trademarks 

DigiTrace, Pyrotenax, Raychem, TraceCalc, and Tracer are owned by Pentair or its 

global affiliates.  All other trademarks are the property of their respective owners.  

Pentair reserves the right to change specifications without prior notice. 

 2003-2014 Pentair  

Printed in USA  H57159  01/14 

User Responsibilities 

The performance, reliability and safety of your heat-tracing system depend on proper 

design, selection and installation. The TraceCalc Pro program will help you design a 

system that meets your requirements, but it is only a tool. It assumes that your input 

is accurate, that you are familiar with heat-tracing design, and that you will ensure 

that all components of the heat-tracing system are installed, maintained and used as 

intended. The output of TraceCalc Pro should be reviewed by a knowledgeable 

engineer to ensure it is appropriate for your application. Additional information 

relating to safety, design and installation is contained in Design Guides, Installation 

Manuals, Data Sheets, and other literature available from Pentair Thermal 

Management. Be sure to consult these documents as needed or send email to 

Technical Support at PTM-info@pentair.com. 

Safety Warnings 

There are important safety warnings shipped with our products and printed in our 

literature. Be sure to read and follow them to reduce the risk of fire, shock or 

personal injury. If you have any questions, send email to Technical Support at PTM-

info@pentair.com. 

Warning and Error Messages 

The TraceCalc Pro program will alert you with a warning or an error message under 

certain circumstances. These are typically either because the program cannot find an 

acceptable answer based on your input or because the user may need to take some 

additional action to ensure the design requirements are completely met. These 

warnings and error messages are detailed in Appendix A. 

If you have any questions, send email to Technical Support at PTM-

info@pentair.com. 

Technical Support 

Local Representatives –  Contact your local Pentair Thermal Management 

representative for help. For the most up-to-date and complete listing, go to 

www.pentairthermal.com, click Support > Where To Buy.  

Email – You can request help by sending email to PTM-info@pentair.com. 

FAQ – To view Frequently Asked Questions, visit www.pentairthermal.com, click 

on Support > Frequently Asked Questions. 

mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
http://www.pentairthermal.com/
mailto:PTM-info@pentair.com
http://www.pentairthermal.com/
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Regional Offices 
 

North America 
Pentair Thermal Management  

7433 Harwin Drive 

Houston, TX 77036 

USA 

Tel: 800-545-6258 

Fax: 800-527-5703 

Email: PTM-info@pentair.com 

 

Europe, Middle East, Africa (EMEA) 
Pentair Thermal Management  

Romeinse straat 14 

3001 Leuven 

België / Belgique 

Tel: +32 16 213 511 

Fax: +32 16 213 603 

Email: PTM-info@pentair.com 

 

Latin America 
Pentair Thermal Management 

Al. Araguaia, 2044 – Sala.1101,  

Bloco B 

Edificio CEA – Alphaville 

Barueri – Sao Paulo – Brasil 

06455-000 

Tel: +55 11 2588 1400 

Fax: +55 11 2588 1410 

Email: PTM-info@pentair.com 

 

Asia Pacific 
Pentair Thermal Management 

20F, Innovation Building, 

1009 Yi Shan Rd, 

Shanghai 200233, P.R. China 

Tel: +86 21 2412 1688 

Fax: +86 21 5426 2937 / 5426 3167 

Email: PTM-info@pentair.com 

mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
mailto:PTM-info@pentair.com
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2  Getting Started 

The following sections will help you get started with TraceCalc Pro. 

System Requirements 

The minimum software and hardware required to run TraceCalc Pro includes the 

following: 

 Windows 98, 2000, NT4-SP5, ME, XP 

 At least 25MB of free hard disk space 

 CD-ROM drive (if installing from CD) 

 Internet Explorer 4.01-SP1 or later 

 Screen resolution at least 1024x768 

Recommended (but not required) equipment: 

 Pentium class computer, or better 

 500 MHZ, 128 MB RAM or more 

 Internet Explorer 5.5 or later 

 Adobe Acrobat Reader 5.0 or later, to view the PDF print version of 

User Guide 

Installing TraceCalc Pro 

Installation will normally start automatically after placing the TraceCalc Pro CD in 

your CD-ROM drive. Just follow the on-screen instructions. 

If installation doesn’t automatically begin: 

 Double-click the “My Computer” icon on your desktop. 

 Right-click the CD-ROM drive icon that holds the TraceCalc Pro CD. 

 Select “Explore” from the pop-up menu. 

 Double-click on Setup.exe to launch TraceCalc Pro installation. 
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Learning TraceCalc Pro 

TraceCalc Pro includes a variety of resources to help you learn the program quickly 

and become proficient in creating heat-tracing designs. These resources include 

online help and a printable book that includes a Tutorial chapter. You can also find 

up-to-date Frequently Asked Questions (FAQ) on www.pentairthermal.com. 

If you are a new user, start by reviewing the following chapters: “3  Basics” on page 

11 to get a good understanding of the program interface, and “4  Tutorial” on page 

23 to learn the basics of entering project data. 

TraceCalc Pro Online Help 

The TraceCalc Pro program contains Online Help, a quick and convenient way to 

look up information about a task or an input field. Help is available at most steps in 

the design process.  

To access Online Help, press F1 from anywhere in the application. For best results 

viewing TraceCalc Pro Online Help, use Microsoft Internet Explorer 4.01-SP1 or 

later. 

TraceCalc Pro User Guide (printable book) 

We also provide a printable version of the Online Help in the form of an Adobe 

Acrobat PDF file. 

To access and eventually print this version of the User Guide, click Start > Program 

Files > Pentair Thermal Management > TraceCalc Pro User Guide. For best 

results viewing the PDF version of the User Guide, use Acrobat Reader 5.0 or later. 

A free version of Acrobat Reader 5.0 is included on the TraceCalc Pro CD for your 

convenience. 

Basic Assumptions 
We assume you are familiar with using a PC computer with the Microsoft Windows 

environment and know how to: 

 Launch an application 

 Open, save, and close files 

 Use menus and dialog boxes 

 Use the mouse 

 Design a basic heat-tracing system 

 Manually select heating cables, components and accessories 

 Understand and apply the fundamentals of electrical design 

 Understand the special requirements of  hazardous area designs 

Document Conventions 

The following typographical conventions are used throughout the User Guide. 

http://www.pentairthermal.com/
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 Bold – used for menu command names and field names. For example, 

File menu, and Line ID field. 

  (Ellipsis button) – click the ellipsis button next to a field to access 

a dialog box related to that field. For example, in the Pipe segment of 

the Basic tab screen, if you click the ellipsis next to the Type field, the 

program takes you to the Customize Pipe Types dialog box where you 

can add, modify or delete Pipe Types. 

 Navigation drilldown > – used to depict a navigation path in which the 

user must drill down in order to reach the final destination; for 

example, Setup > Program Settings > Advanced indicates that the 

user must go to Setup on the main menu, drill down to Program 

Settings, and choose the Advanced tab. 

 Data Entry Example – Arial Red font used for project entry data in 

the samples and tutorial content, such as Water Line 02. 
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3  Basics 

This section tells you how to start TraceCalc Pro and then explains the menu bar, 

tool bar, and the purpose of the Design Pane, the Calculated Results Pane, and the 

Project Explorer Pane. This section is intended for the first-time user who needs to 

become familiar with the basic navigation structure, and does not attempt to explain 

the details of entering design data or calculations. If you are an advanced user, you 

may prefer to go directly to “5  Designing Your Project” on page 29. 

Starting TraceCalc Pro 

To start the TraceCalc Pro program, double-click on the TraceCalc Pro icon on your 

desktop, or click Start > Programs > Pentair Thermal Management > TraceCalc 

Pro. 

When you launch TraceCalc Pro, you have the option to use File > New to start a 

new project or File > Open to open an existing project. A project is simply a 

TraceCalc Pro database file that contains the design parameters, specifications and 

calculated results for the heat-traced application you are designing. From this 

database, you can generate useful reports for building/implementing your heat-traced 

application. 

Menu Bar 

The Menu bar options are organized for creating new, or opening existing projects, 

defining project and program settings, setting up reporting criteria, and other useful 

functions. Each menu is discussed in more detail below. 

File 

This menu lets you create new projects, open existing ones, and save or export 

project data.  
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New 

This command displays the Enter New Project Name dialog box, which lets you 

define a new project name. In the File Name box, type a name for your project, and 

click Save. The file will be saved in the Project folder by default; however, you can 

save the project to a different folder if you wish. 

Open 

This command displays the Select TraceCalc Pro Project dialog box, which lets you 

open an existing TraceCalc Pro project. Click on the file you wish to open. For easy 

project management, you can have more than one project file opened at one time.  

Close 

This command closes an active project.  

Save 

By default, TraceCalc Pro will open project files in “single-user” mode. In this 

mode, you are free to work with all aspects of the project and make as many changes 

as you like and nothing will be saved to the project file until you explicitly choose 

Save. At that time, all changes that you have made will be written to the project file. 

If you don’t choose to Save or there is a computer malfunction that interrupts your 

work session, then all changes will be lost. 

When working in “multi-user” mode, any changes to the data for a pipe segment are 

automatically saved as you move from segment to segment. In this mode, the Save 

menu item and the toolbar icon will not usually be enabled, because TraceCalc Pro is 

saving the data as you work. For more information on opening projects in “multi-

user” mode, please see “Advanced Tab” on page 97. 

Save As 

This command lets you save your project under a different project name. When 

prompted, enter the new project name and click Save.  

Export 

This command exports all, or some field names and their values for lines in your 

project in CSV (comma-separated values) format, which can be read by other 

programs, such as Microsoft Excel.  
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 Select Pipe Only, Vessel Only or Both from the drop-down list to 

export pipe data, vessel data, or data for both pipes and vessels.  Your 

selection affects which fields may be exported.  If you select Pipe Only, 

only pipe data will be exported; ‘vessel-only’ fields such as vessel 

diameter will not be exported.  Similarly, if you select Vessel Only, 

only vessel data will be exported.  Data for pipe-only fields such as 

pipe diameter will not be exported.  If you select Both (Common Fields 

Only), then both pipe and vessel data can be exported, but only data for 

fields used by both pipes and vessels can be exported. 

 Export all field names by clicking on the double right arrow button 

 to move the field names from the left to the right list for export.  

 Export some field names by highlighting the fields you want and 

clicking the single right arrow . Fields may only be selected and 

moved one at a time or all at once. Alternatively, if all the field names 

are on the right, you can click any of the field names and click the 

single left arrow  to remove it from the export list.  

 Fields will be exported in the order they appear in the right-hand list.  

You may change the order with the up and down arrows that appear to 

the right of the list box.  To move a field name to the top or bottom of 

the list, use the top arrow  or bottom arrow .  To move a field 

name up or down, click on the field name and then click on the up 

arrow  or down arrow .  

 To select which lines and / or vessels to export, click the Filter button.  

The Filter and Sort Settings dialog box appears.  For more information, 

please see “Using the Filter and Sort Settings Dialog Box” on page 87. 

 Once you have chosen the type of export (Pipes Only, Vessels Only, or 

Both), selected the names of the fields that you wish to export, and set a 

filter (if desired), click the Export button.  

 Specify a file name for your exported data file. This file will be saved 

in the Project folder by default, unless you specify a different location. 

The CSV format can be read by many applications, including Microsoft 

Excel. The horizontal array of field names and values (all fields on row 

1 and values on row 2) can be transposed to a vertical list (all fields in 

column 1 and values in column 2) using Microsoft Excel’s Paste 

Special – Transpose feature, if required. 

Export -> Saving and Recalling Field Lists 

You can also save the list of fields chosen above and recall those settings in 

subsequent export operations. This makes it easy to export just the fields necessary 

for a particular operation. 

To recall a previously saved list, just select it from the Saved Field Lists drop down 

list. If you edit a saved list and want to save the new settings under the same name, 

click on the Save List button. To save under a different name, click on the Save List 

As… button and then enter a new name. Finally, to delete a saved list, click on the 

Delete Saved List button. 

Note: field lists are specific to the export type.  For example, if you save a field list 

during a Pipe Only export, it will be available for Pipe Only exports, but not for 

Vessel Only exports or Both (Pipe and Vessel) exports. 
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Export –> Filter 

Use this command to apply filter criteria to a selection of lines prior to exporting the 

data. Select the field names for the values you wish to export. Then, click the Filter 

button. The Filter and Sort Settings dialog box appears.  For more information, 

please see “Using the Filter and Sort Settings Dialog Box” on page 87. 

Compact Database 

This menu command will optimize the project database structure, removing wasted 

space and potentially reducing the file size. As you add, delete, modify and 

recalculate pipe segments, it is likely that “unused” space will be created within the 

project file structure. 

For smaller projects, wasted space will normally be inconsequential and can be 

ignored. However, for larger projects, after making many changes, you may be able 

to reduce the project file size by several megabytes using this command. 

Edit 

This menu lets you add and remove project lines, generate various reports, and edit 

variables that will affect all lines in your project. 

 

For more information, see “Working with Project Lines and Vessels” on page 82. 

View 

This menu lets you navigate around the Project Explorer Pane and the Summary 

Pane.  

 

For more information, see “Find a Line or Vessel” on page 79or “Summary Data” on 

page 77. 
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Calculate 

This menu lets you calculate results of your design parameters on the current record 

or all records that are open. You can also calculate only the records that have been 

changed since the last calculation. 

 

For complete details about these menu options, see “Viewing Calculated Results” on 

page 73. 

Reports 

The menu lets you generate reports. You can filter and sort information, modify filter 

and sort settings, and preview the report prior to printing.  

 

For complete details about these menu options, see “8  Reports” on page 105. 

Setup 

This menu lets you add information that is specific to a project, like project name, 

product preferences, design preferences, units of measure, and so on. It also lets you 

identify the location of the product reference data file that contains the data for 

heating cables, components and control devices. Attributes selected in the Setup 

menu will be saved when you close the Setup window.   

 

For complete details about these menu options, see “6 Advanced Settings” on page 

91. 

Window 

From the Window menu option you can arrange multiple project windows, and 

activate and hide project windows when more than one project is open at a time.  

Register 

From the Register menu option you can launch the Registration popup window that 

lets you connect to an online or offline registration form. When you register, you will 
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receive a validation code that you must enter on the Registration popup window in 

order to retain TraceCalc Pro beyond the 30-day trial period. 

Help 

From the Help menu option you can launch the online Help tool. Select Contents, 

Index, or Search depending on which part of Online Help you wish to access. You 

can also access Online Help by pressing the F1 key. 

Tool Bar 

You can use the Tool Bar buttons as shortcuts to some of the commands available 

from the Menu bar’s File, Edit, View, Calculate, and Reports menus. Simply click on 

the button to use frequently used features such as New, Open, Close, Save, 

Calculate Records, Find, Copy, Paste, and Detail Report for Current Pipe. To 

see what function each button represents, simply place your cursor over the button to 

display the ’tool tip’. 

 

Project Window 

TraceCalc Pro’s Project Window has two views: the Design View and the Summary 

View.  In Design view, the Project Window contains three panes—each serves a 

critical function for the design and calculation of your project data. The three panes 

are:  

 Design Pane 

 Calculated Results Pane  

 Project Explorer Pane  
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Summary View is similar to Design View, except that the Design Pane is replaced by 

a Summary Pane. 
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Design Pane 

This pane displays whenever a line or vessel is selected in the Project Explorer Pane. 

The Design Pane contains several tabs: Basic, Reference, Area Class, Heater 

Options, Components (optional), and Controls. Each tab represents a screen where 

the user enters specific design data for the selected pipe segment or vessel.  

For instance, the Basic tab will collect line ID, line type, pipe, insulation, 

temperature, and electrical information. The Reference tab will collect area, fluid, 

and location data. The Area Class tab will collect information that defines the 

specific hazardous location, including class, division/zone, gas/dust groups, design 

parameters, and sheath temperature calculation modes. The Heater Options tab will 

collect information that helps define the type of cable to be considered and whether 

spiraling will be allowed. The Components tab will collect information that specifies 

system components, such as power, splice, tee and end seal. Lastly, the Controls tab 

will collect data for selecting an appropriate temperature control method such as 

Standard ambient sensing, proportional ambient sensing, line sensing with no failure 

alarm, and line sensing with failure alarm.  

If you click on a folder in the Project Explorer Pane or select View > Summary, the 

Design Pane is replaced by the Summary Pane. 

For complete details about entering line and vessel data, see “Entering Design Data” 

on page 31. 

Calculated Results Pane 

The Calculated Results Pane displays an online preview of calculated results for the 

selected pipe segment or vessel when you choose any option from the Calculate 

menu. This window lists specific information related to heating cable lengths, type, 

performance, and electrical operating requirements. 

If no pipe segment or vessel is selected in the Project Explorer Pane, then the 

Calculated Results Pane will be blank. 

For complete details about calculating results, see “Viewing Calculated Results” on 

page 73. 

Project Explorer Pane 

The Project Explorer Pane is where you manage all the pipe lines and the electrical 

panels for your project. Use the Project Explorer Pane to do the following: 

 Select how you wish to view your project elements (by Line Groups or 

Panel Groups) 

 Edit (add, modify, delete, etc.) the list of project pipes. 

 Right-click on a Line ID for more editing (copy, paste, etc.) and 

reporting options. 

 Double-click on a Line ID to edit the Line Type (pipes) or Vessel 

Properties (vessels). 

 Click on any folder to see a Summary of data for lines and vessels in 

that folder. 

For complete details about the Project Explorer Pane, see “Managing Project 

Elements” on page 78. 
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Summary Pane 

The Summary Pane is not visible when you are viewing or editing line or vessel data.  

The Summary Pane appears if you click View > Summary from the Main Menu, or 

if you select (click) a folder in the Project Explorer Pane. 

The Summary Pane shows summary data for your project, such as the number of 

pipe segments needing recalculation, the total length of pipes, and so on. 

You may select the lines to be included in the summary. 

For complete details about the Summary Pane, see “Summary Data” on page 77. 
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4  Tutorial 

This section is a tutorial for the novice TraceCalc Pro user. It leads the user through 

the steps of starting a project, entering data, generating reports, and saving and 

modifying data. Intended as a Fast Start for the novice user, this section does not 

attempt to explain all the capabilities of the TraceCalc Pro program. For a detailed 

explanation of capabilities, refer to “5  Designing Your Project” on page 29. 

Starting a New Project 

To start the TraceCalc Pro program, double-click on the TraceCalc Pro icon on your 

desktop. As an alternative, click on Start > Programs > Pentair Thermal 

Management > TraceCalc Pro. 

Click on File > New. In the Enter New Project Name dialog box, the File Name box 

will be highlighted. Type Tutorial 1 or other suitable file name, and click Save. The 

file will be saved in the Projects folder by default; however, you can save the project 

to a different folder if you wish. 

Entering New Project Data 

In the Project Explorer Pane, one line is already entered called New Line [001] 
under a folder called Piping. In this tutorial we will rename the default line and then 

use that line as a shortcut to enter two new additional lines. 

Just above the Project Explorer Pane you will notice a heading View By: with Line 

Groups highlighted. Leave this setting as Line Groups. You can read more about 

Panel Groups in the section “5  Designing Your Project” on page 29. 

Before you start entering data, let’s set a few project settings: 

 Units – Set units by clicking Setup > Units > Metric if it has not 

already been selected for this tutorial.  

 Project Name – The project name, along with other information 

entered in the Project Information Window, will show up on all reports 

and can be anything that is meaningful to the designer. Give the project 

a name by clicking Setup > Project Settings. In the Project 

Information window, type a Project Name such as Tutorial and add any 

other reference information like customer name, project description, 

and so on that you would like to see on a report. The other tabs in the 

Project Information are described in “Project Settings” on page 91. 
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Basic Tab Data 

The Basic tab is in the Design Pane, just to the right of the Project Explorer Pane. 

Use the Basic tab to enter information and data specific to a particular line. A line 

may consist of a single pipe segment or many, depending on the design conditions. 

Each pipe segment is identified by a unique combination of a Line ID and a Section 

Number. Enter line data as follows: 

 Line ID – In the Line ID field, highlight the words New Line and 

replace them by typing Water Line 01, then press Enter or Tab to 

another field. You can enter a maximum of 30 characters in this field. 

 Section No. – Leave the Section Number field as 1—you use this 

section number only to differentiate different sections of a pipe with the 

same Line ID. 

Enter Pipe data as follows: 

Note that although pipe sizes are commonly supplied in English units, some pipe 

types use metric units by default. If you want to specify a metric pipe size, select a 

Pipe Type such as TC-DN (METRIC). 

 Pipe Type – Select CS-S40 from the drop-down list to specify that the 

piping is Carbon Steel, Schedule 40.  

 Diameter – Select 1.000 inch from the drop-down list. 

 Length – Click on the data in this field and replace it by entering 15 m. 

 Valve and Supports – This section is optional. For this example, we 

will presume that  this 1" pipe has typical supports, there are no flanges 

and one typical valve on this section of pipe.  To view the valves, 

supports and flanges defined for a pipe segment, click Valves, 

Supports… to bring up the HeatSinks dialog box.  Click Cancel to 

close the HeatSinks dialog box without saving changes to the heat sink 

definitions. 

Enter Insulation data as follows: 

 Insulation Type – Select CS from the drop-down list to specify 

Calcium Silicate insulation.  

 Thickness – Enter 20 mm. (Note: You can enter any value, as there is 

no table of standard sizes for insulation thickness.)  

 Advanced – This button provides a way of selecting Two Layer 

Insulation Systems or Over size Insulation. Ignore this button for now. 

 Line Type – This field shows this line type to be Parent. You cannot 

change this, as the first line has to be a Parent, i.e. it will need a power 

connection. Lines branching off this line can be loops, tees, etc. For a 

more detailed information, see “Line Type” on page 32. 

Enter temperature data as follows: 

 Maintain – The desired pipe temperature at the Minimum Ambient 

temperature. Enter 5 C. 

 Min. Ambient – The lowest anticipated Ambient temperature. Enter 

20 C. 

 Max. Ambient – The highest anticipated Ambient temperature. Enter 

35 C. 
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 Max. Htr. Exposure – The highest anticipated pipe or fluid 

temperature to which the heating cable will be exposed intermittently. 

Enter 65 C. 

 Max. Operating – The highest anticipated pipe or fluid temperature to 

which the heating cable will be exposed continuously. Enter 50 C. 

 Max. Allowable – The highest acceptable fluid temperature generated 

by the heating cable. The program uses this temperature to determine 

whether temperature controls are required. Enter 80 C. 

Enter Electrical data as follows: 

 Voltage Configuration – Select Single phase (phase-neutral) from the 

drop-down list. 

 Voltage – Enter 120 volts. 

 Max. CB Size – The highest circuit breaker rating the user desires to 

use. Enter 20 amps. 

Reference Tab Data 

Click the Reference tab at the top of the Design Pane.  

This information will appear in reports and can be used to help organize the output. 

Enter reference data as follows: 

 Area – Accept the default for this tutorial.  

 Fluid – Should already be set at WATER by default. Accept this 

default. The selected fluid appears for reference purposes only. 

 Drawing No. – Accept the default for this tutorial. 

Enter location data as follows: 

 Indoor/Outdoor – Identifies whether the ambient is indoors or 

outdoors. Outdoor locations consider the effect of wind on heat loss. 

Indoor locations assume no wind. Set the location to Outdoor. 

 Wind Speed – Enter 10 meters per second. Wind is not considered for 

indoor locations. 

 Chemical Exposure – Identifies whether significant exposure to 

chemicals is anticipated and limits heating cable selection to those 

having the appropriate outer jacket or sheath. Select None. 

 Startup Temperature – The lowest anticipated temperature of the 

heat-traced pipe or equipment (not necessarily with ambient) at which 

the heating cable circuit will be energized. Lower startup temperature 

may reduce allowable circuit lengths and might increase the cost of 

electrical supply. Enter 5 C. 

 HL Safety Factor – Increases the calculated heat loss to ensure the 

cable provides extra heat. It is one way to compensate for important 

variables that cannot be controlled or quantified. Enter 10 %. 

You may wish to save your data at this point.  Click the Save button, or click File > 

Save from the main menu. 



 

26    4  Tutorial H57159 (01/14) TraceCalc Pro User Guide 

Area Class Tab Data 

Click the Area Class tab at the top of the Design Pane.  

Enter the information as follows: 

 Standards Body – Select US from the drop-down list. 

 Class/ Area Classification – Select Non-hazardous. 

Ignore the rest of the screen for this tutorial. 

Click the Save button, or click File > Save from the main menu, to save your 

changes. 

Heater Options Tab Data 

Click the Heater Options tab at the top of the Design Pane.  

Enter heater technology data as follows: 

 Category – Limits the types of heating cables considered by the 

program based on whether the design employs series or parallel 

electrical circuitry in its construction. Select Parallel. 

 Manual Select Attachment – Leave this box unchecked to allow the 

program to select the default method of attaching the heating cable to 

the pipe.  

 Allow Spiraling – Leave this box unchecked to disallow spiraling, as it 

is more convenient to use a straight run of heating cable, if that gives 

suitable results.  

 Force Trace Ratio – Leave this box unchecked to let the program 

calculate if more than one straight run of heating cable is necessary to 

provide sufficient heat.  

Leave all the boxes unchecked under Heater Selection to allow the program to 

choose from all available heating cables. 

Click the Save button, or click File > Save from the main menu, to save your 

changes. 

Components Tab Data 

If you are not familiar with the component selection, you should skip this section and 

go to the Controls tab. 

Click the Components tab at the top of the Design Pane. 

Click the Power and End Seal tabs, and ensure that all boxes on each tab are 

unchecked, to allow the program to make suitable selections. 

Controls Tab Data 

Click the Controls tab at the top of the Design Pane.  

Select a control method as follows: 

 Control Method – Select Uncontrolled from the drop-down list.  
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Leave all the boxes unchecked and leave the other data fields at their default settings. 

For this tutorial, we will see if the temperature conditions can be met without the use 

of a thermostat or more sophisticated temperature controls. 

Click the Save button, or click File > Save from the main menu, to save your 

changes. 

Review the Results 

You can now allow the program to calculate the heat loss of the pipe and select the 

appropriate heating cable and components. Click the Calculate toolbar icon, or click 

Calculate on the main menu and select Current Record, or press the F9 key. 

The Calculated Results Pane at the bottom of the screen will show the heat loss from 

the pipe on the coldest and windiest day (worse case condition), the catalog number 

of the heating cable, and a summary of other calculated values. 

If the program is unable to select a suitable heating cable for the data you entered, 

you will see an ERROR message at the top of the Calculated Results Pane. 

If the program encounters conditions that  require further  consideration, you will see 

a WARNING message at the top of the Calculated Results Pane. Warning messages 

should not be ignored as they may be identifying conditions that pose a safety risk or 

reduction in system performance.  

TIP: You can change the height of the Calculated Results Pane by dragging the 

border that separates it from the other windows. 

Copy Data to a New Line 

You can now quickly add a new line by using the first line as a template. There are 

two ways of doing this: 

 Set the current line as the default – When you set the current line as a 

default, you can copy all the data for that line to a new line. 

 Copy an existing line – When you copy an existing line, you can copy 

and paste all of the attributes of that line to a new line. 

We will demonstrate each way to make a second and third line respectively in our 

project. 

Set Current Line as Default 

Set the current line you already entered as the default for all new lines you enter in 

this project as follows.  

In the Project Explorer Pane, right-click on the name of the line you have just 

entered (Water Line 01, for this tutorial example) and highlight Set Current Line 

As Default then select For This Project. Alternatively, use Edit on the main menu, 

where the same options appear. 

Right-click inside the Project Explorer Pane and select Add New Line. Add line 

details as follows. 

 Line ID – Enter Water Line 02. 

 Section No – Leave as 1.  

 Line Type – Will be shown as Parent. Click OK. 
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You can now edit the data for this new line. Under the Basic tab enter new data as 

follows: 

 Length – Change to 200 m. 

Click the Calculate Current Record icon , or click Calculate > Current Record 

on the main menu. Alternatively, you can right-click on the line you wish to 

calculate and select Recalculate. 

Click the Save icon, or click File > Save from the main menu to save your data and 

results. 

The first line of the Project Explorer Pane will show a warning to indicate that 

Multiple Circuits have been created. This is because 200 m is too long for a single 

circuit based on the selected heating cable/technology. The program equally divides 

up the circuit and calls for two sets of components. The Circuit Operating Load is 

the load for each circuit and the Pipe Segment Operating Load is the total for all 

circuits on this line. For now we will accept this design although you may decide 

later to create a new line so that you can specify different lengths for the two circuits 

on the 200 m of piping. 

Copy an Existing Line 

Now copy the existing line and paste all of the attributes of the current line to a new 

line that you create as follows: 

Right-click on the name of the second line and select Copy Current Line. Then, 

right-click again and select Paste Append to create an identical new line. 

TIP: Once you have copied a line you can also paste some or all of the data 

associated with that line to an existing line using Paste. 

Enter Line ID data as follows: 

 Line ID. – Enter Eyewash line. 

 Section No. – Enter 1. 

 Line Type – Will be shown as Parent and will not be selectable. Click 

OK. 

Under the Basic tab change data as follows: 

 Pipe Type – Change to SS-S10 for Stainless Steel Schedule 10 piping 

 Diameter – Change to 2.000 inches. 

 Length – Change to 40 m. 

 Insulation Type – Change to FG for Fiberglass. 

 Thickness – Change to 30 mm. 

 Maintain – Change to 29C. 

 Max. Allowable – Change to 35C. 

Under the Controls tab, change data as follows. 

 Control Method – Change to Line sensing with failure alarm. 

 Use local control equipment – Check this box since this is a 

temperature critical application. 

Click the Save icon, or click File > Save from the main menu to save your changes. 
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Click the Calculate Current Record icon, or from the main menu click Calculate > 

Current Record. 

A WARNING for the first line of the Project Explorer Pane indicates that Multiple 

Circuits have been created. In this case, it can be avoided if one arranges to feed the 

circuit from a larger circuit breaker. Click the Basic tab and enter 30 for the Max. 

CB Size.  

Click the Calculate Current Record icon or click Calculate on the main menu then 

Current Record. 

You will see that only one circuit is now needed. 

Click the Save button or click File > Save from the main menu to save your data and 

results. 

NOTE: The appearance of a WARNING in this example assumed all basic data are 

the same for your project as for the example.  For instance, if different heat sinks 

apply to this line, then your calculated heat loss and total heater length will be 

different. 

TIP: If you had not specified a temperature control device, you would have seen a 

warning message indicating that the uncontrolled temperature exceeds the maximum 

allowable. As we have specified a line sensing temperature control the design is 

acceptable and the warning is no longer shown.  

Reports 
You can now review and print several Piping Reports and a Bill of Materials Report. 

To review the Piping Report, click Reports > Piping Reports from the main menu. 

Select Summary Line List from the drop-down list and click Preview. You will see 

a brief summary for all three lines. Use the Print icon to open the Print dialog box 

and select a printer if you wish to print this report. 

To review the Bill of Materials Report, click Reports > Bill of Materials from the 

main menu. For now, leave the Display By: selection box as All Areas. Click on 

Preview and use the Print icon if you wish to print this report. 

TIP: You may notice that two different types of Glass Tape are shown in the Bill of 

Materials. The program selected the attachment method and corresponding materials 

and specified different types of glass tape because the defaults are different for 

carbon steel and stainless steel piping. 

You can print reports for selected groups of lines in a large project by using filtering 

conditions. For more information, “Using the Filter and Sort Settings Dialog Box” 

on page 87. 

 

This is the end of the Tutorial. For more in-depth design detail see “5  Designing 

Your Project” on page 29 and “6  Advanced Settings” on page 91. 
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5  Designing Your Project 

This section provides more detailed information for both the novice and experienced 

TraceCalc Pro user. It leads you through the steps for entering all the design 

parameters in order to create a complete set of reports for your project.  

Entering Design Data 
The TraceCalc Pro Design Pane contains various tabs for collecting line parameter 

and design data. Each tab represents a screen that collects a specific type of design 

data that you may require for your project. This section provides a more detailed 

description of each of the data fields and any advanced editing options. 

TIP: Detailed descriptions of the input fields and menu options are also described in 

the Online Help. Press the F1 function key or click on the Help menu item anywhere 

inside the TraceCalc program to obtain Online Help. 

Basic Tab 

For piping data entry, use the Basic tab to identify line data and to enter detailed pipe 

segment size and type, insulation, temperature, and electrical data. 
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For vessel data entry, the Basic tab is used to enter insulation, temperature and 

electrical data, just as for pipes.  Unlike pipes, however, the Basic Tab does not 

allow entry of vessel properties such as size or composition.  Vessel data are entered 

using a set of pop-up dialog boxes, which are accessed by clicking the Vessel 

Properties… button on the Basic Tab (or by double-clicking on the Vessel ID in the 

Project Explorer Pane).   

 

Details of pipe data entry continue below.  For vessel design information, please see 

“Vessel Properties Dialog Box” on page 65.  For nformation on insulation, 

temperature and electrical data, please see “Basic Tab” on page 31. 

Line ID and Section No. 

Line ID (typically a pipe identification number) is associated with a line that has 

been added in the Project Explorer Pane.   

You can change this Line ID or assign a different section number in one of two 

ways. You can edit the data directly in the Line ID or the Section No. field. 

Alternatively, you can edit this data from the Line Configuration dialog box, which 

is accessed by clicking the ellipsis adjacent to the Line Type field or by double-

clicking the Line ID in the Project Explorer Pane.  For more information, please see 

“Line Configuration Dialog Box” on page 86. 

The purpose of the Section Number is to allow you to use the same Line ID for 

several pipe segments and to differentiate between them by assigning different 

section numbers. This allows you to develop different heat-tracing designs for 

different segments of the same pipe. If you look in the Project Explorer Pane, you 

will see the Section Number displayed in square brackets after the Line ID. 

Examples of when it is useful to have different section numbers is when a pipe 

branches off, changes diameters, or changes its environment. You can assign 

different section numbers to all sections while continuing to use the same Line ID. 

Line Type 

Line Type describes the position of the line in a heat-tracing circuit and is only 

important for circuits involving multiple pipe segments. You must define the Line 
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Type when you add a line because the program uses this information to determine 

which components to include for each segment. For example, properly assigning the 

line type to each of three cable segments connected to a tee kit ensures that only one 

tee kit and two end seals are included in the bill of materials, and not three power 

kits and three end seals. If you are not comfortable with this new feature, you can 

simply define all lines as “Parent lines” and then manually group circuits and adjust 

component quantities. 

To change the Line Type, you must use the Line Configuration dialog box.  When 

you create a new line, the Line Configuration dialog box comes up automatically.  

To use it for an existing line, you may either click the ellipsis adjacent to the Line 

Type field, or by double-clicking the Line ID in the Project Explorer Pane.  For 

more information, please see “Line Configuration Dialog Box” on page 86.  

In many situations, you may want to use the same heating cable to trace both the 

child and the parent line. When this option is technically feasible, the program will 

make the Use Same Heater As Parent check box available in the Line 

Configuration dialog box.  For more information, please see “Line Configuration 

Dialog Box” on page 86. 

Remember, you do not need to calculate the number of components required for your 

design configuration. You only need to properly define the Line Type for each line 

and TraceCalc Pro will automatically determine the number of associated 

components.  

Parent 

If you add a line, the default Line Type is “Parent”. A Parent line will have a power 

connection kit.  It may or may not have an end seal kit, depending on what types of 

child lines it may have. 

 

You can change the Line Type to better reflect more complex designs incorporating 

various piping configurations.  

You may add the new line as a parent and then, using the mouse, simply drag and 

drop it to the parent line you want it associated with. This action opens the Line 

Configuration dialog box, where you can select from the various Line Types listed. 

After selecting the desired Line Type and clicking OK, the line is displayed in its 

new location. Alternatively, to make a parent line into a child you may simply bring 

up the Line Configuration dialog box and select ‘Child’ from the Line Type drop-

down list. 

The program recognizes multiple line types. If the heat-tracing circuit consists of just 

one segment, i.e. a continuous length of heating cable from power point to end seal, 

it can be simply defined as a “Parent” Line Type. Each new line added to a project is 

also assigned a Parent Line Type by default until, and unless, you change it as 

described above. A parent line always includes a power kit but may or may not 

include an end seal depending on whether there are other lines associated with it.  



 

34    5  Designing Your Project H57159 (01/14) TraceCalc Pro User Guide 

If there are other lines associated with the parent, they are referred to as child lines 

throughout this manual. A child may be thought of as a subline. It is a user-defined 

identification of a pipe segment for the purposes of organizing or simplifying the 

heat-tracing design. It is a segment of a pipe system that is somehow connected to, 

and is typically downstream of, a parent segment for either electrical or flow 

purposes. For instance, a branch of a fire water line could be a “child” of the water 

line. The child takes on the design-related parameters of the parent unless you 

override them. For instance, while it may optionally have the same ambient 

conditions as the parent, it will always have the same power-related conditions as the 

parent, i.e., the same voltage, circuit breaker rating, etc., because it is powered 

through the same circuit breaker. 

A wide range of circuit configurations can be created using the various child Line 

Types described below.  

Power, Parallel 

Power, Parallel is a line with its own power connection kit electrically connected to 

the same circuit breaker as the parent. It may also include an end seal, depending on 

the design (if no other lines are connected, it will include the end seal). 

 

Power, Splice 

Power, Splice is a line that is powered from the same power connection kit as the 

parent. For bill of materials purposes, it does not include a power kit but may include 

an end seal depending on the design (if no other lines are connected, it will include 

the end seal). 

 

Power, Tee 

Power, Tee is a line that is one of two other lines powered from the same power 

connection kit as the parent. For bill of materials purposes, it does not include a 

power kit but typically an end seal depending on the design. A powered tee box 

includes at least a parent line as well as two power-tees. If you don’t define a 

complete set, TraceCalc Pro will not be able to determine a complete Bill of 

Materials. If you define a parent with just one power-tee child, it will be similar to a 

power splice and just require a power box that could also be used for a tee. 

mk:@MSITStore:C:/Program%20Files/Tyco%20Thermal%20Controls/TraceCalc%20Pro/TCPro.chm::/segment.htm
mk:@MSITStore:C:/Program%20Files/Tyco%20Thermal%20Controls/TraceCalc%20Pro/TCPro.chm::/parent.htm
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Splice, End Segment 

Splice, End Segment is a line that is spliced to one other segment. Its power comes 

from the other segment, not directly from the power source. For bill of materials 

purposes, it includes a splice kit and typically includes an end seal depending on the 

design. 

 

Splice, Mid Segment 

Splice, Mid Segment is a line that is spliced to another segment at each end. Its 

power comes from one of the other segments, not directly from the power source. 

For bill of materials purposes, it includes a splice kit but does not include an end 

seal. If no other lines are connected, don’t use the mid-segment, but the end-segment. 

Otherwise you Bill of Materials will not include the required end seal. 

 

Tee, End Segment 

Tee, End Segment is a line that is connected to a tee. The difference from the Tee-

mid segment is that the end segment does not include the tee-kit. For Bill of 

Materials purposes, it typically just includes an end seal depending on the design.  
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Tee, Mid Segment 

Tee, Mid Segment is a line that is connected to a tee. Its power comes from its 

parent. For Bill of Materials purposes, it includes a tee kit and typically includes an 

end seal depending on the design.  

 

Continuation 

Continuation is a line that is a segment of another line, but which needs to be 

identified separately for design purposes. The Bill of Materials does not include any 

components; they are included in its parent line. This is a very useful way to handle 

situations where the same pipe has changing design parameters such as diameter, 

insulation temperature or Ambient temperature, and the designer knows that the 

same cable will be used. 

 

Loop 

Loop is a line that is a segment of another line, but which needs to be identified 

separately for design purposes. It returns to its point of origin on the pipe segment. 

For bill of materials purposes, it does not include any components. This is a useful 

way to handle short piping tee sections. 
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Pipe 

Pipe Type 

Specify the Type of pipe being heated. Heating cable selection can be dependent on 

the properties of the particular piping material. 

You can select from the several pre-defined pipe and tubing types in the Type drop-

down list. If you do not find a suitable pipe type, you can add your own. For 

information on adding your own pipe type see “… Customize Pipe Types” on page 

37. If you select a plastic pipe Type, it must be suitable for the likely exposure 

temperature as determined by the program.  

Note: You should consider the heating cable attachment method in conjunction with 

the pipe material to ensure an appropriate match. Aluminum tape is commonly used 

with plastic piping. Also, when using glass tape, you should select a type suitable for 

the piping material. For more information about the attachment method and tape 

selection see “Design Options” on page 56 and also see “Heater Selection” on page 

59. 

Diameter 

Select the pipe Diameter from the Diameter list. The schedule of standard sizes 

changes for different pipe types, so it is important to select the pipe Type first. 

If the size required is not available, you will need to create a new pipe Type to 

include that specific size; see “… Customize Pipe Types” on page 37. 

Length 

Enter the pipe length in the Length field. When necessary, the program will generate 

multiple circuits if the calculated heating cable length (including allowances for 

valves, etc.) exceeds the maximum circuit length for a specific heating cable. 

However, you can also break up a long pipe into shorter segments manually by 

specifying the Line ID and Section Number for each pipe segment. This provides 

additional flexibility in heating cable selection and power distribution design. 

… Customize Pipe Types 

To add, modify, or delete a pipe type, click the  ellipsis by the Type field.  

Identifier/Description  

 Add – To add a custom pipe Type, right-click in the window, or click 

Add and enter a unique pipe type Identifier. This code may be one to 

fifteen characters and is case-insensitive. Click OK. You will then be 



 

38    5  Designing Your Project H57159 (01/14) TraceCalc Pro User Guide 

asked for pipe property information. See Pipe Schedule Properties 

below for more information. 

 Modify – You can only Modify a pipe Type that has been previously 

added to the table. Default pipe Types cannot be modified. The Read 

Only column identifies whether a particular pipe Type may be 

modified. Note: If you do not see a Read Only column, simply enlarge 

the dialog box by dragging the right boundary to the right. 

 

To modify a pipe Type, highlight the Pipe Type Identifier you wish to 

modify and click Modify, or right-click and select Modify from the 

pop-up menu. You can then edit information about the pipe type. See 

Pipe Schedule Properties below for more information.  

 Delete – To delete a pipe Type, highlight the Pipe Type Identifier you 

wish to delete. Click Delete, or right-click and select Delete from the 

pop-up menu. You will be prompted to confirm that you really want to 

delete this item. Once deleted, it cannot be restored. Click Yes to 

confirm, and then Close. You cannot delete default pipe Types. These 

are identified with a “Yes” in the Read Only column. 

 Copy (using right-click) – To copy a pipe Type, highlight the Pipe 

Type Identifier and then right-click and select Copy from the pop-up 

menu. You can then Paste or Paste Append the copied data. 

 Paste (using right-click) – You can copy and paste some or all of the 

properties of a pipe Type to an existing pipe Type, providing it is not a 

default (Read Only) pipe Type. Highlight the Pipe Type Identifier you 

wish to paste the data to, right-click and select Paste. The Paste Pipe 

window shows you the source and destination of the data and gives you 

the opportunity to select the properties you want to paste. This will 

overwrite that data associated with the destination pipe Type. You can 

also select All to check all the groups of items or None to clear all the 

checked items.  

 Paste Append (using right-click) – To copy all of the properties of a 

copied Pipe Type to a new Pipe Type Identifier, highlight any Pipe 

Type Identifier and right-click and select Paste Append. Enter a new 

Pipe Type Identifier name and click OK. You can then use Modify to 

edit the information for the new pipe Type. We recommend this option 

to create a new pipe type, as it helps you avoid retyping similar 

information. 

Pipe Schedule Properties 

In the Pipe Schedule Properties dialog box, click Edit. In the Description dialog box, 

select New and enter a description for the new pipe Type in one or all three language 

boxes, as applicable. Click OK. 

In the Pipe Schedule Properties box, select one of four available Material Types, 

and then enter the Specific Heat and Density values. Then, if you wish to view pipe 

sizes in metric units, click the Metric Nominal Pipe Size box. 

Pipe Size Data 

To modify the pipe size range, select Pipe Size Table, and then modify the values 

and Add Row or Insert Row for additional pipe sizes. The various values are used 

for different purposes. The Nominal Diameter shows in the Pipe Diameter drop-

down list and is the value you will enter to select this size. Heat transfer calculations 

are based on the Actual OD (Actual Outside Diameter) and Actual ID (Actual 

Inside Diameter) that you enter. The wall thickness is calculated automatically. The 
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Over size Diameter is the nominal insulation diameter used when you select the 

option to Use Over size Insulation. 

When finished, click OK twice and Close. 

The program adds the new or modified pipe Type to the drop-down list for use in 

your current and future projects. 

Valves, Supports … 

Heat sinks are a significant source of heat loss and must not be neglected in heat-

tracing system designs. You should include all Valves, Supports and Flanges to 

ensure that the program calculates how much additional heating cable should be 

applied to these items. 

Click on the Valves, Supports … button to open the Heat sinks dialog box. 

For each pipe segment, you can select up the three valve types, three support types, 

and one flange type from their respective drop-down lists. Additionally, you can 

select the quantity of each. 

Note: If the drop-down list does not contain an appropriate predefined valve, support 

or flange, go to Setup > Project Settings > Advanced Tab > Heat sink Definitions 

… to add or modify definitions for valves, supports, or flanges. For more 

information about heat sink definitions, see “Advanced Tab” on page 94.  

Valves, Supports, and Flanges 

On the Heat sinks dialog box, enter valves, supports, and flanges in their respective 

part of the screen as follows:  

 Type – Click the drop-down arrow adjacent to the first Type field 

(Valves, Supports, Flanges respectively) and select the appropriate 

type.  

 Mode – Click the drop-down arrow adjacent to the Mode field and 

select the appropriate calculation mode for the type you entered. There 

can be up to four modes which depends on the way the heat sink was 

initially set up: 

 Calculated heat loss – Heat loss is calculated with a fin-equation 

using predefined data that includes dimensions. The program 

determines the length of heating cable required to replace this heat 

loss for each valve, support, or flange by dividing the heat loss of 

the heat sink through the heat loss of the pipe to accommodate 

possible duty cycle from temperature controls. For more 

information, see “Advanced Tab” on page 94. 

 Equivalent pipe length –The length of heating cable allocated for 

the valve, support or flange is the amount calculated as if it were a 

predefined length of equivalently sized pipe. For instance, if the 

predefined data specified that each valve should use an amount of 

heating cable equal to that needed for 0.8 m of pipe of the same 

size and the program calculated that each meter of pipe needed 1 m 

of heating cables then 0.8 m of additional heating cable would be 

specified for each valve.  

 Total heater length – A constant length of heating cable is applied 

to each heat sink type. The length of cable to be applied is a 

function of pipe size, depending on the definition of the heat sink. 
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 Total wattage – The program calculates the length of heating 

cable needed for all the valves, supports, or flanges, assuming the 

heat loss for each is as defined in the heat sink definition. 

 Specify Interval – You can override any predefined interval. This 

option only applies to supports and flanges where, for example, you 

might want to specify a spacing of one support every 5 m of pipe. 

 Quantity – Enter the quantity each of valve, support, and flange type. 

If this line has more than one type of valve or support, select a second and third type 

of on the next two rows as needed. 

TIP: When the predefined data was entered, it should have included specific data for 

each common pipe size. You should therefore see a predetermined number of 

supports that the program has calculated based on the length of this line. This 

quantity might change with pipe size, if this dependency was specified in the Heat 

sinks properties table. If the option Use TCPro default interval for supports and 

flanges has been checked, then TraceCalc Pro will automatically update the interval 

for any supports and flanges if you change the pipe size.  If this option has not been 

checked, then the program will use the previously selected quantity for any supports 

and flanges. 

For more information about heat sink definitions, see “Advanced Tab” on page 94. 

Miscellaneous 

If you know of other heat sinks that are not accounted for as Valves, Supports, 

Flanges or Vents / Drains, you can include a single allowance for all of them 

together. This allowance can be based on pipe length, on total wattage or on a fixed 

length of heater, as described below. 

 Allow percentage of pipe length – This selection adds a user-defined 

percentage of the pipe length, resulting in extra cable that can be 

installed wherever needed. Check this button and enter a percentage 

value in the Quantity (%) field. For example, if a pipe includes several 

hangers and you want to allow an additional 5% of heating cable so that 

a small loop can be applied to each hanger, enter 5. 

 

Note: the percentage is applied to the pipe length, which results in more 

cable. It is not applied directly to the calculated heating cable length. 

 Allow lump sum watts – This selection adds a user-defined amount of 

watts to the calculated heat loss. Check this button and specify the total 

additional heat loss in the Quantity (W) field. For example, if a line 

includes a pump with a known heat loss of 100 watts and a flow meter 

with an estimated heat loss of 50 watts, enter 150. This will cause the 

program to specify an additional length of heating cable to provide 150 

watts at the Maintain temperature and Minimum Ambient conditions. 

 

TIP: If there are many different heat sinks, you could add their heat 

losses and specify a lump sum wattage. You would then want to 

include a note to indicate how much of the additional length of heating 

cable is to be applied to each additional heat sink. A useful place for 

entering such a note is in the Comments field, under the Reference tab. 

 Allow fixed length of heater – This selection adds a user-defined 

length of heater, resulting in extra cable that can be installed wherever 

needed.  Check this button and specify the total additional length of 

cable in the Quantity (m or ft) field. 
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 Drains / Vents Quantity – You can include a user-defined allowance 

for these items. Specify the number of drains and vents in the Drain / 

Vent Quantity window. The default allowance for drains/vents can be 

modified in Setup > Project Settings on the Design tab. For more 

information, see “Design Tab” on page 93. 

Click OK to save this data and exit the dialog box. 

Insulation 

Insulation Type 

TraceCalc Pro contains several standard insulation types. You can select one of these 

from the insulation Type list. If you do not find a suitable insulation Type, you can 

add a new one. See “… Customize Insulation Types” on page 41. 

The efficiency and size of the thermal insulation greatly impacts the heat loss from a 

pipe. Therefore it is critical for proper heating cable selection. Many factors can 

affect the choice of the best insulation for a given application.  

The insulation system often includes a cladding material over the thermal insulation. 

This program does not consider changes in heat loss if the cladding becomes 

damaged, allowing the thermal insulation to get wet, if the insulation is improperly 

installed, or if the thermal conductivity is reduced due to aging, water, or other 

factors. The thermal conductivity of the insulation is adjusted for temperature. 

The temperature limitations of the insulation materials should be checked against the 

Maximum Heater Exposure Temperature and the Uncontrolled Temperature to verify 

compatibility of the selection. 

… Customize Insulation Types 

To add, modify, or delete an insulation Type, click the  ellipsis by the insulation 

Type field.  

Identifier/Description 

 Add – To add a new insulation Type, click Add and enter a unique 

insulation type Identifying Code. This code may consist of one to 

fifteen characters and is case-insensitive. Click OK. 

 Modify – You can only modify an insulation Type that has been 

previously added to the table. Default insulation Types cannot be 

modified. The Read Only column identifies whether a particular 

insulation Type may be modified. To modify an insulation Type, click 

Modify and change the Insulation Properties as described below. 

 Delete – To delete an insulation Type, highlight the name you wish to 

delete. Click Delete. You will be prompted to confirm that you really 

want to delete this item. Once deleted, it cannot be restored. Click Yes 

to confirm, and then Close. Default insulation Types cannot be deleted. 

The Read Only column identifies these with a “Yes” in the Read Only 

column. 

 Copy (using right-click) – To copy an insulation Type, highlight the 

Insulation Type Identifier and then right-click and select Copy from 

the pop-up menu. You can then Paste or Paste Append the copied 

data. 
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 Paste (using right-click) – You can copy and paste some or all of the 

properties of a Type to an existing Insulation Type, providing it is not 

a default (Read Only) Insulation Type. Highlight the Insulation Type 

Identifier you wish to paste the data to and right-click and select Paste. 

The Paste Insulation window shows you the source and destination of 

the data and you are then able to select to paste the properties of the 

Insulation Type, the description of the Insulation Type and/or the K 

Factor tab. This will overwrite that data associated with the destination 

Insulation Type. You can also select All to check all the groups of 

items or None to clear all the checked items.  

 Paste Append (using right-click) – All of the properties of a copied 

insulation Type can be pasted to a new Insulation Type Identifier. 

Highlight any Insulation Type Identifier and right-click and select 

Paste Append. Enter a new Insulation Type Identifier and click OK. 

You can then use Modify to edit the information for the new Insulation 

Type. 

Insulation Properties 

In the Insulation Properties dialog box, click Edit to go to the Description dialog 

box. You can click Existing to select an existing insulation Type description for 

insulation types, or click New to enter a new description. If you select New, enter a 

description in one or all three language boxes, as applicable. Click OK. This is 

optional text that you may use to more clearly identify the insulation Type on 

reports. It may consist of up to 30 characters.  

You should then enter the maximum and minimum Operating temperatures of the 

insulation material and its Specific Heat and Density values. 

Click the K-Factor Table button to enter Thermal Conductivity values for this 

insulation type for a range of Operating temperature. Click OK and Close. Make 

sure that you are confident with the K-factor data across the entire temperature range 

you expect to use for this insulation type. 

Thickness 

Enter a value for the insulation Thickness. Since TraceCalc Pro does not check the 

availability of the thickness you enter, you should consult the manufacturer’s data. If 

the Thickness is grayed out, click on the Advanced button and make sure that two-

layer insulation is deselected. 

Advanced … 

To specify two layer insulation or over sized insulation click the Advanced … 

button. This opens the Insulation Advanced Options dialog box. 

Two Layer Insulation Systems 

You can specify two layers of insulation to reduce costs when expensive, high 

temperature insulation may be required. This option allows you to select an 

insulation that is able to withstand high temperatures and can be installed directly on 

a hot pipe as well as a more economical insulation for installation on top of the first 

layer. It is important to provide sufficient thickness of the inner insulation so that the 

outer layer is not subjected to temperatures above its capability. Specifying too much 

thickness for the outer layer can also result in the temperature at the interface of the 

two layers becoming too hot for the temperature rating of the outer insulation. 
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To specify two layers of insulation, check the Two Layer Insulation System box. 

Once you are back on the Basic tab, you will see that the insulation properties are 

grayed out which indicates that a two-layer system is being used. 

Inner Layer 

Select the insulation type to be used in direct contact with the pipe from the list. In a 

two-layer system, the Inner Layer is often one that can withstand a high maximum 

pipe temperature, but may not have very good thermal properties (relatively high 

thermal conductivity). 

You can add, modify, or delete an insulation Type by clicking the  ellipsis by the 

insulation Type field. 

Thickness 

Enter the inner layer Thickness. Enter a thickness sufficient to ensure that its outer 

surface temperature is below the temperature rating of the outer insulation.  

Outer Layer 

Select the insulation type to be used on top of the inner layer. In a two-layer system, 

the Outer Layer is often one that has very good thermal properties (relatively low 

thermal conductivity) but cannot withstand a high pipe temperature without a 

primary heat barrier.  

You can add, modify, or delete an insulation Type by clicking the  ellipsis by the 

insulation Type field. 

Thickness 

Enter the Thickness of the outer layer. Be sure that the temperature gradient results 

in an acceptable temperature for the product’s rating at the interface. 

Over Size Insulation 

Over size insulation applies to when the thermal insulation inner diameter must be 

larger than the nominal outer diameter of a particular pipe in order to accommodate 

the heating cable. Over sizing is not necessary if the insulation is compressible, or if 

the pipe is large.  

Click the Use Over Size Insulation box if you wish to specify over sized insulation 

for your heat-tracing design. There is no need to enter a value in the Over Size 

Diameter box as the program will automatically pick the dimension specified in the 

Pipe Size Table, which will often be the next largest size insulation to fit your pipe 

diameter. To see the value that has been picked, close then reopen the Insulation 

Advanced Options dialog box. You can override this automatic selection by entering 

a value, which will only be used for this line. 

The program will base its calculations on this over sized insulation.  

Temperatures 

For a complete design and product selection of a heat-tracing system, TraceCalc Pro 

must have information about the following temperatures: 

Maintain 

The Maintain temperature is the desired temperature at which you want to maintain 

the pipe by the use of heat tracing.  
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The Maintain temperature must be greater than the Minimum Ambient temperature 

as there is no need for heat tracing if the Minimum Ambient temperature is greater 

than the Maintain temperature. 

Heat loss calculations are based on the Minimum Ambient temperature. At higher 

temperatures, the heating cable selected will provide more heat than is required to 

hold the pipe at the Maintain temperature. This will result in a higher actual 

temperature. The program will calculate the Uncontrolled Temperature of the pipe 

assuming Maximum Ambient temperature and no wind. This is reported in the 

Calculated Results Pane. 

Minimum Ambient 

The Minimum Ambient temperature is the lowest temperature expected at the pipe 

location. The Minimum Ambient temperature for indoor locations should be the 

lowest indoor temperature irrespective of the minimum outdoor temperature. The 

effect of wind for outdoor locations is considered in the design. The wind chill factor 

should not be used. 

Heat-loss calculations depend on the difference between the Minimum Ambient 

temperature and the desired Maintain temperature. The program checks the 

Minimum Ambient temperature to ensure that it is less than the Maintain 

temperature and less than the Maximum Ambient temperature. 

Maximum Ambient 

The Maximum Ambient temperature is the highest temperature expected to occur at 

the design location. This value must be greater or equal to the Minimum Ambient 

temperature.  

The Maximum Ambient temperature for indoor locations should be the highest 

indoor temperature irrespective of the maximum outdoor Ambient temperature. 

The Maximum Ambient temperature is typically used to calculate the maximum 

uncontrolled pipe temperature and when necessary, to determine whether a high-

temperature cut-off thermostat is required. 

Maximum Heater Exposure 

The Maximum Heater Exposure temperature is the maximum temperature to 

which the heating cable may be exposed intermittently. It assumes high-temperature 

excursions no longer than 48 hours and a total cumulative exposure of less than 1000 

hours. This temperature is ignored for the purpose of predicting maximum heating 

cable sheath temperatures. 

In many applications the Maximum Heater Exposure temperature will be the same 

as the Maximum Operating temperature.  

Maximum Operating 

The Maximum Operating temperature is the highest temperature of the heat-traced 

fluid during normal process operating conditions. Excursions of less than 1000 hours 

may be ignored. 

The Maximum Operating temperature may be the same as the Maintain 

temperature, but it could be considerably higher. For example, when a process pipe 

operates at a high Operating temperature but the heat tracing is only required to 

prevent the pipe from freezing during shutdown conditions. In this case, the 

Maintain temperature is only slightly above the freezing temperature of the fluid.  
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TraceCalc Pro will select a suitable heating cable assuming that the Maximum 

Operating temperature is the highest continuous (for greater than 1000 hours) 

exposure temperature for the heating cable whether energized or de-energized 

(depending on the control method). 

Maximum Allowable 

The Maximum Allowable temperature is the maximum temperature permitted by 

the user for the process/ fluid or piping. The program uses temperature to determine 

whether temperature controls are required. The value you enter should be the lowest 

value of the fluid degradation temperature, the piping expansion temperature, or the 

piping material withstand temperature (especially in the case of plastic piping). For 

hazardous locations, the maximum temperature ratings are entered separately as an 

auto-ignition temperature and T-rating. Please see “Design Parameters” on page 52. 

Electrical 

You need to enter certain electrical data for each line so the program can make the 

correct product selection. (Note: the Electrical section is only active when you are 

editing a “Parent” line type. All “Child” line types will inherit the Electrical settings 

from their Parent.) 

Voltage Configuration 

You need to select the configuration of the voltage source used for powering the 

heater. This selection will determine how TraceCalc Pro interprets the value entered 

in the Voltage field below. 

Voltage 

For Single Phase systems, this is the actual voltage applied to the heater. For 3 Phase 

systems, this should be the phase-to-phase voltage. TraceCalc Pro then calculates the 

actual voltage applied to the heater and displays it in the Heater Operating Voltage 

field. 

This voltage affects which heating cables may be selected, and their maximum 

circuit lengths.  

Heater Operating Voltage 

This is a read only field where TraceCalc Pro displays the calculated voltage that is 

assumed to be applied to the heating element.  For Single phase systems and Three 

phase DELTA systems, this value will be the same as the entered Voltage. For Three 

phase WYE (Star) systems, this value will be calculated by dividing the Voltage by 

the square root of 3. 

Maximum CB Size 

The Maximum CB Size is the largest circuit breaker that you desire to use. 

TraceCalc Pro will only design heating cables that are compatible with the lower of 

(1) this breaker size or (2) factory defined circuit requirements. 

The program uses this data to determine the maximum heating cable length that can 

be connected to the circuit breaker or fuse. 

A CB load factor is applied to calculate the maximum permissible load for this 

device. Standard practice, in accordance with the U.S. National Electrical Code and 
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the Canadian Electrical Code, is to load a circuit breaker to no more than 80% of its 

nominal current rating (for example, a 30 amp circuit may be loaded to 24 amperes). 

In Europe, the maximum load is normally 100% of the nominal rating. For more 

information, refer to “Design Tab” on page 93. 

In general, the larger the circuit breaker size, the longer the heat-tracing circuit, and 

in turn, the fewer the number of heat-tracing circuits required. You should refer to 

the product literature to confirm that the circuit breaker chosen for the design does 

not exceed the maximum size allowed for the heating cable selected. 

Reference Tab 

Use the Reference tab to enter data such as area, fluid, drawing number, and location 

details of the heat-tracing installation. 

 

Reference 

The information included in the reference section is displayed in various reports. 

You should use this information to help organize your design, particularly as your 

designs become more complicated. 

Area 

In a large design project, there may be several areas where heat tracing is required. 

You can select the default Area name or create a list of Area names to suit your 

needs.  

… Customize Areas 

To add, modify, or delete an Area name, click the ellipsis button  adjacent to the 

Area field to open the Customize Areas dialog box. 

The area names you enter or modify will be available for selection for any existing 

lines or new lines you add to this project. You can then print reports for specific 
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areas by applying Area name as the ‘filter’ condition. For more information, please 

see “Filter Settings” on page 87. 

 Add – To add an Area name, click Add. Enter a name. For example, 

enter a meaningful or description, such as ‘Plant 9’ or ‘Loading area.’ 

Click OK, and then Close.  

 Modify – To modify an Area name, highlight the name you wish to 

modify. Click Modify. Edit the name as necessary. Click OK, and then 

Close. 

 Delete – To delete an Area name, highlight the name you wish to 

delete. Click Delete. You will be prompted to confirm that you really 

want to delete this item. Once deleted, it cannot be restored. Click Yes 

to confirm, and then Close. 

 Copy (using right-click) – To copy an Area name, highlight the name 

you wish to copy and then right-click and select Copy from the pop-up 

menu. You can then Paste or Paste Append the copied data. 

 Paste (using right-click) – You can copy and paste some or all of the 

properties of an Area name to an existing Area name. Highlight the 

Area name you wish to paste the data to and right-click and select 

Paste. The Paste Area window shows you the source and destination 

of the data and you are then able to select to paste the properties of the 

Area name the description. This will overwrite that data associated with 

the destination Area name. You can also select All to check all the 

groups of items or None to clear all the checked items.  

 Paste Append (using right-click) – All of the properties of a copied 

Area name can be pasted to a new Area name. Highlight any Area 

name and right-click and select Paste Append. Enter a new Area name 

and click OK. You can then use Modify to edit the information for the 

new Area name. 

Fluid 

The Fluid field can be left blank. However, this field allows you to develop a list of 

fluid names for the project. You can select a previously entered Fluid name or enter 

a new one. 

… Customize Fluids 

To add, modify, or delete a Fluid name, click the ellipsis button  adjacent to the 

Fluid field. This opens the Customize Fluids dialog box. 

The fluid name you enter or modify will be available for selection for any existing 

lines or new lines added to this project. You can print reports for lines grouped by 

Fluid name by applying this as a custom ‘filter’ condition. For more information, 

please see “Using the Filter and Sort Settings Dialog Box” on page 87. 

Identifier/Description 

 Add – To add a Fluid name, click Add. Enter a name. Click OK. The 

Fluid Properties dialog box opens. Enter specific properties of this 

fluid.  

 Modify – To modify a Fluid name, highlight the name you wish to 

modify. Click Modify. The Fluid Properties dialog box opens. Edit the 
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specific properties of this fluid, as necessary. Click OK, and then 

Close. 

 Delete – To delete a Fluid name, highlight the name you wish to 

delete. Click Delete. You will be prompted to confirm that you really 

want to delete this item. Once deleted, it cannot be restored. Click Yes 

to confirm, and then Close. 

 Copy (using right-click) – To copy a Fluid name, highlight the name 

you wish to copy and then right-click and select Copy from the pop-up 

menu. You can then Paste or Paste Append the copied data. 

 Paste (using right-click) – You can copy and paste some or all of the 

properties of a Fluid name to an existing a Fluid name. Highlight the 

Fluid name you wish to paste the data to and right-click and select 

Paste. The Paste Fluid window shows you the source and destination 

of the data and you are then able to select to paste the properties of the 

Fluid name. This will overwrite that data associated with the 

destination a Fluid name. You can also select All to check all the 

groups of items or None to clear all the checked items.  

 Paste Append (using right-click) – All of the properties of a copied a 

Fluid name can be pasted to a new a Fluid name. Highlight any Area 

Name and right-click and select Paste Append. Enter a new a Fluid 

name and click OK. You can then use Modify to edit the information 

for the new a Fluid name. 

Drawing No. 

This is a reference field where you can enter data to better identify the lines in the 

reports, cross-referencing them to the pipe drawing. You can leave this field blank if 

you wish. 

You can print reports for lines sorted by Drawing Number by applying this as a 

custom ‘filter’ condition. For more information, please see “Using the Filter and Sort 

Settings Dialog Box” on page 87. 

Location 

Indoor / Outdoor 

Specify whether the heat-tracing installation will be Indoor or Outdoor. If it is 

Indoor, then no allowance is made for additional heat loss as a result of wind. If the 

heat tracing is in an indoor area, but still subjected to wind, such as a loading bay, it 

is advisable to specify the application as Outdoor. 

Wind Speed 

This entry is required for outdoor applications. You should enter a reasonable value 

to ensure the design is done for ‘worst case’ conditions. However, you should enter 

an average sustained wind speed (over a period of hours) rather than the maximum 

speed of a short gust. 

Chemical Exposure 

You can select ‘None’, ‘Organics’ or ‘Inorganics’. This will influence the outer 

jacket selection for some heating cables. However, for applications with particularly 

severe exposure conditions, you should confirm that the selected heating cable is 
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suitable for the anticipated exposure. Please also refer to the product literature to 

confirm the suitability of the selected material with your chemical exposure. 

Startup Temperature 

The Startup Temperature is the lowest pipe or equipment temperature expected 

when the heating cables are switched on. It might be the Minimum Ambient 

temperature, but realistically will often be higher. TraceCalc Pro uses the Startup 

Temperature to calculate the maximum current at the startup temperature. This is 

particularly important for self-regulating heating cables. 

For self-regulating heating cables, which draw more current at lower temperatures, 

the startup temperature impacts the maximum circuit length allowed since longer 

circuit lengths will draw a higher current at lower temperatures. Entering a very low 

value, such as the Minimum Ambient temperature, will result in shorter maximum 

circuit lengths for a given size Circuit Breaker. If you anticipate that the heating 

cables will never need to be started ‘cold’ (i.e. when the pipe and contents have 

reached the Minimum Ambient temperature), then you should select a more realistic 

Startup Temperature to allow the use of longer circuit lengths.  

HL Safety Factor 

The HL Safety Factor (heat loss safety factor) is a user-specified increase to the 

calculated heat loss by a specified percentage to ensure that the heating cable 

provides extra power. It is one way to compensate for important design variables that 

cannot be controlled or quantified.  

While 10% is a typical factor for designs at low or moderate temperatures, for higher 

temperatures, many material properties, installation variables, and heat transfer 

processes become more important. To compensate for these additional potential heat 

loss factors, which are difficult to predict or quantify accurately, we recommend 

higher safety factors as shown below: 

 Below 150°C (300°F)-- 10% 

 Up to 260°C (500°F)-- 25% 

 Above 260°C (500°F)-- 50% or more depending on the application 

Keep in mind that this is not the only safety factor incorporated in your design. There 

are other safety factors incorporated automatically in the design, such as a 

conservative Minimum Ambient temperature, the minimum power output of the 

heating cables, the conservative thermal conductivity of the insulation and other 

variables. A high value should not be relied upon to compensate for extreme changes 

from the initial design conditions, such as wet or improperly installed insulation. 

Comment 

Use the Comment field to enter comments about the line being designed. This 

information is for your convenience only and can be left blank. 

TIP: You can enter an identifier code in this field so that a report can be printed for 

lines grouped by Comments by applying this as a custom ‘filter’ condition. For more 

information, please see “Using the Filter and Sort Settings Dialog Box” on page 87. 
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Area Class Tab 

 WARNING: Fire or Explosion Hazard. Designs for hazardous locations that 

are based on incorrect data can create a risk of fire or explosion. Be sure your data is 

reliable or consult an expert for assistance. 

Use the Area Class tab to enter area class data associated with your heat-tracing 

installation. 

TraceCalc Pro provides two systems for the classification of areas containing 

explosive gases: 

 The Class-Division System, which is the primary system in use in 

North America. This system is described in API-RP-500, the NFPA 

National Electrical Code and the Canadian Electrical Code. 

 The IEC Zone System, which is the primary system in use in Europe. 

This system is also described in API-RP-505 and referenced in the 

NFPA National Electrical Code and the Canadian Electrical Code. 

 Equipment intended for installation in Zone classified locations must be 

designed by a registered P.E. – NEC 505.7 (A)” 

Both systems have the same goal—preventing the explosion of volatile gases caused 

by heat or an electrical spark. Both systems use the auto-ignition temperature and the 

probability of occurrence of volatile gas, combustible dust or fibers as the basis for 

classification of the areas. 

You must provide the auto-ignition temperature or pick a T-Rating matching your 

hazardous location. Remember that even a water line in an area where explosive 

gases can be present might need special attention to the selection of products, 

components and controls. The processes in the area determine the classification, not 

the fluid in the pipe. Pentair Thermal Management Technical Support can provide 

more information about relevant API, NEC and IEC documents concerning 

hazardous locations. 

 
Area Class Tab for US/Canada as Standards Body 
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Area Class Tab for CENELEC as Standards Body 

Standards Body 

You must select the Standard Body from the list of choices available. Depending on 

your version, you can select from US, CANADA, and/or CENELEC. This enables 

the program to only select products with the appropriate certifications.  

 US represents FM, UL, or other equivalent Nationally Recognized 

Testing Laboratories (NRTL). 

 CANADA represents CSA. 

 CENELEC represents European approval agencies such as BASEEFA, 

FIMCO, KEMA, LCIE, NEMKO, PTB, SEMKO, and so on. 

Class/Area Classification 

For North American standards, select the appropriate Class. You will notice that 

only Class I allows the further selection of Zone 1 or Zone 2. If you select 

CENELEC in the Standards Body field, your selections will be Non-hazardous, for 

gas atmosphere Zone 1 and Zone 2 and for dust atmosphere Zone 21 and Zone 22. 

Division / Zone 

Select the Division or Zone classification if the design is for a hazardous location. 

Gas / Dust Groups 

When the Class and Division / Zone have been entered, the appropriate choices of 

Gas or Dust groups are available for selection. Select the group that represents the 

most critical condition. If you select CENELEC in the Standards Body field, 

Gas/Dust groups are directly selectable as part of the area classification. 
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Design Parameters 

If any hazardous location has been selected, it is necessary to enter either the 

maximum T-rating of the equipment intended to be used for the design or the auto-

ignition temperature for the specific gases or dusts in this specific hazardous 

location.   

T-Rating 

Standards associations have established the T-rating, or temperature rating, as a 

means of classifying electrical equipment based on the maximum temperature an 

exposed surface may attain. 

The T-rating is identified as the “Temperature Identification Number” in the 

National Electrical Code (U.S.), as the “Temperature Code” in the Canadian 

Electrical Code, and as the “Temperature Class Number” in IEC standards. 

The purpose of the T-rating is to ensure that electrical equipment does not exceed the 

auto-ignition temperature of flammables that might be present in a hazardous 

location. 

If you select Specify equipment T-rating and then select the appropriate T-rating 

from the list, the program simply selects a heating cable with a T-rating less than or 

equal to the one you selected. See the table below for T-rating designations and 

associated temperatures. 

Table 5-1: Temperature ratings 

 

Division  
T-Rating 

Temperature  
(°C) / (°F) 

Zone  
T-Rating 

T1 450 / 842 T1 

T2 300 / 572 T2 

T2A 280 / 536  

T2B 260 / 500  

T2C 230 / 446  

T2D 215 / 419  

T3 200 / 392 T3 

T3A 180 / 356  

T3B 165 / 329  

T3C 160 / 320  

T4 135 / 275 T4 

T4A 120 / 248  

T5 100 / 212 T5 
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Division  
T-Rating 

Temperature  
(°C) / (°F) 

Zone  
T-Rating 

T6 85 / 185 T6 

 

Auto-Ignition Temperature 

If you select Specify Auto-Ignition Temperature, enter the lowest Auto-Ignition 

temperature for the hazardous materials present. The program will select a heating 

cable with a temperature T-Rating or conditional sheath temperature less than or 

equal to the stated Auto-Ignition Temperature. 

The program determines the heating cable sheath temperature by using two 

approaches: (1) A product classification approach in which the maximum self-

generated sheath temperature of the heating device has been established by testing 

the device in an artificial environment simulating worst-case conditions in 

accordance with IEEE 515 – 1997 4.2.2, similar clauses in EN 50-014 and other 

similar standards. (2) A systems approach, in which Pentair Thermal Management 

has demonstrated the ability to predict sheath temperatures by conducting tests in 

accordance with IEEE 515 – 1997 4.2.1 and other similar standards. Additional 

criteria for the design are required (maximum Ambient temperature, no wind, etc.). 

Additional criteria that TraceCalc Pro uses to determine the maximum sheath 

temperature are summarized in Table 5-2 in “Allow Stabilized Design” on page 53. 

Sheath Temperature Calculation Options 

These options determine how sheath and contact temperatures of heating cables are 

calculated and should only be changed by users who are very familiar with heat-

tracing design and control methods. 

Allow Stabilized Design 

If this option is not selected, the program will only search for heating cables that 

match the T-Rating (T-Class) under any condition (so called unconditional T-Rating) 

and would such exclude the use of any power-limiting or series heating cable, 

because their surface temperature must be calculated based on the application. By 

default, Allow stabilized design is checked to allow for a wide variety of heating 

cable technologies. If you check the Allow stabilized design box, the program 

typically calculates the maximum sheath temperature of the heating cable under 

worst-case conditions (over-voltage, max. heating cable tolerances, uncontrolled pipe 

or highest pipe Operating temperature, no wind at Maximum Ambient temperature). 

The calculated sheath temperature will then be compared with the Auto-Ignition 

Temperature or the upper limit of the T-rating you previously entered unless you 

select an additional control system. Depending on the Standards Body and your 

definition of the area, the worse case is defined by applying different parameters, 

which are shown in the following table. 

Table 5-2: Sheath temperature calculation 
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For more information on the criteria applied for a hazardous location, see “Appendix 

B: Hazardous Gases and Vapors” on page 129. 

Use Control Limited Design 

This option allows you to influence the way TraceCalc Pro determines the 

calculation of the maximum sheath temperature as well as the contact temperature 

between the heating cable and the pipe (if applicable, e.g. for plastic pipes).  

Check the Use control limited design box if you wish to include a temperature 

controller to limit the sheath temperature of the heating cable. You must verify, 

independent of the TraceCalc Pro program, whether a single controller (with or 

without failure annunciation) is permissible, or whether there is a requirement for a 

separate high temperature limit controller (perhaps even with a manual reset 

requirement) to de-energize the heating cable. Check local codes and standards to 

verify requirements. TraceCalc Pro assumes the requirements summarized below 

when selecting controls. 

Table 5-3: Control limited design requirements 

 

Class Division/ 
Zone 

Group Requirements for  
control limited design  

NEC/CEC 

Requirements for control 
limited design 

CENELEC 

Non- 

haz. 

- - Sheath temperature calculation based on 

max. controlled temperature, no need for 
failure alarm 

Sheath temperature 

calculation based on max. 

controlled temperature, no 
need for failure alarm 

I D1 A,B,C,D Not allowed n/a 

I D2 A,B,C,D Line sensing with failure alarm  

or std. line sensing and additional lockout 

n/a 

II D1, D2 E,F Line sensing with failure alarm  n/a 

Area 
Class 

Area 
Division/ 

Zone 

Area 
Group 

Over 
voltage: 

NEC 

Over 
voltage: 

CEC 

Over 
voltage: 

CENELEC 

Max. Sheath 
Temp: 

FM 

Max Sheath 
Temp: 
CSA 

Max. Sheath 
Temp: 

CENELEC 

Non- 
haz. 

- - 100% 100% 100% - - - 

I D1 A,B, 
C,D 

120% 110% - ≤80% AIT 100% AIT - 

I D2 A,B, 
C,D 

110% 110% - 100% AIT 100% AIT - 

II D1, D2 E,F 110% 110% - 100% AIT 100% AIT  

II D1, D2 G 110% 110% - The lower of 

165°C or 

100% AIT 

The lower of 

165°C or 

100% AIT 

- 

III D1, D2  110% 110% - 100% AIT 100% AIT  

(I) Z1 - 110% 110% 110% ≤80% AIT 100% AIT AIT – 5K for 
AIT≤200°C 

AIT – 10K for 
AIT>200°C 

(I) Z2 - 110% 110% 110% 100% AIT 100% AIT AIT – 5K for 

AIT≤200°C 

AIT – 10K for 
AIT>0200°C 
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Class Division/ 
Zone 

Group Requirements for  
control limited design  

NEC/CEC 

Requirements for control 
limited design 

CENELEC 

or std. line sensing and additional lockout 

II D1, D2 G Line sensing with failure alarm  

or std. line sensing and additional lockout 

n/a 

III D1, D2  Line sensing with failure alarm  

or std. line sensing and additional lockout 

n/a 

(I) Z1 - Line sensing with failure alarm  

or std. line sensing and additional lockout 

Line sensing with or 

without failure alarm  

and additional lockout 

(I) Z2 - Line sensing with failure alarm  
or std. line sensing and additional lockout 

Line sensing with failure 

alarm  

or std. line sensing and 
additional lockout 

 

Control Limited Setpoint 

You will need to specify the setpoint for the control limited design. It needs to be 

slightly above Maintain temperature, but can also be much higher, if you apply the 

control limited design using a high limit cut-out approach. 

It is also important to place the temperature sensor used for control limited designs at 

the most representative location for the warmest section of the heat-tracing circuit. If 

your temperature controller allows, it is good design practice to use a separate 

temperature sensor for this function, otherwise it is recommended that you define the 

set point sufficiently above the Maintain temperature to allow for a safe operation. 

Note: If you check the Use control limited design box, a default value slightly 

above the Maintain temperature is automatically entered in this field. You can 

override these default values.  

For information regarding ignition temperatures of gases, vapors, dusts, fibers or 

flyings, see Classification of Gases, Vapors, and Dusts for Electrical Equipment in 

Hazardous (Classified) Locations, NFPA 497M-1991, and Fire Hazard Properties of 

Flammable Liquids, Gases, and Volatile Solids, NFPA 325M-1991. 

Heater Options Tab 

Use the Heater Options tab to specify heater category and heater selection for your 

heat-tracing project. 
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Heater Category Selection 

TraceCalc Pro allows you to choose various heater technologies. Each technology is 

a different heating cable construction and requires some differences in the design 

method.  

Category 

You can select from any of the technologies available in the selection list. 

 Parallel Cables – Parallel heating cables can typically be cut to length 

in the field, simplifying installation. 

 Series Cables – Includes cables such as Mineral Insulated (MI) heating 

cables and other series cables using a resistance wire as the heating 

element. The availability of this selection may depend on your user 

authorization.  Contact Pentair Thermal Management if you require this 

option. 

Conductors 

The Conductors box is only applicable for Series heating cables. Series heating 

cables with various numbers of conductors may only be offered for certain 

geographic areas or approval settings. 

Design Options 

Manual Select Attachment 

Check the Manual Select Attachment box to view the list of attachment methods 

available for selection.  

If you leave the Manual Select Attachment box unchecked, the program will select 

an appropriate method by default. 
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The method used to attach a heating cable to a pipe or vessel can affect the heat 

output of the heating cable. This is particularly relevant when installing self-

regulating heating cable.  

 Glass tape is the typical attachment method for parallel heating cables. 

 Adhesive-backed aluminum tape allows better dissipation of heat and is 

often used on plastic pipes. Self-regulating heating cables will generate 

more power when installed with aluminum tape than when installed 

with glass tape due to improved heat transfer.  

 The Channel option is often used on pre-insulated piping. When a self-

regulating heating cable is used in a channel, it will operate at reduced 

power and the program will make this adjustment. 

 Banding or tie wires are typically used with metal sheathed heating 

cables and are not appropriate for cables with polymer insulation. 

If an inappropriate method of attachment is selected, the program will override this 

selection without warning. 

Allow Spiraling (Piping Only) 

The most efficient way of applying heating cable is to install it straight along the 

pipe, so we recommend you leave the Allow Spiraling box unchecked. However, by 

checking this box, you allow the program to more closely balance the heat provided 

to the heat required by specifying the degree to which the heating cable should be 

spiraled.  

Force Trace Ratio (Piping Only) 

Check the Force Trace Ratio box if you wish to make the program use a specific 

trace ratio.  After doing so, click on the Settings… button to display the following 

window: 

 

The following fields are available from this window: 

 Voltage configuration – This is a read-only field and it is displayed as 

a reminder of  voltage configuration for the current line. For more 

information, see “Electrical” on page 45. 

 Number of cables – From the drop-down list, select how many 

separate runs of heater cable you would like to have on this line.  This 

field is used in conjunction with the Trace ratio per cable field below 

in order to determine how many total passes of heater are applied to the 

current line.  If you were using a 3-phase voltage configuration, this 

field would be labelled Number of Cable Groups and it would be 
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assumed that three separate cables are required to make up a single 

circuit. 

 Trace ratio per cable – Enter the desired trace ratio per run of cable.  

If you have checked Allow Spiral on the previous Heater Options tab, 

then you can enter fractional trace ratios, such as 1.5.  Otherwise, you 

will be limited to whole number values for this field. 

 Total pipe trace ratio – This is a read-only field where TraceCalc Pro 

displays the total trace ratio for the current line.  This value is derived 

from the preceding two fields. 

Heater Design Options… (Vessels Only) 

Click the Heater Design Options… button to bring up the Heater Design Options 

dialog box.  

 

 Limit Heater Output – Check this box if you want to limit the heater 

to some maximum value.  When you check the box, the text box is 

enabled, allowing you to enter the maximum heater wattage per unit 

length. 

 Force Segment Length – If you know that your design will require 

more than one power connection, you may choose to set the length of 

each cable set.  Checking this box enables the text box.  Enter the 

desired segment length in the text box. 

 Cover All Available Area – If you select Cover All Available Area, 

and enter a desired Heater Spacing, TraceCalc Pro calculates a cable 

length using your available area and preferred heater spacing, and 

selects the most economical cable possible, giving the required power 

with the required length.  By contrast, if you do not select this option, 

TraceCalc Pro may select a shorter length of higher wattage cable, 

since that may result in lower cable cost. 
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Heater Selection 

We strongly recommend that you only use this option to force certain parameters of 

the heater selection if you are very familiar with TraceCalc Pro and its heating cable 

selections. Leaving all boxes unchecked will give TraceCalc Pro the flexibility to 

select the most appropriate products for your application. 

Family 

Check the Manual Select box adjacent to Family if you wish to force the program to 

use a heating cable from a specific family. 

Heater 

Check the Manual Select box adjacent to Heater if you wish to force the program to 

use a specific heating cable. 

Dielectric 

Check the Manual Select box adjacent to Dielectric if you wish to force the 

program to select cables constructed with a specific dielectric. 

Jacket Material 

Check the Manual Select box adjacent to Jacket Material if you wish to force the 

program to use a specific jacket material. 

Ground Path 

Check the Manual Select box adjacent to Ground Path if you wish to force the 

program to select a heating cable with a specific type of ground path. 

Components Tab 

Use the Components tab to manually select the connection system you wish 

TraceCalc Pro to use for the Power Connection, Splices, Tees and End Seals. You 

can also select a specific product from a list of optional configurations for that 

connection system. 
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Components 

A picture of the selected components will display in the selection area at the bottom 

of the screen. Each picture is simply a visual representation of a specific aspect of a 

component attribute. A picture only appears if you have automatically selected a 

component (by recalculation) or if you have forced a component. 

To view or change your component options, you must click on the appropriate 

component type tab at the left side of the Components screen.  For instance, in the 

picture above, the Power component options are visible.  To view and edit your end 

seal options, you would click the End Seal tab. 

TraceCalc Pro allows you to enter preferences only for needed components.  The 

pictured component screen is for a stand-alone parent line.  The Splice and Tee tabs 

are disabled, because a stand-alone line normally would require no splice or tee kits.   

When you make a component selection, it only applies to the line segment that is 

currently selected in the Project Explorer Pane.  As an example of how this works, 

suppose you have configured a line with two pipe segments; a parent and an end-

segment splice.  The line will need three component kits; power, splice and end seal.  

TraceCalc Pro associates each component with a particular pipe segment.  The power 

kit is associated with the parent segment; the splice kit and end seal are associated 

with the child segment.  When the parent is the selected pipe segment, only the 

power component tab is enabled.  The splice kit and end seal kit are ‘assigned’ to the 

child line, so those tabs are enabled when the end-segment splice pipe segment is 

selected, not when the parent segment is selected. 

The assignment is based on two things; connectivity, and function.  In the case 

above, both the parent and child are connected to the splice kit; but you could say 

that the splice kit is only needed because of the presence of the end-segment splice 

child, so the kit is associated with the child. 

There are two ways of selecting components; you may use the Attributes check 

boxes to indicate what attributes (for instance, Signal Light) you want on your 

component; or you may use the Manually Select … Group and Manually Select … 

Component check boxes and select a particular component group and component kit 

from the associated drop-down lists. 
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For all but advanced users, the preferred way of selecting components is by 

indicating desired component attributes.  Selecting desired attributes easy and does 

not require studying the list of available components. 

Attributes 

To indicate your preferred attributes for a particular component kit, simply click the 

appropriate tab of the component type tab (End Seal in the picture below); then 

check the box adjacent to the attribute you wish to select.  You may select more than 

one attribute, if available. 

If an Attribute check box is disabled, that is because no available component kit has 

that attribute.  In the case pictured below, after the user selected the Signal Light 

attribute, all other attribute check boxes became disabled, because no component kit 

with a signal light is installed off-pipe, under insulation, or with an earth plate. 

In the picture below, the user simply checked the Signal Light Attribute check box.  

TraceCalc Pro attempts to find a component with a signal light in its default group of 

end seal components.  It indicates that the actual end seal kit has a signal light with 

the X in the Actual Attribute column.  In this case, the picture also indicates the 

presence of a signal light. 

 

 

Manually Select … Component Group 

If you wish to restrict TraceCalc Pro to selecting from a particular set of component 

kits, then you would first check the Manually Select … Component Group check 

box, then choose the desired group of components from the component group drop-

down list.  For instance, if you are not designing in a hazardous area, but wish to 

force TraceCalc Pro to assign a component rated for Hazardous Area use, you may 

check Manually Select … Component Group and then select ‘Kits for Class I Div. 

1’ from the drop-down list box.   

If you have check this check box, then the Manually Select … Component check 

box will become enabled, allowing you to select a particular component kit if you 

wish. 
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During calculation, if you have checked this check box and no appropriate 

component is found for your particular pipe application in the selected component 

group, then TraceCalc Pro de-selects the forced component group, and attempts to 

find an appropriate component from another group of components (the default one). 

If you have not checked the check box, the component group drop-down list will be 

disabled; yet after calculation a component group will appear in the drop-down list 

box.  The component group shown is the group of components where TraceCalc Pro 

found the selected component.  It is the ‘default’ component group for the selected 

heater.  

Manually Select … Component 

If you wish to select a particular component kit, you must first select a component 

group using the Manually Select … Component Group check box.  You may then 

check the Manually Select … Component check box and select the desired 

component kit from the component kit pull-down list.  

Controls Tab 

Use the Controls tab to set the type of thermostatic control to be used, if any, and 

whether it is to be a centralized or local system. You can also select a specific 

product and assign which panel it is to control, if centralized.  

 

Control Method 

You can specify whether the heating cable will be controlled by a temperature 

controller or be Uncontrolled. Select the Control Method type from the selection 

list. This will tell the program which control method to use for all calculations. If you 

want to add the temperature controllers to the Bill of Materials, select: 

 Use centralized control equipment – Check this box if this 

temperature control system will be placed in a location, such as a panel 

or control room, removed from some or all of the circuits being 

controlled. 
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 Use local control equipment – Check this box if the control will be 

located in the immediate vicinity of the circuit being controlled, as is 

usually the case for line sensing thermostats. 

Note: If you have already allocated several lines to the same panel and now specify 

different control methods for some of these lines, the program will use a panel 

named ‘Unassigned’ and move the changed lines to this panel. You will see this in 

the Project Explorer Pane when in View By: Panel Groups mode. You may want to 

reconsider whether the lines should use different control methods or whether they 

should be supplied from another existing panel. You can use the Drag-and-drop 

feature in the Project Explorer Pane to relocate the lines to another existing panel, 

which will make the lines use the control method for this panel. 

Local Sensor Location 

If you have selected a local control method (Line Sensing or Line Sensing With 

Failure Alarm) for a line group, then the Local Sensor Location checkbox should be 

used to indicate which line segment has the sensor.  The line with the sensor will 

dictate the power being distributed to the whole group.  After the lines are calculated, 

the duty cycle of the line with the sensor will be used to calculate the controlled 

temperatures of the other lines in the group.  Any line whose controlled temperature 

is below the maintain temperature will have a WARNING. 

You can only change the Local Sensor Location by selecting the line where you 

intend to locate the sensor and clicking the Local Sensor Location checkbox.  You 

may not ‘de-select’ the checkbox if it is checked. 

The Local Sensor Location checkbox will be disabled for all other control methods.  

WARNING: On a line with child segments, the location of the temperature sensor 

must be selected with care as incorrect placement can cause over- or under-heating 

of some pipe sections and create a risk of fire or damage to the process material or 

piping.  

Centralized Control Equipment 

If you selected Use centralized control equipment, complete the following required 

fields.  

Panel Name 

The Panel Name field shows which panel the heat-tracing circuit is assigned to.  

You can change that assignment by selecting a different Panel Name from the list of 

all the panels with the same Control Method as the one selected. This change will 

be immediately shown in the Project Explorer Pane if you are in View By: Panel 

Groups mode.  

Conversely, if you move a heat-tracing circuit from one panel to another by using the 

drag-and-drop feature of the Project Explorer Pane, you will see that the new Panel 

Name is automatically entered in the Panel Name field. 

Customize Panels 

Click the Edit Panels button to add, modify, or delete a control panel name. 

 Add – To add a new panel name, click Add and enter a unique 

Identifier. Click OK. In the Control Panel Properties dialog box, enter 

a panel name, and select from a list of possible Control Methods for the 

panel. Then select from a list of products that can be used to provide 
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that control method. Finally, specify the quantity of this control product 

in the Product Qty. field. 

 Modify – To modify a panel name, highlight the panel you wish to 

modify. Click Modify. In the Control Panel dialog box, modify the 

panel name, specify the maximum allowable load for the panel (in kW) 

and select from a list of possible Control Methods for the panel. Then, 

select from a list of products that can be used to provide that control 

method. Finally, specify the quantity of this control product in the 

Product Qty. field. 

 Delete – To delete a panel name, highlight the panel name you wish to 

delete. Click Delete. 

 Copy, Paste and Paste Append – These menu items are available 

from the pop-up menu using right-click. However, as panels do not 

include lengthy data associated with them in this program, it is usually 

easier just to Add a new panel rather than copy the attributes of an 

existing one.  

TIP: You can also access the Panel Name list and Edit Panels feature from the Setup 

menu by selecting the Project Lists menu item then selecting Control Panels. 

Select Sensor 

Check the Select Sensor box and then select from a list of available sensors. The 

default number of sensors for the selected panel will be added to the Bill of Materials 

unless you override that quantity using the Force Central Sensor Qty. check box. 

Force Central Sensor Qty. 

If you have selected a particular sensor to go with a control panel, you may dictate 

how many are included in the Bill of Materials by checking the Sensor Qty. check 

box and entering the quantity in the adjacent text box. 

Local Control Equipment 

If you selected Use local control equipment, complete the following fields. 

Category 

Select either Electronic (e.g. RTD) or Mechanical (e.g. Bulb and Capillary) as the 

temperature sensing method. 

Select Product 

Check the Select Product box only if you want to choose a specific product. You 

can then select from the list of available temperature controllers matching the control 

method and enter the quantity of temperature controllers to be included for this line. 

You can also leave this option unchecked and let TraceCalc Pro find a product that 

matches your specifications. 

If you select a particular local control product, you may check the Force Qty: check 

box to force a particular number of control products. 
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Select Sensor 

If you have chosen an Electronic temperature sensor and have chosen the product, 

you can now check the Select Sensor box and select from a list of available sensors. 

You can also leave this option unchecked and let TraceCalc Pro find a product that 

matches your specifications. Then check the Force Qty: check box if you want to 

enter the quantity of sensors to be included for this line. Otherwise, TraceCalc Pro 

will select the number of sensors to include according to the control product 

specifications. 

Reference Information (optional) 

CB No. 

Enter the CB No. (i.e. a reference number for the circuit breaker) if you wish to have 

it for reference. This number will be useful if you anticipate exporting the results of 

this program to generate a listing of heat-tracing circuits sorted by CB Number. For 

more information about exporting data, see “Export” on page 14. 

You can also print reports for lines grouped by CB Number by applying this as a 

custom filter condition. For more information, see “Using the Filter and Sort 

Settings Dialog Box” on page 87. 

You can enter any text, up to 30 characters long, such as “Panel3”. 

Circuit No. 

Enter the Circuit No. if you wish to have it for reference. This number can be useful 

if you anticipate exporting the results of this program to generating a listing of heat-

tracing circuits sorted by Circuit Number. For more information about exporting 

data, please see “Export” on page 14. 

You can also print reports for lines grouped by Circuit Number by applying this as a 

custom filter condition. For more information, please see “Using the Filter and Sort 

Settings Dialog Box” on page 87. 

Vessel Properties Dialog Box 

The availability of all vessel options may depend on your user authorization.  

Contact Pentair Thermal Management if you require this option. 

The Vessel Properties dialog box is used to enter basic vessel data such as body 

style, dimensions and material, fill height, and insulation level.  There are separate 

input forms for vessel support data and heat sink data such as ladders, manholes and 

miscellaneous.  Please see “Vessel Supports Dialog Box” on page 69 and “Vessel 

Heat Sinks Dialog Box” on page 71. 

For an existing vessel, the Vessel Properties dialog box is accessed by clicking the 

Vessel Properties… button on the Basic Tab, or by double-clicking on the Vessel 

ID in the Project Explorer window. 

If you create a new vessel, the Vessel Properties dialog box appears automatically.  

There are three ways to create a new vessel; select Edit > Add Vessel… from the 

menu bar, click the Add Vessel button from the button bar, or right-click anywhere 

in the Project Explorer pane and select Add Vessel… from the pop-up menu. 

TIP:  If you click Cancel while first defining a vessel, no vessel will be created.  
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TIP:  The form is conveniently designed to enter data from top to bottom, down the 

left side and then the right, to complete data entry. 

Vessel ID 

The Vessel ID serves the same purpose as the pipe segment Line ID.  Since vessels 

do not have children, however, each Vessel ID must be unique.  There is no Section 

No. to differentiate between vessels. 

You may change the Vessel ID here on the Vessel Properties dialog, or on the Basic 

tab of the main project form. 

Style 

The Style section of the Vessel Properties dialog box allows you to specify the 

vessel body, top and bottom style; and to bring up the Vessel Supports Dialog and 

Vessel Heat Sinks Dialog.  The vessel graphic illustrates the selected style and 

required dimensions. 

Use the Type pull-down list to select the body style from the four available choices: 

vertical cylinder, horizontal cylinder, rectangular, and spherical. 

Use the Top pull-down list to select the top style from the available choices.  

Available top styles will be among conical, flat, floating, full dome, and half dome.  

The exact choices will depend on body style. 

Use the Bottom pull-down list to select the bottom style from the available choices.  

Available bottom styles will be among flat, truncated cone, truncated pyramid, full 

dome, and half dome.  The exact choices will depend on body style. 

Use the Supports button, the one with the ellipsis (…) to the right of the Supports 

text box, to bring up the Vessel Supports dialog box, described on page 69.  The 

Vessel Supports dialog box allows you to fully specify the vessel supports. 

Use the button labeled Heat Sinks… to bring up the Vessel Heat Sinks dialog box, 

described on page 71.  The Vessel Heat Sinks dialog box allows you to specify any 

ladders, manholes, handholes, nozzles, and miscellaneous heat sinks. 
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Body 

Dimensions: Diameter, Width, Height, Length 

Enter the body dimensions in the text boxes provided.  The vessel graphic illustrates 

the required dimensions. 

Minimum Fill; Maximum Fill 

The Minimum Fill Height is the minimum fill level, in length, up the side of the 

vessel body (the base, if it has volume, is assumed to be full). 

The Maximum Fill Height is the maximum expected fill level, again measured in 

units of length up the side of the vessel body.  

The maximum allowable value for the minimum and maximum fill heights is the 

vessel height (in the case of horizontal cylinders and spheres, the maximum 

allowable value is the vessel diameter). 

Insulation Height 

Insulation Height indicates how far up the body of the vessel the insulation extends.  

The maximum value is the body height (or diameter, for horizontal cylinders and 

spherical vessels).  The minimum value is the Maximum Fill Height. 

Available Area (Body) 

Enter the fraction of the vessel body that is available to be traced.  For example, to 

indicate that you want to restrict heat tracing to the bottom third of the vessel, you 

would enter 33% in the Available Area text box.   

Since the traced area must be insulated, the available area may not exceed the area 

defined by your insulation height. 

To trace all of the area you have specified with some specific spacing, you must in 

addition specify Cover All Available Area.  For more information, please see 

“Heater Design Options… (Vessels Only)” on page 58. 

Material (Body) 

The Material pull-down list is used to indicate the vessel wall material.  For metal-

walled vessels, you must select either stainless steel or metal (other than stainless).  

For plastic-walled vessels, the options are HDPE, FRC, or PVC.  Select the plastic 

type that has thermal properties closest to those of your vessel. 

WARNING:  If you are designing for plastic vessels, make sure that you have 

indicated the maximum allowable temperature on the Basic Tab of the TraceCalc Pro 

Design Pane to avoid possible damage to the vessel. 

Material Thickness 

Use this text box to enter the vessel body wall thickness. 

Heater Design Options… 

The Heater Design Options… button brings up the Heater Design Options dialog 

box, which allows you to set the parameters Limit Heater Output, Force Segment 
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Length, and Cover All Available Area.  For more information, please see “Heater 

Design Options… (Vessels Only)” on page 58. 

Top 

Height (Top) 

If the selected top style is conical, then you should enter its height. 

Available Area (Top) 

Enter the fraction of the vessel top that is available to be traced.  The minimum value 

is 0; the maximum is 100%. 

Since any traced area must be insulated, if your top is not insulated, the Available 

Area is set to zero and cannot be changed. 

To trace all of the area you have specified with some specific spacing, you must in 

addition specify Cover All Available Area.  For more information, please see 

“Heater Design Options… (Vessels Only)” on page 58. 

Top Insulated 

To indicate that the top of the vessel is insulated, check the Top Insulated check 

box.  

If the top is not insulated, then no heat tracing will be allowed there (the Top 

Available Area will be set to zero and may not be changed). 

Bottom 

Dimensions: Height, Width, Length, Diameter 

If the selected bottom style is a truncated cone or truncated pyramid, then you will 

enter the dimensions.  For a truncated cone, the needed dimensions are bottom height 

and bottom diameter.  For a truncated pyramid, the needed dimensions are bottom 

height, bottom length, and bottom width. 

The dimensions will be illustrated by the vessel graphic that appears on the Vessel 

Properties dialog box. 

Bottom Insulated 

To indicate that the bottom of the vessel is insulated, check the Bottom Insulated 

check box.  

This option is only enabled in the case of the closed skirt.  If the vessel has a closed 

skirt with an access port, you may indicate that the bottom is insulated by checking 

the Bottom Insulated check box.  For all other support types, the option is disabled. 

If the support type is legs, gussets, saddle, or open skirt, the check box is checked 

and cannot be changed.  You must insulate the vessel bottom if you use leg, gusset, 

saddle or open skirt supports.  If the support type is slab, the check box is cleared and 

cannot be changed.  No insulation is assumed if the vessel is on a slab. 

If the bottom is not insulated, then no heat tracing will be allowed there (the Bottom 

Available Area will be set to zero and may not be changed). 
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Available Area (Bottom) 

Enter the fraction of the vessel bottom that is available to be traced.  The minimum 

value is 0; the maximum is 100%. 

Since any traced area must be insulated, if the bottom is not insulated, the Available 

Area is set to zero and cannot be changed. 

To trace all of the area you have specified with some specific spacing, you must in 

addition specify Cover All Available Area.  For more information, please see 

“Heater Design Options… (Vessels Only)” on page 58. 

Vessel Supports Dialog Box 

Use the Vessel Supports dialog box to enter all support data for a vessel.  The Vessel 

Supports dialog box is accessible from the Vessel Properties dialog box. 

 

Type 

Select from slab, gusset, leg, saddle, open skirt, and closed skirt.   

The available choices will depend on the vessel body style and bottom style.  Saddles 

are only available for horizontal cylinders.  Slab is only available for vessels with flat 

bottoms. 

Material 

Available materials will be among stainless steel, carbon steel, aluminum, concrete, 

and other (depending on the support type chosen).   

Other is always available.  If you wish to adjust the material thermal conductivity (k-

factor), then select Other to enable the K-Factor text box. 

Quantity 

The number of supports (Quantity) applies if the support type is saddle, leg or 

gusset.   If you select Use TCPro default settings for support properties,  

If you select Use TCPro default settings for support properties, you will not be 

able to set the Quantity.  TCPro will automatically set and update it whenever you 

change the vessel or support definition.  For more information, see “Use TCPro 

default settings for support properties” on page 70. 

K-Factor 

Standard values of thermal conductivity (K-Factor) are used for all materials.  The 

K-Factor may not be changed unless you select Other as the support Material. 
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Cross-sectional Area and Perimeter 

The Cross-sectional Area and Perimeter of a leg, saddle or gusset support is the 

area and perimeter of the surface of the support that is in contact with the vessel.  

The support graphic on the Vessel Supports dialog box illustrates the required 

dimensions.    

If you select Use TCPro default settings for support properties, you will not be 

able to set these dimensions.  TCPro will automatically set and update them 

whenever you change the vessel or support definition.  For more information, see 

“Use TCPro default settings for support properties” on page 70. 

Skirt Wall Thickness and Perimeter 

For skirts, instead of entering the Cross-sectional Area and Perimeter, you will 

enter the Skirt Wall Thickness and the outer Perimeter where the skirt meets the 

vessel.  When you select skirt as the support type, a graphic on the Vessel Supports 

dialog box illustrates the required dimensions.    

If you select Use TCPro default settings for support properties, you will not be 

able to set these dimensions.  TCPro will automatically set and update them 

whenever you change the vessel or support definition.  For more information, see 

“Use TCPro default settings for support properties” on page 70. 

Slab Thickness 

For slabs, enter the Slab thickness.   

If you select Use TCPro default settings for support properties, you will not be 

able to set Slab Thickness.  TCPro will set and update it whenever you change the 

vessel or support definition.  For more information, see “Use TCPro default 

settings for support properties” on page 70. 

Insulated? 

You can greatly reduce heat loss from vessel supports  by insulating them.  

TraceCalc Pro will make allowance for insulated supports if you check the 

Insulated? check box. 

IMPORTANT:  If you use support insulation, in order to avoid underestimating your 

support heat loss, you must insulate the support as follows: 

Leg, saddle and open skirt supports must be insulated along at least the first two feet 

from where they meet the vessel. 

Closed skirts must be fully insulated. 

Gussets must be insulated along the first four inches from where they meet the vessel 

if the vessel is very small.  For vessels over 6 feet in diameter, the insulation must 

extend at least ten inches from where the gusset meets the vessel. 

Use TCPro default settings for support properties 

By default, the support properties quantity, cross-sectional area, perimeter, skirt wall 

thickness, and slab thickness will be automatically updated for you.   

TraceCalc Pro will initialize all support properties when the support type changes.  

By default, TCPro will also automatically recalculate default values and update the 

support properties with the new defaults if you change vessel type, size or support 

material.  
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If you prefer NOT to have TCPro update these properties, then you must clear the 

check box marked Use TCPro default settings for support properties.  It is 

checked by default.  If you do clear the check box, you must update the support 

properties yourself. 

Vessel Heat Sinks Dialog Box 

Heat sinks are a significant source of heat loss and must not be neglected in vessel 

heat-tracing system designs. 

Use the Vessel Heat Sinks dialog box to enter data for all heat sinks other than 

supports.   

Ladders, manholes, handholes and nozzles all may be defined on the Vessel Heat 

Sinks dialog box.   

For other heat sinks, you may choose to use the ‘Miscellaneous’ heat sink category.   

Finally, for any heat sinks that you have not accounted for in any other way, you 

may specify an additional length of heater. 

 

 

Accessories 

You may create up to three different accessory “definitions”.  For each accessory 

you define, you specify how many (the Quantity), the Diameter, the Height, 

whether it is Insulated, and whether it is above the maximum fluid level. 

Type 

Select from manhole, hand hole, or nozzle.  If you wish to remove an accessory 

definition, you may select the blank from the drop-down list, and the other fields will 

be cleared. 

Quantity 

Enter the number of accessories that match this definition.  For instance, if you have 

two manholes that are essentially the same, you may create one accessory definition, 

and enter ‘2’ in the Quantity field. 

If you enter zero Quantity, the accessory definition will be removed. 
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Diameter 

Enter the accessory outer Diameter. 

Height 

Enter the Height that the accessory extends from the vessel.  For a nozzle, you might 

think of this as the length. 

Insulated? 

If the sides and top of the accessory are insulated, then check this check box.  If not, 

then clear the check box. 

It is not possible to indicate that only the sides of an accessory are insulated or that 

only the end is insulated.  If that is the case, then you should clear this check box. 

Above Max Fill Level? 

If the inner surface of the accessory will ever be wet, then you must clear this check 

box.  Check this check box only if the accessory is entirely above the maximum fill 

level of the vessel.   

TraceCalc Pro neglects the contribution of accessories that are entirely above the 

maximum fill level. 

Ladders 

Use this section to define any ladders that extend below the maximum fill level.  You 

may neglect any ladders and handrails that are above the maximum fill level. 

If you have more than one ladder, a single definition must be used for all of them. 

Material 

Select Carbon Steel or Other from the drop-down list.  If you select Other, you will 

be allowed to change the thermal conductivity (K-Factor). 

Quantity 

Enter the number of ladders. 

K-Factor 

Enter the ladder thermal conductivity.  If you have selected Other as your ladder 

Material, this field will be editable.  Otherwise, it will be read-only.  

Contact Points With Vessel 

Enter the number of supports attaching each ladder to the vessel. 

Cross-Sectional Area and Perimeter 

These dimensions are measured from the cross-section of the ladder support where it 

meets the vessel.  The ladder support cross-sectional area and perimeter are exactly 

analogous to the cross-sectional area and perimeter of a leg support. 
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Miscellaneous 

If you know of other heat sinks that are not accounted for as accessories or ladders, 

you can include a single allowance for all of them together. This allowance can be 

based on a fraction of vessel body heat loss, or on total wattage as described below. 

 Allow percentage of vessel body heat loss.  This selection adds a user-

defined percentage of the vessel body heat loss, resulting in extra cable that 

can be installed wherever needed. Check this button and enter a percentage 

value in the Quantity (%) field.  This will cause the program to add an 

additional length of heating cable to provide the number of watts specified 

by the given percentage of the total body heat loss. 

 Allow Lump sum watts.  This selection adds a user-defined amount of 

watts to the calculated heat loss. Check this button and specify the total 

additional heat loss in the Quantity (W) field. This will cause the program 

to specify an additional length of heating cable to provide the specified 

number of watts at the Maintain temperature and Minimum Ambient 

conditions. 

Additional length of heater 

This selection adds a user-defined length of heater, resulting in extra cable that can 

be installed wherever needed.  Check this button and specify the total additional 

length of cable in the Quantity field. 

Viewing Calculated Results 

Use the Calculated Results Pane to view a brief summary of the values calculated by 

the program as a result of the data you provided. 

You can resize the window to show all the information without scrolling, or shrink it 

to a minimal height when you do not wish to view the results.  Note: This pane might 

be hard to see if your screen resolution is smaller than 1024x768 or if you are using 

the “large fonts” setting for the appearance in Windows Display Properties. 

Before viewing the results, you will need to select Calculate from the menu, which 

offers the following choices for generating calculated results: 

 Current Record – This command calculates the results only for the 

line that is highlighted in the Project Explorer Pane. 

 All Records – This command calculates, or recalculates all lines in the 

project. However, only the line that is highlighted in the Project 

Explorer Pane will have its results shown in the Calculated Results 

Pane. You will need to highlight each of the lines in the Project 

Explorer Pane to show their results in the Calculated Results Pane. 

 Changed Records Only check box – When this box is checked, the 

program will only recalculate lines that have been changed since they 

were last calculated.  

Status Messages 

The first line of the window will show the status of the calculation. Several warning 

or error messages might apply at the same time. In this case, you will see a down 

arrow appear on the right end of the message text. Click on this arrow to see all the 

messages. 
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Status Messages Explanations 

RECALC – Heat loss calculation required Data has not been processed or has been 

changed since the last calculation. Select 
Calculate in the main menu, use the F9 key, 

or use the Recalculate icon to view the 

updated results. 

RECALC – Heater selection required 

OK The program has been able to complete its 

calculations with the data provided. 

ERROR 

 

A description to indicate the possible reason 
the program could not complete its 

calculations. 

WARNING The program has completed its calculations 

but has encountered a situation that you 
should review. 

 

Pipe Data 

If the selected item is a pipe segment, then the first column of the Calculated 

Results shows the values calculated for parameters related to the pipe segment. 

These include: 

 Heat Loss per unit length of pipe. This is the calculated heat loss based 

on the data you entered. 

 Total Heater Length – This is the total amount of heating cable 

required for the selected line/pipe segment. This is divided into the 

specific amounts for Pipes, Valves, Supports, Flanges and Misc., 

including contingencies for power connections, splices and any 

miscellaneous heat sink allowances.  

 for Piping – The total amount of heater that has been allowed to trace 

the length of this pipe segment. 

 for Valves( ) – The amount of heater that has been allowed to trace all 

the valves in this pipe segment. The number of valves that have been 

specified for this segment is shown in parenthesis. 

 for Supports( ) – The amount of heater that has been allowed to trace 

all supports in this pipe segment. The number of supports that have 

been specified for this segment is shown in parenthesis. 

 for Flanges( ) – The amount of heater that has been allowed to trace all 

flanges in this pipe segment. The number of flanges that have been 

specified for this segment is shown in parenthesis. 

 for Misc – The amount of heater that has been allowed to trace 

miscellaneous heat sinks for this pipe segment. For more information, 

see “Valves, Supports …” on page 39. 

 for Terminations – The amount of heater that has been allowed for 

heater terminations. Note: this only applies to heaters that are field 

terminatable. Also, the length shown is assumed to be “wastage” and is 

not included when calculating Electrical Data. 
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Vessel Data 

If the selected item is a vessel, then the first column of the Calculated Results 

shows the values calculated for parameters related to the vessel. These include: 

 Heat Loss. This is the calculated heat loss based on the data you 

entered, including the safety factor. 

 Vessel Body – The calculated heat loss of the wet and dry areas of the 

vessel. 

 Slab/Supports – The calculated heat loss of the vessel supports.  In the 

case of a slab, the calculated heat loss through the base of the vessel. 

 Other – The calculated heat loss of all other heat sinks.  This includes 

accessories, ladders, and miscellaneous heat sinks, all of which are 

entered on the Vessel Heat Sinks dialog box. 

 Safety Factor – The calculated safety factor, in watts. 

 Vessel Area – The total surface area of the vessel. 

 Heated Area – The area of the vessel surface that will be covered with 

heater, using the specified heater length and spacing. 

 Ave. Heat Loss Rate – The average rate of heat loss from the vessel 

body per unit area, in watts per unit area. 

 Total Heater Length – This is the total amount of heating cable 

required for the selected vessel. This includes the amount needed to 

account for the total heat loss, plus any additional length of heater 

specified on the Vessel Heat Sinks dialog box, and amounts for 

terminations.  

 for Terminations – The amount of heater that has been allowed for 

heater terminations. Note: this only applies to heaters that are field 

terminatable. Also, the length shown is assumed to be “wastage” and is 

not included when calculating Electrical Data. 

Heater Data 

The second column of the Calculated Results shows the calculated values that relate 

to the heating cable. These include: 

 Catalog No. of the heating cable selected by the design calculation. 

 Power Output per unit length of the selected heating cable when 

operating at the Maintain temperature. 

 Trace Ratio of the heating cable (pipes only). 1.00 indicates a straight 

application of heating cable along the pipe. 1.50 indicates that 50% 

more tracing is to be applied, by spiraling, so that 15 m of heating cable 

would be applied to each 10 m of pipe. 2.00 indicates even more 

spiraling or more typically a double tracing of the heating cable on this 

pipe segment. 

 Heater Spacing (vessels only).  The heater spacing to be used on the 

vessel.  The heater spacing will be either Default, Forced, or 

Calculated.  If the user has not specified Use All Available Area, then 

the user’s specified default spacing will be used if the available area is 

sufficient. If the available area is not sufficient, the spacing will be 

reduced to meet the specified heat loss requirements.  If the spacing 
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must be smaller than the user-specified spacing, then the Calculated 

mode will be used. If the user has specified Use All Available Area, 

then the spacing will be Forced, unless a smaller spacing than specified 

must be used.  In that case, the spacing is Calculated. 

 Cable Set Qty shows the number of cable sets that will be used for this 

line. This could be 2 if you design a pipe to be traced by two 

independent lengths of heating cable. (See Design Options where you 

can specify a forced trace ratio and elect to use Multiple Cable Sets.) 

 Sheath Temperature of the heating cable in a worst-case situation, i.e. 

Maximum Ambient temperature, no wind, maximum heating cable 

power, over voltage, and so on, as required by the standards body and 

the requirements of the area class. 

 Max Cable Length (Parallel Heating Cables) or Max. Unjointed 

Length (Series Heating Cables) – This is the maximum continuous 

length of cable allowed for the selected heating cable. For a parallel 

heating cable, also called max. circuit length, this value depends on 

various parameters such as CB size, startup temperature, and so on. 

Circuits using more cable than this value need to be broken into several 

circuits. For series cable, this value typically only refers to the 

maximum length that the supplier can deliver in one piece. Circuits 

using more cable than this value can be used, but not without splices, 

which need to be added when installing the system. The heating cable 

manufacturer specifies the value for the max. cable length. 

 Min. Controlled – This is the calculated minimum estimated 

temperature at which the pipe will be maintained, taking the selected 

control method and nominal heater ratings into consideration. 

 Max. Controlled – This is the calculated maximum estimated 

temperature at which pipe will be maintained, taking the selected 

control method and nominal heater ratings into consideration. 

 Uncontrolled – This is the calculated worst-case pipe temperature that 

the pipe could reach. This calculation assumes the heater is operating 

with no control device and conditions (Ambient temperature, voltage, 

heater output, etc.) are at their worst-case expected values as defined 

by the selected Standards Body. For more information, refer to the 

table in the section “Auto-Ignition Temperature” on page 53. The only 

exception is if you specified “control limited design.” In this case, no 

uncontrolled temperature will be calculated and the setpoint for the 

control limiting temperature device will be shown. For more 

information, see “Use Control Limited Design” on page 54. 

 Contact Temp – This is the calculated maximum estimated 

temperature of the cable where it contacts the pipe, taking the selected 

control method and nominal heater ratings into consideration.  Contact 

Temperature is calculated only for plastic pipes and vessels. 

Electrical Data 

The third column of the Calculated Results shows the calculated values relating to 

the electrical load for heating cable system. These include: 

 Line Segment / Vessel Operating Load – The nominal operating load 

at Maintain temperature for selected line segment or vessel (which 
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might consist of multiple circuits if they were broken down by the 

program). 

 Circuit Operating Load – The nominal load at Maintain temperature 

for each circuit (the program might have broken the line segment or 

vessel tracing sub-system into several circuits). 

 Circuit Operating Current – The nominal current at Maintain 

temperature for the each circuit (the program might have broken the 

line segment or vessel tracing sub-system into several circuits). 

 Circuit CB Current – Maximum steady state current at startup 

temperature used for sizing the circuit breaker(s) for each circuit  (the 

program might have broken the line segment or vessel tracing sub-

system into several circuits). 

Summary Data 

The Summary Pane shows record counts, as well as some averages and totals.  The 

summary may be for a selected set of lines, or for the project as a whole. 

 

Viewing the Summary Pane 

 Select View > Summary from the TraceCalc Pro menu.  The 

summary will include all lines and vessels in the project. 

 Click on a folder in the Project Explorer.  The summary will 

include all lines and vessels in that folder.  For example, if you 

were viewing by Line Groups, and click on the Piping folder, then 

the summary includes pipes only.  If you are viewing by Panel 

Groups and click on a panel name in the Project Explorer, then the 

summary includes all lines and vessels assigned to that panel. 
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Filtering the Summary 

You may set filter criteria for the summary at any time by clicking on the Filter… 

button.  The filter criteria you set replace the current filter.  For more information, 

please see “Using the Filter and Sort Settings Dialog Box” on page 87. 

Managing Project Elements 

The Project Explorer Pane is where you manage all the lines, vessels and panels for 

your project.  

 

 

Use the Project Explorer Pane to do the following: 

Select how you wish to view your project elements (by Line Groups or Panel 

Groups) 

Move and Edit (add, modify, delete, copy, paste and paste append) the project 

elements. 

View by Line Groups 

When you select View By: Line Groups, all the lines you have entered for heat-

tracing segments of piping are shown under the Piping folder. All the vessels you 

have entered for heat tracing are shown under the Vessels folder.  If you have 

entered some lines or vessels, but cannot see them, the folder may be closed. You 

can open the folder by clicking on the + symbol to the left of the folder.  You can 

also open the folder by clicking the Expand Treeview button on the toolbar, or by 

clicking View > Expand Treeview on the main menu. 

This way of representing your project elements allows you to drag and drop to 

reconfigure child lines in a line group. It also lets you change a child into a parent or 

vice versa. For more information, see “Organizing Your Project Lines” on page 82. 

View by Panel Groups 

When you select View By: Panel Groups, all the lines you have entered will be 

shown under the Panel folders. There will be a folder for each default panel and for 

any other panels you have created. There will also be an Unassigned folder for lines 

that have not yet been assigned to a specific panel. 
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If you have entered some lines, but cannot see them, some of the panel folders may 

be closed. You can open the folder by clicking on the + symbol to the left of the 

folder. 

This way of representing your project elements allows you to drag and drop the lines 

or groups of lines to assign them to different panels. For more information, see 

“Organizing Your Project Lines” on page 82. 

TIP: You can add new panels in the Controls tab. For more information, see 

“Customize Panels” on page 63. 

Find a Line or Vessel 

It is easy to change the view in the Project Explorer or to find a particular line you 

are looking for by using View menu items.  These items are also available on the 

button bar for your convenience. 

Find   

The Find form is a powerful, easy-to-use tool for finding a particular pipe segment or 

vessel, and for managing your project.  The Find form has an alphabetized list of 

project lines and vessels, which you may filter in either of two ways: 

 You may type part of a Line ID or Vessel ID. 

 You may enter Filter criteria using the Filter and Sort dialog box. 

When you click on an item in the Find form item list, that item becomes the selected 

item in the TraceCalc Pro Project Explorer.  If a scroll bar appears at the right side of 

the list, some items are hidden.  Use the scroll bar to show the hidden items. 

Since the Find form does not close automatically, you may view the Design Pane of 

the TraceCalc Pro main form, while you click on several items in the item list, to 

find the item you are looking for. 

Find using text within a Line ID or Vessel ID 

If you select the Line ID option, then you may filter the item list based on all or part 

of the Line ID or Vessel ID.  You may even use this option to search for particular 

text within the Line ID or Vessel ID. 
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To search by Line ID or Vessel ID: 

 Select the Line ID option. 

 Begin typing the Line ID or Vessel ID in the text box provided.   

 Click on the desired item in the list box.  If a scroll bar appears at the right 

side of the list, some items are hidden.  Use the scroll bar to show the 

hidden items. 

TIP:  If you begin by typing an asterisk, then the Find form searches within the Line 

IDs and Vessel IDs for the text that follows the asterisk, whether that text is at the 

beginning, in the middle, or at the end of the Line ID or Vessel ID.  The graphic 

above illustrates this method.  If you do not type the asterisk, then the list only shows 

Line IDs and Vessel IDs that begin with the text you entered. 

Find using Criteria 

If you select the Criteria option, then you may filter the item list based on line and 

vessel data to help find the line or vessel of interest. 
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To find an item using search criteria: 

 Select the type of item you are searching for from the drop-down list: Pipe, 

Vessel, or Pipe/Vessel (if you wish your search to include both pipes and 

vessels). 

 Click the Filter… button.  The Filter and Sort Settings dialog box will 

appear.  For information, please see “Using the Filter and Sort Settings 

Dialog Box” on page 87.  

 Click on the desired item in the list box.  If a scroll bar appears at the right 

side of the list, some items are hidden.  You will need to use the scroll bar 

to show the hidden items. 

Expand Treeview   

To expand the Project Explorer list so that no lines or vessels are hidden, click on the 

Expand Treeview button on the button bar.  You may also click View > Expand 

Treeview from the main menu. 

Collapse Treeview   

Use this option to collapse all parent lines in the Project Explorer. 

In large projects, this option will ease scrolling to a particular parent line. 

This option will not expand any folders.  If a Piping or Panel folder is closed 

(collapsed), no change will be made to the view of that folder.  For any open folders, 

the result is to collapse all parent lines. 
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Organizing Your Project Lines 

A powerful capability of this program is that you can reorganize which lines to 

allocate to each panel and its associated control method. If you have created a project 

with more than one panel, you can select View By: Panel Groups and then click on 

any line and drag it to any other panel by holding down the left mouse button as you 

move it. If you move a line from a panel that has been defined, for example, as 

having a centralized ambient sensing control to a panel with no central control 

system (uncontrolled), you may need to review the settings under the Control tab for 

the line you moved and specify a local ambient sensing control. 

You can also drag lines to different positions when you are viewing your project 

elements by Line Groups. It may not be that common to move segments of a parent 

line to another parent line. However, the facility can be useful in complex situations. 

Working with Project Lines and Vessels 

The following commands are accessible from the Edit main menu or by right-

clicking on an item in the Project Explorer Pane. 

Add New Line 

To add a parent line, right-click on the folder for which you want to add a parent 

line. For example, to add a parent to a particular panel, change to Panel View and 

right-click on the desired panel’s folder and select Add New Line. In the Line 

Configuration dialog box, enter a Line ID name that identifies your pipe. Then, enter 

a section number in the Section No. field. Then, click OK.  

To add a child line, right-click on the line for which you want to create a child line.  

In the Line Configuration dialog box, pull down the Line Type list and select 

Child.  Pull down the Line Type list again and select the desired line type.  Enter a 

Line ID name that identifies your pipe segment.  Then enter a section number in the 

Section No. field.  Then click OK. 

You may also add a new line by clicking on the Add New Pipe button  on the 

button bar, or by clicking Edit > Add New Pipe… on the main menu. 

Add New Vessel 

To add a vessel, right-click on a folder for which you want to add a vessel.  For 

example, in Panel View, right-click on the panel that will be used to control the new 

vessel heat tracing system. Click on Add New Vessel.  Enter your vessel data, then 

click OK in the Vessel Properties dialog box. 

You may also add a vessel by clicking on the Add New Vessel button  on the 

button bar, or by clicking Edit > Add New Vessel on the main menu.  

Delete Current Pipe / Vessel 

To delete an item, right-click on the item you wish to delete and select Delete 

Current Pipe / Vessel. You will be prompted to confirm that you really want to 

delete this item. Once deleted, it cannot be restored. Click Yes to confirm. 

NOTE: If the item has child lines, all child lines will also be deleted.  If you do not 

wish to delete the child lines, you must move them before performing the deletion. 
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Copy Current Pipe / Vessel 

To copy a parent or child line or vessel, right-click on the item you wish to copy and 

select Copy Current (Pipe / Vessel). This copies the selected item to the 

“clipboard” where it can be used for a subsequent Paste or Paste Append operation. 

Paste 

Once you have copied an item, select the item to which you want to paste some or all 

of the attributes of the copied item. Right-click and select Paste. In the Paste dialog 

box, select All to paste all of the item’s attributes or None to clear all of the checked 

attributes and then check just the attributes you wish to paste. Then, click OK. 

Paste Append 

Once you have copied an item, right-click and select Paste Append to paste all the 

information into a new item.  

If the copied item is a pipe segment, the Line Configuration dialog box will appear, 

and you will be prompted to enter a new Line ID and Section No. You may also 

change the line type to Child and select the desired Parent, if you wish to create the 

pipe segment as a child line.  You can then edit the attributes of the new line using 

the tabs in the Design Pane. 

If the copied item is a vessel, then the Vessel Properties dialog box appears.  Set the 

vessel properties and click OK.  If you click Cancel on the Vessel Properties dialog 

box, no new vessel will be created. 

TIP: If you want to create a child item, right-click on the desired parent.  When you 

select Child as the line type in the Line Configuration dialog, the line that was 

selected in the Project Explorer Pane is selected as the new Parent. 

Set Current Pipe / Vessel As Default 

The default pipe is the pipe that will be created when you use the Add New Pipe… 

option.  The default vessel is the vessel that will be created when you use the Add 

New Vessel… option. 

To set the default pipe, select a pipe segment whose properties you wish to designate 

as the default. Right-click and select Set Current Pipe As Default. Then choose 

either For This Project or For Future Projects. 

If you select For This Project, any new pipe segments created in this project using 

the Add New Pipe… option will use these parameters. If you select For Future 

Projects, the default line for any new project will use the parameters of the selected 

line. However, lines added to other existing projects will not use this new default, but 

will use the default previously set for that project. 

TIP: Since some project settings must be consistent with piping data for correct 

operation, if you select For Future Projects some project-level defaults for new 

projects will also be changed. 

To set the default vessel, select a vessel whose properties you wish to designate as 

the default.  Right-click and select Set Current Vessel as Default.  Then choose 

either For This Project or For Future Projects. 

If you select For This Project, any new vessel created in this project using the Add 

New Vessel… option will use these parameters. If you select For Future Projects, 

the default vessel for any new project will use the parameters of the selected line. 

However, vessels added to other existing projects will not use this new default, but 

will use the default previously set for that project. 
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TIP: Since some project settings must be consistent with vessel data for correct 

operation, if you select For Future Projects some project-level defaults for new 

projects will also be changed. 

Recalculate 

To recalculate a line or vessel, select the item, right-click, and select Recalculate. 

The program recalculates the results and displays the calculated data in the 

Calculated Results Pane. 

If you select Recalculate from the main menu, the highlighted item will be 

recalculated. 

Bill of Materials for Current Pipe / Vessel 

Select an item for which you want to generate a single item Bill of Materials. Right-

click and select Bill of Materials for Current Pipe / Vessel. You can now Preview 

the Bill of Materials for that line or Export the results to a comma separated file 

(.CSV format). You can also enter Filter criteria to view the Bill of Materials for 

another pipe or vessel, or change the view to enter other filter criteria.  For more 

information, see “Bill of Materials” on page 106. 

TIP: If you collapse a parent line that has child lines associated with it, so that the 

child lines are not displayed, there will be a + symbol adjacent to the parent line. 

You will need to expand these groups so you can view the Bill of Materials for each 

line. 

Bill of Materials for Current Pipe Group 

Select a pipe segment in a pipe group for which you want to generate a Bill of 

Materials. Select Bill of Materials for Current Pipe Group from the Edit menu, or 

click the appropriate button on the button bar.  The Bill of Materials will include 

items for all pipe segments with the same root parent.  The root parent line is 

indicated in the Criteria pull-down list of the Bill of Materials dialog. You can now 

Preview the Bill of Materials or Export the results to a comma separated file (.CSV 

format). You can also change the scope of the Bill of Materials using the Display 

By: or Criteria pull-down.  For more information, see “Bill of Materials” on page 

106. 

Detail Report for Current Pipe / Vessel 

Select an item for which you want to generate a single line Detail Report or Vessel 

Detail Report.  Right-click and select Detail Report for Current Pipe / Vessel. 

You can review this multi-page report using the arrows at the top of the report to 

jump to the next or last page and the magnifying glass drop-down menu to zoom. 

You can also click the printer icon to open the Print dialog box to select a printer and 

print the report. 

Detail Report for Current Pipe Group 

Select a pipe segment in the pipe group for which you want to generate single line 

Detail Reports. Right-click and select Detail Report for Current Pipe Group. A 

Single Line Detail Report will be generated for every pipe segment in the currently 

selected group.  You can review these multi-page reports using the arrows at the top 

of the reports to jump to the next or last page and the magnifying glass drop-down 

menu to zoom. You can also click the Printer icon to open the Print dialog box to 

select a printer and print the reports. 
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Global Edit 

This command lets you make changes to one or more items that you have entered 

into your project. Since this command can make significant changes to your 

database, use it with caution. Consider saving your project before you apply the 

global edit command. 

Not all variables can be changed using Global Edit because some variables relate to 

other variables that need to be changed at the same time. For example, changing all 

lines to hazardous area would require the user to enter more information, like 

class/zone, T-rating, and so on. To change this type of variable globally, use global 

paste. 

 Select one of the following items from the Select List: pull-down list:   

 Pipe – To apply edits only to pipe segments, select Pipe.  The list 

of available variables will be limited to those that apply to pipes. 

 Vessel – To apply edits only to vessels, select Vessel.  The list of 

available variables will be limited to those that apply to vessels.  

 Common – To apply edits to pipes and vessels, select Common.  

Only those variables that apply to both pipes and vessels (for 

example, Maintain Temperature) will be available. 

 The Select Field: list shows the available variables stored in 

conjunction with each designed item. To change the value for any of 

the fields, select the field and enter a replacement value. Some default 

values may be displayed in the replacement window, depending on the 

field chosen. If you select a field that has a Yes / No answer, such as 

Allow Spiraling, then the Replacement Value field will be a pull-

down list box with the Yes / No choices. Likewise, if the field has 

standard entry choices associated with it, such as is the case with 

Chemical Exposure, then the Replacement Value field will show 

those standard choices. 

 The Replacement Value function allows you to enter the new design 

parameters for all the lines in the project. For example, you may have 

entered various wind speeds but have now decided to design for a 20 

MPH wind for all the lines. Entering that replacement value will 

overwrite the previous values for all the lines when you click Apply. 

Global Edit –> Filter 

Use this command to change the design parameters for a selection of the items in 

your project. From the Edit menu select Global Edit then click on the Filter button. 

The Filter and Sort Settings dialog box appears. For more information, please see 

“Using the Filter and Sort Settings Dialog Box” on page 87. 

Global Paste 

This menu command lets you paste groups of data from one or more lines to all the 

other lines in the project. Like Global Edit, this command can make significant 

changes to your database, so use it with caution. Consider saving your project before 

you apply the global paste command. 

 First, select the item (pipe segment or vessel) that contains the design 

parameters that you want to copy to the other items (pipe segments, 

vessels, or both). Click on this item in the Project Explorer Pane, and 

then right-click or select Edit from the menu, and then select Copy 
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Current Pipe / Vessel. All of the data associated with that item is now 

on the clipboard, available for pasting to all the other items in this 

project. 

 From the Edit menu select Global Paste to access the Paste Pipe 

dialog box. This dialog box displays the Line ID or Vessel ID of the 

source data in the Source field. Verify that this is the intended source 

for the data you wish to paste before proceeding, as there is no Undo 

feature.  

 In the Destination: section, select Pipe, Vessel or Pipe / Vessel to 

indicate the type of item you want to paste the copied data to.  You may 

paste only to pipe segments, only to vessels, or to either type of item.  

 Also in the Destination: section, if you wish to change the design 

parameters for a selection, but not all of the items of the type selected,  

then click the Filter… button to bring up the Filter and Sort Settings 

dialog box, which allows you to limit the items to be pasted to, based 

on filter criteria.  For more information, please see “Using the Filter 

and Sort Settings Dialog Box” on page 87.  

 You will see that there is a list of groups of design parameters under the 

heading Paste Items. This is different from Global Edit, where each 

design parameter is selectable. You can use the None button to clear all 

the selections and then just check the groups of design parameters 

which you wish to paste. When you click OK, the copied values for the 

selected groups of parameters will replace the previous values for all 

the items of the selected type in the project, or all those items that 

match the filter criteria that you have set. You will notice that if you 

select Temperature Data, the value in all the temperature fields in the 

Design Pane, under the Basic tab, will be updated and also the Startup 

Temperature value which is under the Reference tab. 

 You must use Calculate All Records (Shift+F9) to update the results 

for all the changed lines. 

Line Configuration Dialog Box 

The Line Configuration dialog box is used to change a line’s Line ID, Section No., 

Line Type, Use Same Heater as Parent, and Parent properties. 

For further information on the definitions of these data, refer to “Basic Tab” on page 

31. 

There are two ways to call up the Line Configuration dialog box: 

 Click the button next to the Line Type: text box on the Basic tab. 

 Double-click the Line ID in the Project Explorer Pane. 
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Line Type 

You may use this drop-down list to change any line’s Line Type.  You may select 

Parent to change a child line from child to parent; all of its children will move with 

it.  You may change a Parent line to a child type; in that case, you would use the 

Select Parent button (the one with the ellipsis next to the Parent text box) to select a 

parent for the line.  

Select Parent 

Changing a child line’s Parent may be accomplished by dragging the line from one 

place to another in the Project Explorer Pane.  As an alternative, you may call up the 

Line Configuration dialog box and click the button next to the Parent: text box with 

the ellipsis.  When you click the button, the Find form appears.  Simply select the 

line you wish to make the Parent of the line you are configuring and click the Close 

button.  The line you chose will now be shown in the Parent text box.  To learn 

more about using the Find form, please see “Find a Line or Vessel” on page 79. 

Depending on the parent configuration, the Line Type might need to change.  Check 

the Line Type after you change the Parent for a child line, or select a Parent for a 

line that was previously a Parent. 

Using the Filter and Sort Settings Dialog Box 

The Filter and Sort Settings dialog box is used to allow you to select a subset of the 

lines or vessels for an operation. For example, by default all lines are included in a 

Piping Report.  You control which lines are included on a Piping report by setting a 

filter, using the Filter and Sort Settings dialog box.  From the Reports dialog box, 

you call up the Filter and Sort Settings dialog box by clicking on the Filter… button.  

The Filter and Sort Settings dialog box is also used on the Bill of Materials, Export, 

Global Edit, and Global Paste dialog boxes. 

Filter Settings 

To specify filter conditions for your criteria, do the following: 

 Specify the Units that will apply to the Comparison Values by 

selecting either the English Units or Metric Units option.  These units 

need not be the same as were used when you initially entered the design 

parameters.  For example, you could select English Units so you can 

enter Maintain Temperature in °F even though the project is using 

metric units.  If you are entering multiple filter conditions, all your 
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conditions must use the same system of units (English or Metric).  

Units will be shown in the Units column adjacent to each of the 

Comparison Values. 

 Select a Field Name from the drop-down list; for example, select 

“Maintain Temp.” 

 Choose the Comparison Type for each Field Name.  This selection 

choice will vary, depending on whether the field name is a Yes/No 

field, a text field, or a numeric field. 

 Enter the Comparison Value, or select from a list of available 

comparison values.  For example, enter 100 for 100°C. 

 Select either the Match all conditions or the Match any conditions 

option.  If you specify only one filter condition, it does not matter 

which you select.  However, if you specify multiple conditions, such as 

“Maintain Temp. is greater than 100°C” and “Outdoors equals Yes”, 

then you must select either Match all conditions or the Match any 

conditions to obtain the desired result. 

Sort Settings 

Sort order does not have any effect on Bills of Materials, or on Global Edit or Global 

Paste operations.  However, it does have an effect on data exports and reports. 

To specify a sort order for your lines, do the following: 

 Select a Field Name for the sort conditions from the drop-down list in 

the Sort area of the window. 

 Enter a secondary sort field, if necessary. 

 Select Ascending or Descending from the drop-down list for each of 

the sort fields selected. 

Saving your criteria as a Saved Query 

At any time, you may save your current filter and sort criteria for future use.  You 

may have as many saved queries as you wish.  You must give each saved query a 

unique name.  

To save a set of criteria as a Saved Query, do the following: 

 Click Save Query As…  

 Enter a meaningful name, such as ‘Maintain Temperature above 100’, 

in the text box that appears 

 Click OK. 

Recalling your criteria (Saved Queries) 

If you wish to use a previously saved query, simply select the name of the saved 

query from the drop-down list of Saved Queries. 

If you modify the query criteria, the saved query is not affected unless you click the 

Save Query button.  
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Saving changes to a Saved Query 

If you make changes to a saved query and would like those changes to be reflected 

the next time you use the query, you must save the changes.   

If you save the changes to a query, the previous criteria will be overwritten unless 

you save the criteria as a new query using Save Query As… 

There are three ways to save changes to a saved query: 

 Click the Save Query button. 

 Click OK (see Using your criteria below) and click Yes when 

prompted to save your query. 

 Click Save Query As… and enter a new name (in this case, the saved 

query is not overwritten, and your criteria are saved as a new saved 

query). 

Using your criteria 

When you are finished creating or modifying your selection and sort criteria, click 

OK.  The Filter and Sort Settings dialog box closes, and you return to the operation 

for which you needed the filter. 

If you have modified a saved query, you will be prompted to save it.  If you click:  

 Yes: the changes to your saved query are saved, using the same query 

name (previous query criteria are overwritten).  The criteria you have 

just selected are used. 

 No: your saved query is left as it was before your modifications.  The 

criteria you have just selected are used. 

 Cancel: no action is taken, and you are returned to the Filter and Sort 

Settings dialog box. 

Canceling your criteria 

If you wish to return to your operation without setting a filter, you must click 

Cancel.  

If you return to the operation with a filter set, but decide you do not want to use a 

filter, bring up the Filter and Sort Settings dialog box again, and click Cancel. 
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6  Advanced Settings 

The TraceCalc Pro program includes basic default setting for many aspects of the 

program. However, you can configure the system with the Setup menu to 

accommodate the project and program settings that suit your needs. Attributes 

selected in the Setup menu will be saved when you close the Setup window.  

Project Settings 

TraceCalc Pro assigns some basic default project settings that are used for new 

projects that you create. However, you can modify these default settings as needed. 

To modify project settings, go to the Setup menu and click Project Settings. The 

Project Information screen appears.  

This screen lets you customize settings for the current project. However, you can set 

your current project settings as the default for future projects. To set project settings 

as the default for future projects, select a pipe segment or vessel in the Project 

Explorer Pane, then from the Edit menu select Set current pipe / vessel as default 

> For future projects. 

The Project Information screen contains five tabs for customizing your project 

settings. 
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Information Tab 

Select this tab to enter the following project information: 

Project Name – Enter a name for your heat-tracing design project. This field accepts 

30 characters. The project name will appear on all reports generated by the program.  

Project No. – Enter a number for your heat-tracing design project. This field accepts 

30 characters. The project number will appear on reports generated by the program.  

Customer Name – Enter the name of the customer who is the recipient of the heat-

tracing design project. This field accepts 30 characters. The customer name will 

appear on all reports generated by the program. 

Customer Reference No. – Enter the customer reference number that identifies the 

customer of the heat-tracing design project. This field accepts 15 characters. The 

customer reference number will appear on all reports generated by the program. 

Project Description – Enter a project description for the heat-tracing design project. 

This field accepts 255 characters. This description will appear on some reports 

generated by the program. 

Product Preferences Tab 

Use of this tab is reserved for advanced users.  If you have not been specifically 

instructed to use the Product Preferences tab, it is advised that you skip this section 

Select this tab to choose product preferences, as follows: 

Reference Data File – Select from the list of available product reference files, if 

more than one is available.  

Data Version – Select from the list of available groups of products, if more than one 

is available. 

Heaters - In the window below, click on the Heaters tab.  Check the heating cable 

technologies, families, and/or specific heating cables that you wish the program to 

use in its selection process. When you check a folder, such as the heating cable 
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technology ‘Parallel’ folder, all the families and specific heating cables in that folder 

will be selected. You can select and deselect any combination of folders and 

products as you wish by expanding or collapsing the folder (click on the + symbol 

adjacent to the folder name) and checking or unchecking families or specific heating 

cables as needed. 

Components - In the window, click on the Components tab.  Check the different 

groups of components that you wish the program to use in its selection process. 

When you check a folder, such as the Power Kits folder, all the power components in 

every group of power components will be selected. You can select and deselect any 

combination of folders and individual component kits as you wish by expanding or 

collapsing the folder (click on the + symbol adjacent to the folder name) and 

checking or un-checking groups of component kits or individual component kits as 

needed. 

Design Tab 

Select this tab to enter the following design preferences: 

Default Warning Label – Select from the list of Warning Label options.  

Default Pipe Straps – Select the desired pipe strap type used for fixing components 

on the pipe.  

Warning Label Interval – Enter a value to indicate the installation distance 

between warning labels. Labels should be installed at intervals sufficient to ensure 

personnel are alerted to the presence of electrical equipment. 

Max Spiral Ratio – Enter a value to indicate the maximum spiral ratio you wish the 

program to consider. Above this value, the program will only allow straight runs of 

heating cable. We typically don’t recommend any value higher than 1.5. 

Minimum Heater Spacing – Enter a value to indicate the minimum distance you 

will allow between installed lengths of cable.  

Default Heater Spacing – Enter a value to indicate the distance you normally want 

to allow between adjacent wraps of installed cable on a vessel.  

Default Heater Max. Output – This value only applies to vessel designs.  It 

specifies a project wide maximum heater wattage that you would like TCPro to try 

when selecting a heater for a vessel application.  This just represents a starting point 

for heater selection calculations; in many cases, a much lower wattage will be 

required because of operational limitations.  This limit can be over-ridden on a line 

by line basis by using the Heater Design Options dialog box. For more information, 

please see “Heater Design Options… (Vessels Only)” on page 58. 

Preferred Cold Lead Glands – Check boxes corresponding to those glands you 

want to be considered for your design. 

CB Load Factor – The CB Load Factor specifies the maximum allowed current 

loading (in percent) of the Max. CB Size. The National Electrical Code and the 

Canadian Electrical Code require the operating current of a heating device to not 

exceed 80% of the nominal CB rating. In Europe there is no such requirement and 

the typical setting is 100%. 

If the allowed CB current (Max. CB Size * CB Load Factor) is exceeded during the 

heater selection process, depending on the Line Type, TraceCalc Pro will do one of 

the following: 
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 If the segment is a Parent line, with no Child line associated with it, a 

parallel heating cable length will be broken into multiple “circuits” 

with all necessary components allowed for each circuit. 

 If the segment is a Parent line with Child line or is a Child line or is a 

series cables, warning W1001 will be issued (the heating cable length 

will not be automatically split into circuits). You can then re-adjust the 

CB rating or change other parameters. 

Termination Allowance – The TraceCalc Pro program adds this allowance for each 

end of a heating cable set to allow for termination with a component. This does not 

apply to factory terminated cable sets. The additional length appears in the 

Calculated Results Pane under Pipe Data/for Terminations, as well as in the Bill of 

Materials. However, it is not included in the electrical design of the circuit as it is 

assumed to have been cut off during installation. 

Drain/Vent Length – Enter a value to indicate the length of drains and vents. 

TraceCalc Pro assumes that this drain/vent length will be traced as a simple loop, and 

as such will add double the drain/vent length to the BOM for each drain/vent. 

Pipe Emissivity – Enter a value for TraceCalc Pro to use in calculating heat loss.  It 

must be a value between zero and one.  

Cladding Emissivity – Enter a value for TraceCalc Pro to use in calculating heat 

loss.  It must be a value between zero and one.  

Journal Tab 

Select this tab to enter journal entries for your project. You can use the journal to 

conveniently track changes to, and history of, the project or simply to keep project 

notes. The information is only visible when you view the journal and is not used by 

the program for any design purposes. 

 Add – Click Add to enter a new line into your journal. Place your 

cursor on a new line and begin your entry. There is a 255-character 

limit to your journal entry. To choose a date for your journal entry click 

on the left side of the line to select any date on the calendar.  

 Delete – Highlight the line you wish to delete, and then click Delete. 

Advanced Tab (Project Settings) 

This tab contains settings that should only be modified by “advanced” users. Note: 

the Advanced tab is only visible if you selected this option under Setup > Program 

Settings > Advanced. 

Bill of Materials 

The following options are available for customizing your Bill of Materials. 

 Allow Priced Bill of Materials – Check this box if you wish to show 

pricing information on your Bill of Materials. To disable pricing 

information of your Bill of Materials, deselect the box. 

 Price List File – Select the price list file you wish to use for your Bill 

of Materials. 

 Currency Format – Select the currency you wish to display on your 

Bill of Materials. TraceCalc Pro does not do currency conversion. 
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 Clear Saved Prices – Deletes prices that might have been saved for the 

particular project—although prices in the price list file are not affected. 

Heat Sink Options 

Heat sinks are an important consideration for electrical heat-tracing. The data you 

enter here will be used for selection in the Heat sinks dialog box, located under Basic 

tab > Valves, Supports …. For more information on how to select valve, support 

and flange data, see “Valves, Supports …” on page 39. 

Unless you define a specific value for the film coefficient, TraceCalc Pro will use the 

film coefficient calculated for the cladding of the thermal insulation. To use a fixed 

value, check the box “Use fixed film coefficient” and enter the value you desire. 

Heat Sink Definitions 

Click the Heat Sink Definitions… button to add, modify, or delete heat sink 

definitions. 

The program includes data for several standard valves, pipe supports and flanges and 

this predefined data is marked as Read Only – Yes so it cannot be changed. 

However, you can copy and modify the data. 

TIP: You can also Copy, Paste and Paste Append the heat sink definitions by 

highlighting a heat sink in the Customize Heat sinks dialog box, then right-clicking 

to a pop up menu. Select Copy, then Paste Append to add a duplicate of that item 

with a different Identifier, and then use Modify to make specific changes. 

 Add – To add a heat sink definition, click Add and enter a unique 

Identifying Code. Click OK. Then, in the Heat Sink dialog box, click 

the Edit button next to the Description field and select from a list of 

existing descriptions or enter a new description. Click OK. Then select 

a Category for the heat sink from the drop-down list.  

 

Check the boxes to specify the calculation methods that will be allowed 

for this heat sink. It is advisable to check one at a time when entering 

new data, so that you will see which fields of data are required for each 

calculation method. You can check any or all of the four calculation 

methods detailed below, making them all available for selection. The 

choice is made when you specify the type and quantity of heat sinks for 

each line under the Basic tab – Valves, supports … button. 

 Specify total heater length – This calculation method allocates a 

fixed amount of cable to each heat sink. You will need to enter the 

Absolute Heater Length to be allocated to each valve, support or 

flange, depending on the Pipe Diameter. You might also wish to 

enter a practical Max. Recommended Length. which will always 

override the calculated length if it is greater. You can also enter a 

Default Spacing for heat sinks. This option pertains primarily to 

supports and flanges, where you might want to specify a frequency 

of one support every 5 m of pipe for example (ignore this for 

valves). These assigned values can always be overwritten when 

you call up the heat sinks under the Basic tab. For more 

information, see “Valves, Supports …” on page 39. 

 Specify total wattage – This calculation method allocates a fixed 

amount of heat (watts) to each heat sink. You will need to specify 

the Absolute Total Watts to be supplied by the selected heating 

cable for each valve, support or flange, depending on the Pipe 
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Diameter. As above, you can enter a practical Max. 

Recommended Length and a Default Spacing of the heat sink 

item. The total wattage is a fixed value and will not change if you 

change for example, your Maintain temperature. 

 Specify equivalent pipe length – This calculation method 

allocates an amount of heating cable that is obtained by treating the 

heat sink as if it were a defined length of pipe.  You will need to 

specify the Equivalent Pipe Length to allow the program to 

calculate the correct length of heating cable. This “equivalent 

length” is the length of heating cable that would be required for a 

defined length of pipe of the same nominal size as the heat sink. If 

you specify, for instance, that each valve should use an amount of 

heating cable equal to the amount that would be needed for 0.8 m 

of pipe of the same size, and the program calculated that each 

meter of pipe needed 1 m of heating cables, then 0.8 m of cable 

would be specified for each valve.  You need to enter this 

Equivalent Pipe Length for all relevant Pipe Diameters. As 

above, you can enter a practical Max. Recommended Length and 

a Default Spacing of the heat sink item. 

 Calculate heat loss – This method calculates the heat lost from the 

heat sink based on its physical attributes. You will need to specify 

the following for all relevant Pipe Diameters: The Body Heat 

Loss factor (enter 0.3 m if you consider that the insulated body of 

the heat sink will loose the same amount of heat as 0.3 m of 

insulated pipe of this nominal diameter), the Fin X-Sectional 

Area, the Fin X-Sectional Perimeter and the Fin Thermal 

Conductivity. This allows the program to calculate the heat 

transfer of the heat sink by using a fin-equation. As above, you can 

enter a practical Max. Recommended Length. Note: The default 

spacing field is ignored for valves. 

 

Having entered all the applicable data, click OK. 

 Modify – To modify a heat sink definition that is not marked as Read 

Only – Yes, highlight a definition and click Modify. Then in the Heat 

Sink dialog box, modify the data as described in Add above, and click 

OK. 

 Delete – To delete a heat sink definition that is not marked as Read 

Only – Yes, highlight a definition and click Delete. 

 Copy – (using right-click to access this choice) – To make a copy of 

the selected heat sink data for pasting, highlight the heat sink, right-

click and select Copy. 

 Paste – (using right-click to access this choice) – To add part or all of 

the data from a copied heat sink to another user-defined heat sink, 

highlight the user-defined heat sink, right-click and select Paste.  You 

are given the choice of pasting just the Heat sink Category, the Heat 

sink General information, all the Heat sink Details or any 

combination of these three. 

 Paste Append – (using right-click to access this choice) – To make a 

duplicate of the copied heat sink data to a new heat sink with a different 

Identifier, highlight any heat sink, right-click and select Paste 

Append. The new heat sink can then be modified as described above. 
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Miscellaneous 

To use maximum exposure temperature rather than maximum operating temperature 

for sheath temperature calculations, check the check box. 

MI Cable Sheath Temperature Calculation 

Leave the setting as ‘Use data based on global codes and standards.’  The second 

option, ‘Use historic Pyro Designer data,’ is included only for comparison of results 

with legacy applications. It should not be used to create new designs.  This option 

will be available only if you chose to install North American data during program 

installation. 

Project Lists 

This sub-menu, accessed from the Setup Menu, provides access to the Control 

Panels and Area Names menu items. Each of these items allows you to access the 

respective list of definitions that are stored with the current project. These lists are 

actually stored with the project file and are available even if the project file is moved 

to or accessed from another workstation.  They are not, however, accessible to other 

projects.  Panels and Area Names must be defined in each project where they are 

used. 

Program Settings 

The TraceCalc Pro program has default program settings that are used for new 

projects that you create. However, you can modify these settings to suit your needs. 

To modify program settings, go to the Setup menu and click Project Settings. The 

Project Settings screen appears. This screen contains two tabs for customizing your 

program settings.  

 

Reference Data Tab 

Select the Reference Data tab to see where the Reference data is stored. To edit the 

path click Browse and select the folder where you want the Reference Data to reside.  

Advanced Tab 

Select the Advanced tab to enter the following options:  
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Open Projects in Multi-user (Shared) Mode 

If this box is checked, project databases will be opened in such a way as to allow 

other TraceCalc Pro users on your LAN to open and work on the same projects 

simultaneously. Unless you need to have multiple users work on the same project at 

the same time, it is recommended that you leave this box unchecked. 

Note: When projects are opened in Multi-user mode, any changes to a pipe segment 

are automatically saved to the database file as you move from line to line. Unlike 

single-user mode, you cannot make multiple changes and then at the end of your 

session, choose to cancel the saving of all changes. 

Show Project Settings Advanced Options 

Select the Show Project Settings Advanced Options check box in order to display 

the advanced project settings option tab. If left unselected the advanced project 

settings will be hidden from the user.  

New Project Default Settings 

By default, each new project contains one pipe segment.  Use this option to create 

new projects with a vessel instead, or with both a pipe and a vessel. 

User Defined Product List 

From the Setup menu, select Global Lists -> User Defined Product List to review 

and modify the items in this list. Please note that this is a “global” list.  This means 

that all data contained in the list is available to all projects on the computer 

workstation. The data is not stored in the project file, which means that if the project 

file is moved to or accessed from another workstation, this data will not be available. 

Product List Editor 

The Product List Editor allows you to define product lists, which can include pricing 

information, for the following Categories: Heaters, Components, Controls, 

Accessories, and Services. Simply select the desired category from the list then right-

click for the pop-up editing menu. You can then edit, add, and remove products from 

the list. You can also copy and item and then paste its attributes to an existing item 

or use paste append to create a new item based on the copied item. Products entered 

in this list will override eventual duplicates in the standard price lists. 

Units 

From the Setup menu select Units to select English for English units, or Metric for 

metric units. With the exception of pipe schedules, all values displayed on screen and 

in reports will reflect the units system you selected. 

Changing the system of units may require the lines in your project to be recalculated. 

Language 

From the Setup Menu, select a language from the language list. All text displayed on 

screen and in reports will be in the chosen language. 
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7  Heat-Tracing Technologies 

There are two basic types of electrical heat-tracing technologies: Parallel and Series 

Circuit. The following are descriptions of cables based on these two technologies: 

 Parallel Circuit 

 Series Circuit 

Parallel Circuit 

Self-Regulating Heating Cables: Self-regulating heating cables are the preferred 

choice for most complex pipe-tracing applications. This is due to their parallel 

construction, which allows them to be cut to length and spliced in the field. 

Self-regulating heating cables are based on conductive-polymer technology in both 

monolithic (solid core) and fiber-wrap heating cable designs. The heating element is 

made of polymers mixed with conductive carbon black. This special blend of 

materials creates electrical paths for conducting current between the parallel bus 

wires along the entire cable length.  

In the heating cable core the number of electrical paths between the bus wires 

changes in response to temperature fluctuations. As the ambient temperature 

surrounding the heating cable decreases, the conductive core or fiber contracts 

microscopically. This contraction decreases electrical resistance and creates 

numerous electrical paths between the bus wires. Current flows across these paths to 

warm the core or fiber. 

As the temperature rises, the core or fiber expands microscopically. This expansion 

increases electrical resistance, and the number of electrical paths decreases. As a 

result, the heating cable automatically reduces its power output. 
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Power-Limiting Heating Cables: Power-limiting heating cables are the preferred 

technology for applications requiring high power output at elevated temperatures. 

These cables can be used for high maintain temperatures ranging up to 455°F 

(235°C) depending on cable selection and exposure temperatures to 482°F (250°C). 

This technology can provide a cost-effective alternative to self-regulating heating 

cables when more than a single run of cable is required (trace ratio > 1). 

Power-limiting cables are parallel heating cables formed by a coiled resistor alloy 

heating element wrapped around two parallel bus wires. At a fixed distance, the 

insulation is removed alternatively, first from one of the bus wires and then from the 

other. This distance between contact points forms the heating zone length. 
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The positive temperature coefficient (PTC) of the heating element reduces power 

output as ambient temperature increases. This effect allows the power-limiting cable 

to be crossed over itself since the temperature of the heating element is reduced at 

the cross over points. 
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Series Circuit 

Mineral Insulated (MI) Heating Cables: Mineral Insulated heating cables offer a 

wide variety of solutions for industrial pipe and equipment heat-tracing applications. 

MI heating cables are series-type heating cables and suitable for maintain 

temperatures up to 1022°F (550°C) and/or exposure temperatures for the heating 

cable to 1238°F (670°C). MI is the ideal choice when an application’s temperature 

and power output requirements exceed the capabilities of self-regulating and 

powerlimiting heating cables. 

MI heating cables can be used for applications with the following requirements: 

 Maintain temperature up to 1022°F (550°C) 

 Maximum heating cable exposure temperature to 1238°F (670°C)* 

 Power output to 82 W/ft (269 W/m) 

* Higher temperatures are available upon manufacturer’s approval 

MI heating cables consist of one or two conductors embedded in a highly dielectric 

magnesium oxide insulation surrounded by a metal sheath. 

MI heating cables provide superior strength in dynamic cut-through, crush, and 

corrosion tests. Special annealing processes maximize flexibility for ease of on-site 

handling. 

 

 

 

MI heating cable sets are supplied factory terminated and ready to install. They 

include a heating section and a cold lead (nonheating) section. 

 

 

 

 

 

Various constructions are available in different market places. For detailed 

information, please refer to local product literature. 

 



 

TraceCalc Pro User Guide H57159 (01/14) 7  Heat-Tracing Technologies    103 

Polymer Insulated Heating Cables: Series constant-wattage, polymer-insulated 

heating cables can be used when the circuit length required exceeds that permitted by 

parallel-circuit heating cables. The polymer-insulated cables are suitable for 

exposure temperatures up to 400°F (204°C) for SC cables and 482°F (250°C) for 

SC-H cables. They incorporate a fluoropolymer outer jacket that makes them ideal 

for chemically aggressive applications. 

Polymer-insulated heating cables can be used for applications with the following 

requirements: 

 Maximum heating cable exposure temperature to 482°F (250°C) 

 Maximum power output to 9 W/ft (30 W/m) 

 

 

 

 

Various constructions are available in different market places. For detailed 

information, please refer to local product literature. 
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8  Reports 

You can preview and print several reports to show the input parameters and the 

calculated results for all lines of your project or for a selection of lines.  

Piping Reports and Vessel Reports 

From the Reports menu, select Piping Reports or Vessel Reports to access the 

Reports dialog box. In this dialog box select from a list of available reports and then 

click the Preview button. If you wish to print the report, click the printer icon to 

open the Print dialog box, select a printer and print the report. 

The Electrical Line List and the Summary Line List both display one line of data 

for each line in your project.  

The Single Line Details report and Vessel Details report will typically generate two 

pages for each line in your project and display all of the input parameters and 

calculated results.  

TIP: You can also view the Single Line Details or Vessel Details report by right-

clicking on the line or vessel in the Project Explorer Pane and selecting Detailed 

Report for Current Line / Vessel. 

TIP: You can use the File > Export command from the main menu to generate a 

comma-delimited file (.csv format) for some or all of the project items to include all 

or a selection of the data fields and the calculated results. For more information, see 

“Export” on page 14.  

If you want to generate a report for only a selection of the items, such as all those for 

a specific electrical panel, and sort them, perhaps by circuit number, use the Modify 

button to enter Filter and Sort Settings.  For more information, please see “Using 

the Filter and Sort Settings Dialog Box” on page 87. 

Subtotals for Piping Reports 

Check the box next to Show Subtotals to generate a report that is subtotaled by the 

field you specified as the primary Sort field. If you had not set any sort conditions, 

click the Modify button to go to the Filter and Sort Settings dialog box and set a Sort 

condition. 
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Report Preview 

Click Preview to view this report. Use the left and right arrow buttons to move to 

another page of the report.  Use the scroll bar to move up or down on the current 

page.   

The Report Preview is modal, so you must close the report, by clicking on Close or 

the close window icon, to return to the Reports dialog box. 

You can click the printer icon to open the Print dialog box to select a printer and 

print the report. 

You can click on Save As… to save the report in a file, in PDF or HTML format.  

TIP: If you have a mouse-wheel, the Control + Mouse-Wheel lets you zoom in and 

out. Shift + Mouse-Wheel lets you jump to next or previous page. 

 

Bill of Materials 

From the Reports menu, select Bill of Materials to access the Bill of Materials 

dialog box. From this dialog box you can select from a list of available groupings for 

this report. You can also add items to the Bill of Materials Report and run or export 

the report.  

Display by: Total, Area, Line, Line Group, Custom 
Filter 

Select one of the Display by: options: Total, Area, Line, Line Group, or Custom 

Filter.  

If you select Total, no further choice is available in the Criteria selection box and 

you can click Preview to generate a print preview of the consolidated Bill of 

Materials for all the lines in your project. 

If you select Area, Line, Line Group, or Custom Filter you can select Criteria 

options. 

Criteria options 

If you choose to display the Bill of Materials Report, grouped by Area, the Criteria 

list will show all the available Area names that you have assigned to the lines in 

your project. 

If you choose to display the Bill of Materials Report, grouped by Line or Line 

Group, the Criteria list will show all the available Line IDs in your project. 

If you choose to display the Bill of Materials Report using a Custom Filter, the 

ellipses button adjacent to the Criteria box will provide access to the Filter and 

Sort Settings dialog to let you select the specific lines you wish to include in the Bill 

of Materials Report.  For more information, please see “Using the Filter and Sort 

Settings Dialog Box” on page 87. 

Note: Sort options are not applicable to the Bill of Materials Report. 

Having selected the filter settings and returned to the Bill of Materials dialog box, 

you will see an indication of the number of lines found that meet the criteria you 

have selected. This is shown at the bottom of the dialog box as Lines Used: x of y, 
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where x is the number of the lines found that meet the condition (and have been 

calculated/recalculated) and y is the number of lines that meet the condition (that 

may or may not have been calculated/recalculated). 

The Bill of Materials window will list the parts needed to fabricate the design you 

created in TraceCalc Pro. 

TIP: If you do not see any items selected, you may have run the report before 

calculating the line. You will need to close the Bill of Materials window and select 

Calculate All Records. (The shortcut key is Shift + F9.) 

Add Item 

Click the Add Item button to add an item to the Bill of Materials. You can select 

from a list of Standard items or from previously entered User Defined items. When 

you add an item, you must also add a quantity for that item. For more information, 

see “User Defined Product List” on page 98. 

If you desire, you can add a contingency allowance for items such as additional End 

Seal Kits, which will be indicated on the Bill of Materials as “Quantity Override.” 

TIP: You can only add items when you are viewing the Bill of Materials for a 

specific line or area—not if you look at a total Bill of Materials.  

Delete Item 

You can delete any item that you previously added. To do so, click on the “Quantity 

Override” checkmark in the displayed Bill of Materials and then click the Delete 

button. The system will prompt you to confirm that you want to delete the item. 

Click Yes. 

Preview (Run Report) 

Click the Preview button to view the Bill of Materials Report. You can then click the 

printer icon to open the Print dialog box to select a printer and print the report. In 

some cases, the Preview button will show the words Run Report… The Preview is 

shown in a separate window so you can click on close, or use the close window icon, 

to return to the previous Bill of Materials Calculated Results Pane. 

TIP: If you have a mouse-wheel, the Control + Mouse-Wheel lets you zoom in and 

out. Shift + Mouse-Wheel lets you jump to next or previous page. 

Export Data 

Click Export to export the Bill of Materials in comma delimited (.CSV) format that 

can be read by programs like Microsoft Excel. For more information, see “Export” 

on page 14. 

Bill of Materials Line Item Detail 

Each line in the Bill of Materials is a summary for the catalog number shown; each 

catalog number will appear only once in a Bill of Materials, and the Quantity shown 

is the sum for all items (pipe segments, vessels) included in the Bill of Materials.   

If you click on a Catalog Number in the Bill of Materials dialog box, the Bill of 

Materials Line Item Detail dialog box appears, showing in detail how that item came 

to be in the current Bill of Materials. 
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You may cancel a user-defined quantity or delete a user-added item using the Line 

Item Detail dialog box.  Simply select the line and click the Delete button.  To 

confirm the deletion, you must click OK when you close the Line Item Detail dialog 

box.  To cancel the changes, click Cancel. 
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Appendix A: Troubleshooting  

The TraceCalc Pro program will alert you with a warning or an error message under 

certain circumstances. These are typically either because the program cannot find an 

acceptable answer based on your input or because the user may need to take some 

additional action to ensure the design requirements are completely met.  

For questions, please contact Technical Support at PTM-info@pentair.com. 

Errors 

The following error messages give descriptions that indicate the possible reason the 

program could not complete its calculations. 

E17 “Unable to select heater, Thermal Insulation thickness is 
zero.” 

Suggested Action: TraceCalc Pro requires pipes to be insulated. Review the value in 

the Insulation Thickness field under the Basic tab. This value must be greater than 

zero for Pipe Heat-tracing. Modify the value, if appropriate. Select Recalculation 

and review results. 

E25 “The specified Insulation type could not be found in the 
Reference Database.” 

Suggested Action: The line data refer to an insulation not found in your reference 

database.  This may happen if you have received the project from someone else who 

has created a custom insulation type.  Select another insulation type, or create an 

insulation definition, if necessary to describe the insulation. 

E26 “The specified Pipe type could not be found in the Reference 
Database.” 

Suggested Action:  The line data refer to a pipe type not found in your reference 

data.  This will happen if you receive the project from someone else that has created 

and used a custom pipe type.  Select another pipe type.  Create a pipe type, if 

necessary to describe the pipe. 

mailto:PTM-info@pentair.com
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E30 “A heater has been forced but it cannot be found in the 
Reference Database.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. You may need to 

reinstall TraceCalc Pro if the Reference Database has become corrupted. 

E31 “A heater has been forced but it cannot be found in the 
Allowed Heaters list.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. Also check whether the 

heater has been deselected in Setup > Project Settings > Product Preferences.  

E32 “A heater has been forced but its Power Output is too low.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. Consider forcing the 

Trace Ratio under the Heater Options tab – Design Options or selecting a higher 

power output heater. You might also want to review the safety factor. 

E33 “A family has been forced but it cannot be found in the 
Reference Database.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. You may need to 

reinstall TraceCalc Pro if the Reference Database has become corrupted.  

E34 “A family has been forced but it cannot be found in the 
Allowed Heaters.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. Also check whether the 

heater has been deselected in Setup > Project Settings > Product Preferences. 

E35 “No heaters found. The Voltage or Maintain Temp. is out of 
range.” 

Suggested Action: Review the Voltage field and Maintain temperature under the 

Basic tab. Ensure you have chosen an appropriate Heater Technology (Series or 

Parallel) under Heater Options tab. Consider deselecting heater Manual Select under 

Heater Options tab – Heater Selection (if selected). Ensure all suitable products are 

available for selection. (Products might have been made unavailable in the Advanced 

Section under the menu item Setup – Project Settings – Product Preferences.) Select 

Recalculation and review results.  

E36 “No heaters found; the Voltage is too low.” 

Suggested Action: Review the Voltage field under the Basic tab. Modify the value, 

if appropriate. Consider deselecting heater Manual Select under the Heater Options 

tab – Heater Selection (if selected). Select Recalculation and review results. Ensure 

you have chosen an appropriate Heater Technology (Series or Parallel) under Heater 

Options tab. 
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E37 “No heaters found; the Maintain temperature is too high.” 

Suggested Action: Review the Maintain temperature field under the Basic tab. 

Modify the value, if appropriate. Consider deselecting heater Manual Select under 

the Heater Options tab – Heater Selection (if selected). Select Recalculation and 

review results. Ensure you have chosen an appropriate Heater Technology (Series or 

Parallel) under Heater Options tab. 

E38 “No heaters found; the Operating temperature is too high.” 

Suggested Action: Review the Operating temperature field under the Basic tab. 

Modify the value, if appropriate. Consider deselecting heater Manual Select under 

the Heater Options tab – Heater Selection (if selected). Select Recalculation and 

review results. Ensure you have chosen an appropriate Heater Technology (Series or 

Parallel) under Heater Options tab.  

E39 “No heaters found; the Exposure Temperature is too high.” 

Suggested Action: Review the Exposure Temperature field under the Basic tab. 

Modify the value, if appropriate. Consider deselecting heater Manual Select under 

the Heater Options tab – Heater Selection (if selected). Select Recalculation and 

review results. Ensure you have chosen an appropriate Heater Technology (Series or 

Parallel) under Heater Options tab. 

E40 “No heaters found; the Startup temperature is too low.” 

Suggested Action: Review the Startup temperature field under the Reference tab. 

Modify the value, if appropriate. Consider deselecting heater Manual Select under 

the Heater Options tab – Heater Selection (if selected). Select Recalculation and 

review results. 

E41 “No heaters found that are suitable for Pipe Heating.” 

Suggested Action: Deselect heater Manual Select under the Heater Options tab – 

Heater Selection (if selected). Review Maintain temperature and other 

temperatures. Select Recalculation and review results. 

E42 “No heaters found that are suitable for the Chemical 
Exposure.” 

Suggested Action: Review the Chemical Exposure field under the Reference tab. 

Deselect heater Manual Select under the Heater Options tab – Heater Selection (if 

selected). Select Recalculation and review results. 

E43 “No heaters found that match the forced heater Construction 
Options.” 

Suggested Action: Review the selections made under Dielectric, Jacket Material 

or Ground Path under the Heater Options tab – Heater Selection. Modify the 

values, if appropriate. Also consider deselecting heater Manual Select under the 

Heater Options tab – Heater Selection. Select Recalculation and review results. 
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E44 “No heaters found that are suitable for use on Plastic 
surfaces.” 

Suggested Action: Review the selection made for Pipe Type under the Basic tab. 

Modify the value, if appropriate. Also consider deselecting heater Manual Select 

under the Heater Options tab – Heater Selection. Select Recalculation and review 

results. Ensure you have chosen an appropriate Heater Technology (Series or 

Parallel) under Heater Options tab. 

E45 “No heaters could be found that are suitable for use in the 
specified Area Classification.” 

Suggested Action: Review the Standards Body and Class selections made under 

the Area Class tab. Modify the value, if appropriate. Also consider deselecting heater 

Manual Select under the Heater Options tab – Heater Selection. This can also be 

the result of specifying a Hazardous Location heater (such as 5HBTV2-CT) in an 

unclassified area. Select Recalculation and review results. 

E47 “No heaters could be found which support the requested 
Sheath Temperature Calculation mode.” 

Suggested Action: Review selections made for Sheath Temperature calculations 

options under the Area Class tab. Enable “Allow stabilized design”, if appropriate. 

Consider specifying Use control limited design, to require the use of thermostatic 

control to limit the sheath temperature. Also consider deselecting heater Manual 

Select under the Heater Options tab – Heater Selection to see if the program can 

find a suitable heater when a free selection is allowed. Select Recalculation and 

review results. 

E48 “No heaters found which have a suitable T Classification.” 

Suggested Action: Review the T-rating value entered in Design Parameters – 

Specify equipment T-rating under the Area Class tab. Enable “Allow stabilized 

design”, if appropriate. Also consider deselecting heater Manual Select under the 

Heater Options tab – Heater Selection to see if the program can find a suitable 

heater when a free selection is allowed. Select Recalculation and review results. 

E49 “No heaters found; the Sheath Temperature is too high.” 

Suggested Action: Review the selections made for Sheath Temperature 

calculations options under the Area Class tab. Modify the value, if appropriate. 

Consider specifying Use control limited design, to require the use of thermostatic 

control to limit the sheath temperature. Also consider deselecting heater Manual 

Select under the Heater Options tab – Heater Selection to see if the program can 

find a suitable heater when a free selection is allowed. Select Recalculation and 

review results. 

E50 “No heaters found; the required cable Resistance is too 
low.” 

Suggested Action: The pipe might be too long. Break it up into several circuits, or 

review the Voltage entered under the Basic tab. Modify the voltage value lower, if 

appropriate. Also consider deselecting heater Manual Select under the Heater 

Options tab – Heater Selection. Select Recalculation and review results. 
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E51 “No heaters found; the required cable Resistance is too 
high.” 

Suggested Action: Review the Voltage entered under the Basic tab. Modify the 

voltage value higher, if appropriate. Also consider deselecting any manual Heater 

Select under Heater Options tab - Heater Selection. Select Recalculation and 

review results. 

E52 “No heaters found; the cable Conductor Temperature is too 
high.” 

Suggested Action: Review the Heater Operating Voltage entered under the Basic 

tab. Modify the voltage value lower, if appropriate. Consider specifying Use control 

limited design, to require the use of thermostatic control to limit the conductor 

temperature. Also consider deselecting heater Manual Select under the Heater 

Options tab – Heater Selection. Select Recalculation and review results. 

E53 “No heaters found; the Heat Loss or Trace Ratio is too high.” 

Suggested Action: Review the values entered for the Insulation Thickness and 

Maintain temperature under the Basic tab. Modify the insulation thickness value 

higher, if appropriate. Also consider deselecting heater Manual Select under the 

Heater Options tab – Heater Selection. Select Recalculation and review results. 

E54 “There is an error on another segment in this group.” 

Suggested Action: Open each of the lines in the group of lines that belong to the 

same parent by clicking on them in the Project Explorer Pane. Find which line(s) 

have error messages and resolve those errors. 

E55 “No Cold Leads found with required current rating.” 

Suggested Action: Review the Voltage entered under the Basic tab. This can be the 

result of asking for a series cable to operate at low voltage, resulting in high current. 

Modify the voltage value higher, if appropriate. Also consider deselecting heater 

Manual Select under the Heater Options tab – Heater Selection. Select 

Recalculation and review results 

E56 “Unable to locate a Cold Lead with the proper 
configuration.” 

Suggested Action: Review and possibly remove any manually selected Cold Lead 

Options on the Heater Options tab. 

E57 “No heaters found with specified Number of Conductors.” 

Suggested Action: Change the number of conductors. Also, under Project Settings – 

Product Preferences, ensure that you haven’t excluded heaters with the proper 

number of conductors. 

E58 “No heaters found that are suitable for the specified Voltage 
Configuration.”  

Suggested Action: This indicates that TraceCalc Pro was unable for find any heaters 

that are rated for use with your specified Voltage Configuration.  Change your 
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voltage configuration or review/remove any manually selected Heater Design 

settings. 

E100 “No heaters found; the Power Output is too high.” 

Suggested Action: The required heater power output might be too high because the 

heat loss is very high. Under the Basic tab, review the value in the Insulation 

Thickness field. This value may be unreasonably small. Modify the insulation 

thickness value higher, if appropriate. Also consider deselecting heater Manual 

Select under the Heater Options tab – Heater Selection. Select Recalculation and 

review results. 

E101 “No heaters found the Power Output is zero.” 

Suggested Action: This message indicates that the required Power Output is zero. 

This will be because the heat loss is zero. There could be no heat loss if the Maintain 

temperature is the same or less than the Minimum Ambient temperature. However, 

the program should not allow this condition. If you enter a Minimum Ambient 

temperature that is greater than or equal to the Maintain temperature, the program 

resets the Maintain temperature to be 1 degree greater than the Minimum Ambient 

temperature.) 

E102 “The maximum allowed output is too low.” 

Suggested Action: This error means that TCPro does not have enough vessel surface 

area to fit all of the required heater.  It can occur for one or more of the following 

reasons: 

 You have specified a Maximum Heater Ouput that is too low. 

 You have specified a Maximum Heater Output, but no heaters could be 

found that satisfy this setting. 

 You have specified a Min. Heater Spacing that is too high. 

 You have specified an Available Area setting that is too low. 

 The Default Heater Max. Output setting is too low. 

Please review each of these settings adjust as required. 

E103 “An Attachment has been forced but it can not be found in 
the Reference Database.” 

Suggested Action: This indicates that an Attachment Method has been manually 

selected, but it can not be found in the current Product Database.  This can occur if 

you are trying to use a project file that was created on a different workstation which 

had access to a different set of product data. From the Heater Options tab, clear the 

forced setting and allow TraceCalc Pro to select the default Attachment Method for 

the selected heater. 

E110 “Unable to converge during equilibrium temperature 
calculation.” 

Suggested Action: Contact Technical Support. This is an abnormal error condition. 
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E111 ““The specified Standards Body could not be found in the 
Reference Database.”   

Suggested Action: This indicates that selected Standards Body can not be found in 

the current Product Database.  This can occur if you are trying to use a project file 

that was created on a different workstation which had access to a different set of 

product data. From the Area Class tab, select an new Standards Body. 

E150 “No heaters found, the user-defined heater output 
maximum is too low or the user-defined heater spacing is too 
large.” 

Suggested Action:  This indicates that the user-specified area and heater spacing 

does not allow enough heater length to supply the necessary power to offset the 

vessel heat loss.  You may need to decrease the heater spacing, increase the available 

area, or select a higher-power cable. 

 E151 “No heaters found, the user-defined heater spacing is too 
large.” 

Suggested Action:  This indicates that the user-specified area and heater spacing 

does not allow enough heater length to supply the necessary power to offset the 

vessel heat loss.  You may need to decrease the heater spacing, increase the available 

area, or select a higher-power cable. 

 “An unspecified error occurred during recalculation.” 

Suggested Action: Contact Technical Support. This is an abnormal error condition. 

Warnings 
The following warning messages give descriptions that indicate that the program 

completed its calculations but has encountered a situation that you should review. 

W1001 “Circuit current exceeds the Max. Allowed value for the 
specified CB size.” 

Suggested Action: Review the Calculated Results Pane. Consider changing the 

Max. CB Size or Heater Operating Voltage the entered under the Basic tab. 

Modify the value, if appropriate. Also consider deselecting heater Manual Select 

under the Heater Options tab – Heater Selection. Select Recalculation and review 

results. 

W1002 “Circuit current exceeds maximum allowed for the 
selected heater.” 

Suggested Action: Review the Calculated Results Pane. Consider changing this 

section of piping into two separate sections using separate heat-tracing circuits. Also 

consider deselecting heater Manual Select under the Heater Options tab – Heater 

Selection. Select Recalculation and review results. 
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W1003 “Max. circuit or unjointed cable length exceeded.” 

Suggested Action: Review the Calculated Results Pane, which will give you either 

the Max. Circuit Length (Parallel heating cables) or the Max. Unjointed Length 

(Series heating cables). Please refer to the manufacturers product literature. For 

Parallel heating cables, consider increasing the Max. CB Size or break the line into 

multiple circuits. For Series heating cables, split the line into multiple sublines each 

connected with a splice, so that the max. length that can be supplied in one piece is 

not longer exceeded. Also consider deselecting heater Manual Select under the 

Heater Options tab – Heater Selection. Select Recalculation and review results. 

W1004 “Max. controlled temperature exceeds Max. Allowable 
temperature.” 

Suggested Action: Review the Calculated Results Pane. Consider changing the 

Control Method under the Controls tab to be Line Sensing or Ambient Sensing. 

Also consider deselecting heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. 

W1005 “Contact Temp exceeds Max. Allowable temperature.” 

Suggested Action: Review the Calculated Results Pane. Consider changing the 

Control Method under the Controls tab to be Line Sensing or Ambient Sensing. 

Also consider deselecting heater Manual Select under the Heater Options tab – 

Heater Selection. Select Recalculation and review results. 

W1006 “Heater Sheath Temp exceeds Max. Allowable 
temperature.” 

Suggested Action: Review the Calculated Results Pane. Consider changing the 

Control Method under the Controls tab to be Line Sensing or Ambient Sensing. 

Review Maximum Allowable temperature under the Basic tab. Also consider 

deselecting heater Manual Select under the Heater Options tab – Heater Selection. 

Select Recalculation and review results. 

W1007 “Max. Controlled temperature exceeds heater limits. Line 
Sensing control is required.” 

Suggested Action: Change the Control Method to “Line Sensing, no failure alarm,” 

or “Line sensing, w/failure alarm.” If applicable, you may also consider removing 

any Manual Select constraints from the Heater Options tab. 

W1009 “Forced Power Components not suitable, default used.” 

Suggested Action: Review the resultant component selection by right-clicking on 

the line name in the Project Explorer Pane and selecting Detail Report for Current 

Line. Go to bottom of page 2 to see the Components. If these are not appropriate, 

determine why the forced selection was not available. Consider changing the 

Manual Select component choice on the Components tab. Also consider deselecting 

heater Manual Select on the Heater Options tab – Heater Selection. Select 

Recalculation and review results. 



 

TraceCalc Pro User Guide H57159 (01/14) Appendix A: Troubleshooting    117 

W1010 “Forced End Seal Components not suitable, default 
used.” 

Suggested Action: Review the resultant component selection by right-clicking on 

the line name in the Project Explorer Pane and selecting Detail Report for Current 

Line. Go to bottom of page 2 to see the Components. If these are not appropriate, 

determine why the forced selection was not available. Consider changing the 

Manual Select component choice on the Components tab. Also consider deselecting 

heater Manual Select under the Heater Options tab – Heater Selection. Select 

Recalculation and review results. 

W1011 “Forced Tee Components not suitable, default used.” 

Suggested Action: Review the resultant component selection by right-clicking on 

the line name in the Project Explorer Pane and selecting Detail Report for Current 

Line. Go to bottom of page 2 to see the Components. If these are not appropriate, 

determine why the forced selection was not available. Consider changing the 

Manual Select component choice under the Components tab. Also consider 

deselecting heater Manual Select under the Heater Options tab – Heater Selection. 

Select Recalculation and review results. 

W1012 “Forced splice components not suitable, default used.” 

Suggested Action: Review the resultant component selection by right-clicking on 

the line name in the Project Explorer Pane and selecting Detail Report for Current 

Line. Go to bottom of page 2 to see the Components. If these are not appropriate, 

determine why the forced selection was not available. Consider changing the 

Manual Select component choice under the Components tab. Also consider 

deselecting heater Manual Select under the Heater Options tab – Heater Selection. 

Select Recalculation and review results. 

W1020 “Forced Control not suitable, default used.” 

Suggested Action: Go to middle of page 1 to see the Control selection. 

(Alternatively, view the Bill of Materials for Current Line.) If this is not appropriate, 

determine why the forced selection is not available. Consider changing to Electronic 

– Local Control Equipment under the Controls tab. Also consider deselecting 

heater Manual Select under the Heater Options tab – Heater Selection. Select 

Recalculation and review results. 

W1021 “Forced Sensor not suitable, default used.” 

Suggested Action: Review the choices of sensors available in the selection lists in 

Centralized Control Equipment or Local Control Equipment under the Controls 

tab and consider selecting a specific Sensor. Determine why a sensor could not be 

found. Check that the temperatures entered under the Basic tab are correct and that 

sensors are available for these temperatures. Consider changing the Control Method 

under the Control tab to see how this would affect the results. 

W1022 “No suitable Controls found.” 

Suggested Action: Review the choices of controls available in the selection lists in 

Centralized Control Equipment or Local Control Equipment under the Controls 

tab and consider selecting a specific Control. Determine why a control could not be 

found. Check that there is a suitable control for the Area selected under the Area 
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Class tab. Consider changing the Control Method under the Control tab to see how 

this would affect the results. 

W1023 “No suitable Sensors found.” 

Suggested Action: Review the choices of sensors available in the selection lists in 

Centralized Control Equipment or Local Control Equipment under the Controls 

tab and consider selecting a specific Sensor. Determine why a sensor could not be 

found. Check that the Temperatures entered under the Basic tab are correct and that 

sensors are available for these temperatures. Consider changing the Control Method 

under the Control tab to see how this would affect the results. 

W1024 “The default Pipe Strap specified in Project Settings can 
not be found.” 

Suggested Action: This indicates that selected Pipe Strap that is specified on the 

Design tab of the Project Settings window can not be found in the current Product 

Database.  This can occur if you are trying to use a project file that was created on a 

different workstation which had access to a different set of product data.  Go to 

Project Settings and re-select a Pipe Strap that is availabe in the current product data. 

W1030 “Multiple circuits created.” 

Suggested Action: Review the Calculated Results Pane. Note that Cable Set 

Quantity is greater than 1. This can be an acceptable design, but if you do wish to 

redesign with a single cable set, consider changing the Insulation Thickness or 

possibly the Maximum CB Size under the Basic tab. Also consider deselecting any 

manual Heater Select under Heater Options tab – Heater Selection. Do 

Recalculation and review results. 

W1031 “Forced segment length exceeds heater max. circuit 
length.” 

Suggested Action: Review the advanced heater options settings.  The forced 

segment length exceeds the circuit length for the selected heater.  Use the Advanced 

Heater Options dialog to adjust the forced segment length.  If you do not wish to 

reduce the segment length, you may choose to force a different family of heaters. 

W1040 “Calculated sheath temp. exceeds Heater Max. Exposure 
Temp.” 

Suggested Action: Review the calculated Sheath Temperature under the Heater 

Data in the Calculated Results Pane. Compare this with the temperature values 

entered under the Basic tab. Consider specifying Use control limited design, to 

require the use of thermostatic control to limit the Sheath Temperature. Also 

consider deselecting any manual Heater Select under Heater Options tab – Heater 

Selection to see if the program can find a suitable heater when a free selection is 

allowed. Do Recalculation and review results. 

W1041 “Max. Operating temperature exceeds heater limits. Line 
Sensing control is required.” 

Suggested Action: Change the Control Method to “Line Sensing, no failure alarm,” 

or “Line Sensing, w/failure alarm.” Depending on the heating cable type selected, 

you may want to consider forcing a higher temperature rated cable. 
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W1042 “Heater wattage too high at Max. Controlled temperature. 
Line Sensing control is required.” 

Suggested Action: Change the Control Method to Line Sensing. Depending of the 

heater type selected, you may want to consider forcing a higher temperature rated 

cable. You could also try forcing the Trace Ratio to a higher value. This would allow 

TraceCalc Pro to look for lower wattage cables to meet the total heat loss 

requirement. 

W1043 “Sheath temperature calculation is invalid.  Spacing does 
not exceed cable minimum spacing.” 

Suggested Action: Lower the trace ratio.  If you have not forced the trace ratio, and 

have forced the heater, you should deselect the heater and allow TraceCalc Pro to 

select a heater, or select a higher-power heater. 

W1044: Min. controlled temperature below maintain temperature.  
Check temperature sensor location. 

Suggested Action: This warning indicates that you are using line sensing control to 

control multiple line segments based on the temperature of another segment.  Move 

location of your temperature sensor to another line segment and recalculate.  You 

may need to break the line grouping into additional, independently controlled 

circuits.  You can also try to equalize the duty cycle amongst the segments. 

W1045: Max. controlled temperature exceeds control limited 
setpoint.  Check temperature sensor location. 

Suggested Action: This warning indicates that you are using line sensing control to 

control multiple line segments based on the temperature of another segment.  In this 

case, the temperature of some line segments may exceed the control limited setpoint 

value used for sheath temperature calculations.  This is potentially a very serious 

condition and MAY INVALIDATE THE CALCULATED SHEATH 

TEMPERATURE.  You should carefully review the design and possibly break the 

line grouping into additional, independently controlled circuits.  

W1050 “Valve1 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 

balance the heat loss from this valve than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the valves. Note: To view the Maximum Recommended 

Length, being the maximum practicable heating cable length, for all heat sinks, 

select Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 

W1051 “Valve2 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 
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balance the heat loss from this valve than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the valves. Note: To view the Maximum Recommended 

Length, being the maximum practicable heating cable length, for all heat sinks, 

select Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 

W1052 “Valve3 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 

balance the heat loss from this valve than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the valves. Note: To view the Maximum Recommended 

Length, being the maximum practicable heating cable length, for all heat sinks, 

select Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 

W1053 “Support1 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 

balance the heat loss from this support than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the supports. Note: To view the Maximum Recommended 

Length, being the maximum practicable heater length, for all heat sinks, select 

Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 

W1054 “Support2 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 

balance the heat loss from this support than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the supports. Note: To view the Maximum Recommended 

Length, being the maximum practicable heater length, for all heat sinks, select 

Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 
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W1055 “Support3 max. recommended heater length exceeded.” 

Suggested Action: This warning message is an important caution to bring to your 

attention that the program needed to provide a greater length of heating cable to 

balance the heat loss from this support than was entered as the Maximum 

Recommended Length (maximum practicable heating cable length) in the heat sink 

data tables. Consider using a heating cable with higher power output or specifying 

more insulation for the supports. Note: To view the Maximum Recommended 

Length, being the maximum practicable heater length, for all heat sinks, select 

Setup on the main menu, then Project Settings > Advanced tab > Heat sink 

Definitions button > Modify. You cannot modify standard default data marked 

Read Only = Yes, but you can right-click on an item and select Copy then Paste 

Append to define a new item with modified data. For more information, see 

“Advanced Tab” on page 94. 

W1056 “Flange max. recommended heater length exceeded.” 

Suggested Action: The program will not call up a greater length of heating cable 

than can practicably be installation on the selected type, and size of flange. This 

warning message is an important caution to bring to your attention that the program 

needed to provide a greater length of heating cable to balance the heat loss from this 

flange than was entered as the Maximum Recommended Length (maximum 

practicable heating cable length) in the heat sink data tables. Consider using a 

heating cable with higher power output or specifying more insulation for the flanges. 

Note: To view the Maximum Recommended Length, being the maximum 

practicable heater length, for all heat sinks, select Setup on the main menu, then 

Project Settings > Advanced tab > Heat sink Definitions button > Modify. You 

cannot modify standard default data marked Read Only = Yes, but you can right-

click on an item and select Copy then Paste Append to define a new item with 

modified data. For more information, see “Advanced Tab” on page 94. 

W1057 “Circuit breaker size exceeds the maximum allowed for 
the selected heater.” 

Suggested Action: The manufacturer’s ratings and approvals for each heater specify 

the maximum size of circuit breaker that may be used to power the heater.  In order 

to clear this warning, you will need break the line down into additional Parent lines. 

W1058 “Preferred gland size not available for selected cold lead.  
Default used.”   

Suggested Action: This indicates that the Cold Lead that was selected by TraceCalc 

Pro is not offered with one of the Preferred Cold Lead Gland Sizes that have been 

specified on the Design tab of the Project Settings window. 

W1059 “Heater sheath temp. may exceed the Insulation Max. 
Temp.”   

Suggested Action: Use a lower-power heating cable, for instance by raising the trace 

ratio or increasing the insulation thickness; or consider using a high-temperature 

insulation, either by itself or as part of a two-layer insulation system.  
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W1060 “Forced cold lead or cold lead group not suitable.  Default 
used.”   

Suggested Action: Review the product data sheet to learn why the forced cold lead 

was not acceptable.  You may choose to accept the cold lead selected by TraceCalc 

Pro, or you may select a different cold lead and recalculate.   

W1061 “Standard cold lead not suitable, generic used.  Contact 
TTC for alternatives.”   

Suggested Action: This indicates that no standard cold lead in the TraceCalc Pro 

database is suitable for your application.  An experienced Pentair Thermal 

Management representative can recommend a custom cold lead suitable for your 

application. 

W1074 “No [??] were found that are compatible with the selected 
heater.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1075 “No [??] were found that are suitable for the application.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1076 “No [??] found, the voltage is too high.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1077 “No [??] found, the voltage is too low.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 
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W1078 “No [??] found, the Exposure temperature is too high.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1080 “No [??] found, the Operating Current is too high.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1081 “No [??] found, the Operating Current is too low.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1082 “No [??] found, the Pipe OD is too large.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1083 “No [??] found, the Pipe OD is too small.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1084 “No [??] were found that are suitable for plastic 
surfaces.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 
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Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1085 “No [??] were found that are suitable for the specified 
Area Classification.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1086 “No [??] were found, the Max. Surface Temp. exceeds the 
auto-ignition or T-class temp.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals).  If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1087 “No [??] found with correct number of heater entries.” 

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the input data specified in the message and 

try recalculating. Please note that to maintain the approvals and/or ratings of a 

heating cable, you must use the components that have been approved by the 

manufacturer for that particular heating cable. 

W1088 “No [??] found that are suitable for the specified Voltage 
Configuration.”   

Suggested Action: The [??] will be replaced with the specific component category 

(Power Kits, Splice Kits, Tee Kits or End Seals). If you are forcing a particular 

selection from the Components tab, consider removing the forced selection. 

Otherwise, you will be required to adjust the Voltage Configuration and try 

recalculating. Please note that to maintain the approvals and/or ratings of a heating 

cable, you must use the components that have been approved by the manufacturer for 

that particular heating cable. 

W1100 “No controls were found that are suitable for the 
application.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 
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W1201 “No controls found, the voltage is too high.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1202 “No controls found, the voltage is too low.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1203 “No controls found, the Exposure Temperature is too 
high.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1204 “No controls found, the Maintain temperature or Control 
Limited Setpoint exceeds the setpoint range.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1205 “No controls found, the Operating Current is too high.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1206 “No controls found, the Operating Current is too low.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1207 “No controls found, the Pipe OD is too large.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1208 “No controls found, the Pipe OD is too small.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 
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Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1209 “No controls found that are suitable for use on plastic 
surfaces.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1210 “No controls found that are suitable for the Area 
Classification.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1211 “No controls found, the controller Max. Surface 
Temperature exceeds the auto-ignition temperature.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1212 “No controls found that are suitable for the specified 
Voltage Configuration.” 

Suggested Action: This indicates that TraceCalc Pro was unable for find any 

Temperature Controls that are rated for use with your specified Voltage 

Configuration. Change your voltage configuration or review/remove any manually 

selected settings on the Controls tab. 

W1213 “No controls found with the correct number of switch 
poles.” 

Suggested Action: This indicates that TraceCalc Pro was unable for find any 

Temperature Controls that have the correct number of poles.  This is driven by the 

Voltage Configuration. Single phase (phase-phase) will require 2 poles and Three 

Phase configurations will require 3 poles.  You may need to change your Voltage 

Configuration or modify settings on the Controls tab. 

W1214 “No controls found suitable for Temperature Limited 
design.” 

Suggested Action: If you have forced a controller, de-select the controller and allow 

TraceCalc Pro to select one. 

W1215 “Temperature limited design in Zone 1 (Zone 21) requires 
the use of an approved temperature limiter.” 

Suggested Action: This is just a reminder that you must use a controller/limiter 

that is approved to be used as a temperature limiter for a Zone 1 area. 
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W1220 “No sensors were found that are suitable for the 
application.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1223 “No sensors were found, the Exposure Temperature is 
too high.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1229 “No sensors were found that are suitable for use on 
plastic surfaces.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1230 “No sensors were found that are suitable for the Area 
Classification.” 

Suggested Action: TraceCalc Pro was unable to locate a temperature control or 

sensor that meets the specified data value. You can try changing selections on the 

Controls tab or alternatively, changing the input data to generate a different heating 

cable circuit design. 

W1231 “No sensors found, the sensor Max. Surface Temperature 
exceeds the auto-ignition temperature.” 

Suggested Action: This indicates that TraceCalc Pro was unable for find any 

Temperature Sensors that have a maximum sheath temperature or T-rating that is 

compatible with your current Area Class settings.  Review your settings on both the 

Area Class and Controls tabs. 
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Appendix B: Hazardous Gases 
and Vapors 

The following pages contain excerpts from the National Fire Protection Association 

publication NFPA 497M “Classification of Gases, Vapors, and Dusts for Electrical 

Equipment in Hazardous (Classified) Locations 1994 Edition.” The list includes the 

ignition temperatures and group classifications for Class I gases. Class II dusts and 

Class III fibers and filings are not listed. 

Note that considerable skill and judgment must be applied when deciding to what 

degree an area contains hazardous concentrations of vapors, combustible dusts, or 

easily ignitable fibers and filings. Many factors—such as temperature, barometric 

pressure, quantity of release, humidity, ventilation, and distance from the vapor 

source—must be considered. When information on every factor concerned is 

properly evaluated, a consistent classification of the selection and location of 

electrical equipment can be developed. 

For the most current list of properties of flammable liquids, gases, and solids, see the 

latest edition of NFPA 497M, “Classification of Gases, Vapors, and Dusts for 

Electrical Equipment in Hazardous (Classified) Locations.” 

Group Classification and AIT Table 

Table B-1: Group Classification and Auto-ignition Temperature (AIT) of 

Selected Flammable Gases and Vapors 

 

 

Material Group °F °C 

Acetaldehyde C* 347 175 

Acetic acid D* 867 464 

Acetic anhydride D 600 316 

Acetone D* 869 465 

Acetone cyanohydrin D 1270 688 

Acetonitrile D 975 524 

Actylene A* 581 305 

Acrolein (inhibited) B* 455 235 

Acrylic acid D 820 438 
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Material Group °F °C 

Acrylonitrile D* 898 481 

Allyl alcohol C* 713 378 

Allyl chloride D 905 485 

Ammonia D* 928 498 

n-Amyl acetate D 680 360 

Aniline D 1139 615 

Benzene D* 928 498 

Benzyl chloride D 1085 585 

1,3-Butadiene B* 788 420 

Butane D* 550 288 

1-Butanol D* 650 343 

2-Butanol D* 761 405 

n-Butyl acetate D* 790 421 

iso-Butyl acetate D* 790 421 

n-Butyl acrylate (inhibited) D 559 293 

Butylamine D 594 312 

Butylene D 725 385 

n-Butyraldehyde C* 425 218 

n-Butyric acid D 830 443 

Carbon monoxide C* 1128 609 

Chlorobenzene D 1099 593 

Cresol D 1038–1110 559–599 

Crotonaldehyde C* 450 232 

Cumene D 795 424 

Cyclohexane D 473 245 

Cyclohexene D 471 244 

Cyclohexanol D 572 300 

Cyclohexanone D 473 245 

Cyclopropane D* 938 503 

p-Cymene D 817 436 

n-Decanol D 550 288 

Decene D 455 235 

Diacetone alcohol D 1118 603 

o-Dichlorobenzene D 1198 647 

1.1-Dichloroethane D 820 438 

1.2-Dichloroethylene D 860 460 

Dicyclopentadiene C 937 503 

Diethyl benzene D 743–842 395–450 

Diethylene glycol monobutyl ether C 442 228 

Diethylene glycol monomethyl ether C 465 241 

Diethylamine C* 594 312 

Diethyl ether C* 320 160 

N-N-Dimethyl aniline C 700 371 
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Material Group °F °C 

Di-isobutylene D* 736 391 

Di-isobutyl ketone D 745 396 

Di-isopropylamine C 600 316 

Dimethylamine C 752 400 

Dimethyl formamide D 833 455 

Dimethyl sulfate D 370 188 

1.4-Dioxane C 356 180 

Dipentene D 458 237 

Di-N-propylamine C 570 299 

Dodecene D 491 255 

Epichlorohydrin C* 772 411 

Ethane D* 882 472 

Ethanol D* 685 363 

Ethyl acetate D* 800 427 

Ethyl acrylate (inhibited) D* 702 372 

Ethylamine D* 725 385 

Ethyl benzene D 810 432 

Ethyl chloride D 966 519 

Ethylene C* 842 450 

Ethylene chlorohydrin D 797 425 

Ethylene glycol monobutyl ether C 460 238 

Ethylene glycol monobutyl ether acetate C 645 340 

Ethylenediamine D* 725 385 

Ethylene dichloride D* 775 413 

Ethylene glycol monoethyl ether C 455 235 

Ethylene glycol monoethyl ether acetate C 715 379 

Ethylene glycol monomethyl ether D 545 285 

Ethylenimine C* 608 320 

Ethylene oxide B* 804 429 

Ethyl formate D 851 455 

2-Ethylhexaldehyde C 375 191 

2-Ethyl hexanol D 448 231 

2-Ethyl hexyl acrylate D 485 252 

Ethyl mercaptan C* 572 300 

Formaldehyde (gas) B 795 429 

Formic acid (90%) D 813 434 

Fuel oils D 410–765 210–407 

Furfural C 600 316 

Furfuryl alcohol C 915 490 

Gasoline D* 536–880 280–471 

Heptane D* 399 204 

Heptene D 500 260 

Hexane D* 437 225 
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Material Group °F °C 

2-Hexanone D 795 424 

Hexene D 473 245 

Hydrazine C 74–518 23–270 

Hydrogen B* 968 520 

Hydrogen cyanide C* 1000 538 

Hydrogen sulfide C* 500 260 

Isoamyl acetate D 680 260 

Isobutyl acrylate D 800 427 

Isobutyraldehyde C 385 196 

Isophorone D 860 260 

Isoprene D* 428 220 

Isopropyl acetate D 860 460 

Isoamyl alcohol D 662 350 

Isopropylamine D 756 402 

Isopropyl ether D* 830 443 

Iso-octyl aldehyde C 387 197 

Kerosene D 410 210 

Liquefied petroleum gas D 761–842 405–450 

Mesityl oxide D* 652 344 

Methane D* 999 630 

Methanol D* 725 385 

Methyl acetate D 850 454 

Methyl acrylate D 875 468 

Methylamine D 806 430 

Methyl n-amyl ketone D 740 393 

Methylcyclohexane D 482 250 

Methylcyclohexanol D 565 296 

Methyl ether C* 662 350 

Methyl ethyl ketone D* 759 404 

Methyl formal C* 460 238 

Methyl formate D 840 449 

Methyl isobutyl ketone D* 840 449 

Methyl isocyanate D 994 534 

Methyl methacrylate D 792 422 

2-Methyl-1-propanol D* 780 416 

2-Methyl-2-propanol D* 892 478 

alpha-Methyl styrene D 1066 574 

Monoethanolamine D 770 410 

Monoisopropanolamine D 705 374 

Monomethyl aniline C 900 482 

Monomethyl hydrazine C 382 194 

Morpholine C* 590 310 

Naphtha (coal tar) D 531 277 
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Material Group °F °C 

Nitrobenzene D 900 482 

Nitroethane C 778 414 

Nitromethane C 785 418 

1-Nitropropane C 789 421 

2-Nitropropane C* 802 428 

Nonane D 401 205 

Octane D* 403 206 

Octene D 446 230 

Pentane D* 470 243 

1-Pentanol D* 572 300 

2-Pentanone D 846 452 

1-Pentene D 527 275 

Propane D* 842 450 

1-Propanol D* 775 413 

2-Propanol D* 750 399 

Propionaldehyde C 405 207 

Propionic acid D 870 466 

Propionic anhydride D 545 285 

n-Propyl acetate D 842 450 

Propylene D* 851 455 

Propylene dichloride D* 1035 557 

Propylene oxide B* 840 449 

n-Propyl ether C 419 215 

Propyl nitrate B* 347 175 

Pyridine D* 900 482 

Styrene D* 914 490 

Tetrahydrofuran C* 610 321 

Tetrahydronaphthalene D 725 385 

Toluene D* 896 480 

Turpentine D 488 253 

Unsymmetrical dimethyl hydrazine 

(UDMH) 

C* 480 249 

Valeraldehyde C 432 222 

Vinyl acetate D* 756 402 

Vinyl chloride D* 882 472 

Vinylidene chloride D 1058 570 

Vinyl toluene ti 921 494 

Xylenes D* 867–984 464–529 

 

 

*Material has been classified by test. 
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Appendix C: Field Name Locator 

The following table gives you a list of TraceCalc Pro’s field and the location (tab, 

sub-window, dialog box) where each field is located in the program. 

Field Name Locator Table 

Table C-1: Field name locator 

 

Field Name Location (tab or menu item) 

Above Max Fill (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Additional Length of Heater Basic / Vessel Properties / Heat Sinks 

Additional Length of Heater Basic / Vessel Properties / Heat Sinks 

Advanced Setup / Project Settings 

Allow Lump Sum Watts Basic / Valves, Supports 

Allow Percentage Of Pipe Length Basic / Valves, Supports 

Allow Priced Bill of Materials Project Settings / Advanced 

Allow Spiraling Heater Options 

Allow Stabilized Design Area Class 

Area  Reference 

Area Classification Area Class 

Auto-ignition Temperature Area Class 

Auto-ignition Type Area Class 

Available Area Basic / Vessel Properties 

Body Diameter Basic / Vessel Properties 

Body Height Basic / Vessel Properties 

Body Length Basic / Vessel Properties 

Body Width Basic / Vessel Properties 

Bottom Diameter Basic / Vessel Properties 

Bottom Height Basic / Vessel Properties 

Bottom Insulated Basic / Vessel Properties 

Bottom Length Basic / Vessel Properties 

Bottom Style (Vessel) Basic / Vessel Properties 

Bottom Width Basic / Vessel Properties 
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Field Name Location (tab or menu item) 

Category Controls 

CB Number Controls 

Central Sensor Name Controls 

Central Sensor Quantity Controls 

Chemical Exposure  Reference 

Circuit Breaker Load Factor Project Settings / Design 

Circuit Breaker Number Controls 

Circuit Number Controls 

Cladding Emissivity Project Settings / Design 

Class Area Class 

Comment Reference 

Conductors Heater Options 

Contact Points (Ladder) Basic / Vessel Properties / Heat Sinks 

Control Method  Controls 

Cold Leads Heater Options 

Cross-Sectional Area (Ladder) Basic / Vessel Properties / Heat Sinks 

Cross-Sectional Area (Vessel Support) Basic / Vessel Properties / Supports 

Currency Setup / Project Settings / Advanced 

Customer Name Setup / Project Settings / Information 

Customer Reference Number Setup / Project Settings / Information 

Data Version  

Setup / Project Settings / Product 

Preferences 

Default Pipe Straps Setup / Project Settings / Design 

Default Warning Label Setup / Project Settings / Design 

Design Setup / Project Settings 

Diameter (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Dielectric Heater Options 

Division / Zone Area Class 

Drain / Vent Heater Length Basic / Valves, Supports 

Drain / Vent Quantity Basic / Valves, Supports 

Drain / Vent Length Setup / Project Settings/ Design 

Drawing Number Reference 

End Seal Components 

Exposure Temperature Basic 

Film Coefficient Project Settings / Advanced 

Flange Mode Basic / Valves, Supports 

Flange Quantity Basic / Valves, Supports 

Flange Spacing Basic / Valves, Supports 

Flange Specify Spacing Basic / Valves, Supports 

Flange Type Basic / Valves, Supports 

Fluid Reference 

Force Attachment Heater Options 

Force Dielectric Heater Options 

Force Family Heater Options 
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Field Name Location (tab or menu item) 

Force Ground Path Heater Options 

Force Heater Heater Options 

Force Jacket Material Heater Options 

Force Multiple Runs Heater Options 

Force Trace Ratio Heater Options 

Gas / Dust Groups Area Class 

Ground Path  Heater Options 

Heat Loss Safety Factor Reference 

Heater Attachment Heater Options 

Heater End Seal Group Components 

Heater Family Heater Options 

Heater Maximum OCD Size Basic 

Heater Operating Voltage Basic 

Heater Power Group Components 

Heater Splice Group Components 

Heater Tee Group Components 

Heater Type Heater Options 

Heat sink Definitions Project Settings / Advanced 

Height (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Hi-limit Temperature Area Class 

Indoor Reference 

Insulated (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Insulated (Vessel Support) Basic / Vessel Properties / Supports 

Information Project Settings 

Insulation Diameter Basic / Advanced 

Insulation Height Basic / Vessel Properties 

Insulation OverSize Basic / Advanced 

Insulation Thickness Basic 

Insulation Thickness (Inner) Basic / Advanced 

Insulation Thickness (Outer) Basic / Advanced 

Insulation Two Layer Basic / Advanced 

Insulation Type Basic 

Insulation Type (Inner) Basic / Advanced 

Insulation Type (Outer) Basic / Advanced 

Jacket Material Heater Options 

Journal Project Settings 

K-factor (Ladder) Basic / Vessel Properties / Heat Sinks 

K-Factor (Vessel Support) Basic / Vessel Properties / Supports 

Line ID Basic 

Line Type  Basic 

Local Control Category Controls 

Local Controller Name Controls 

Local Controller Quantity Controls 
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Field Name Location (tab or menu item) 

Local Sensor Name Controls 

Local Sensor Quantity Controls 

Maintain Temperature Basic 

Manual Select Attachment Heater Options 

Material (Ladder) Basic / Vessel Properties / Heat Sinks 

Material (Vessel) Basic / Vessel Properties 

Material (Vessel Support) Basic / Vessel Properties / Supports 

Maximum Allowable Temperature Basic 

Maximum Ambient Temperature Basic 

Maximum CB Size Basic 

Maximum Fill Basic / Vessel Properties 

Maximum Heater Exposure Temperature Basic 

Maximum Operating Temperature Basic 

Maximum Spiral Ratio Project Settings / Design 

Minimum Ambient Temperature Basic 

Minimum Fill Basic / Vessel Properties 

Minimum Heater Spacing Project Settings / Design 

Miscellaneous Sink Quantity Basic / Valves, Supports 

Miscellaneous Sink Qty (Vessel) Basic / Vessel Properties / Heat Sinks 

Miscellaneous Drain/Vent Quantity Basic / Valves, Supports 

Number of Conductors Heater Options 

Outdoors Reference 

Over size Diameter Basic / Valves, Supports 

Panel Name Controls 

Perimeter (Ladder) Basic / Vessel Properties / Heat Sinks 

Perimeter (Vessel Support) Basic / Vessel Properties / Supports 

Pipe Diameter Basic 

Pipe Length Basic 

Pipe Type Basic 

Pipe Emissivity Setup / Project Settings / Design 

Power Components 

Price List File Setup / Project Settings / Advanced 

Product Preferences Setup / Project Settings 

Product Quantity Controls 

Project Description Setup / Project Settings / Information 

Project Name Setup / Project Settings / Information 

Project Number Setup / Project Settings / Information 

Quantity Basic / Valves, Supports 

Quantity (Ladder) Basic / Vessel Properties / Heat Sinks 

Quantity (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Quantity (Vessel Support) Basic / Vessel Properties / Supports 

Reference Data File 

Setup / Project Settings / Product 

Preferences 

Reference Data Path Setup / Program Settings / Reference 
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Field Name Location (tab or menu item) 

Data 

Reset Price Table Setup / Project Settings / Advanced 

Safety Factor Reference 

Section Basic 

Select Product Controls 

Select Sensor Components 

Sensor Quantity Controls 

Sheath Temperature Calculation Type Area Class 

Show Components Tab Project Settings / Advanced 

Show Project Settings Advanced Options Program Settings / Advanced 

Skirt Wall Thickness Basic / Vessel Properties / Supports 

Slab Thickness Basic / Vessel Properties / Supports 

Specify Auto-ignition Temperature Area Class 

Specify T-Rating Area Class 

Splice Components 

Standards Body Area Class 

Startup Temperature Reference 

Support 1 Mode Basic / Valves, Supports 

Support 1 Quantity Basic / Valves, Supports 

Support 1 Spacing Basic / Valves, Supports 

Support 1 Specify Spacing Basic / Valves, Supports 

Support 1 Type Basic / Valves, Supports 

Technology Heater Options 

Tee Components 

Termination Allowance Project Settings / Design 

T-rating Area Class 

Top Height Basic / Vessel Properties 

Top Insulated Basic / Vessel Properties 

Top Style (Vessel) Basic / Vessel Properties 

Two Layer Insulation System Basic / Advanced 

Type (Vessel) Basic / Vessel Properties 

Type (Vessel Accessories) Basic / Vessel Properties / Heat Sinks 

Type (Vessel Support) Basic / Vessel Properties / Supports 

Use Artificial Hotspot Design Area Class 

Use Centralized Control Equipment Controls 

Use Control Limited Design Area Class 

Use Local Control Equipment Controls 

Use Multiple Cable Sets Heater Options 

Use Over size Insulation Basic / Valves, Supports 

Valve 1 Mode Basic / Valves, Supports 

Valve 1 Quantity Basic / Valves, Supports 

Valve 1 Spacing Basic / Valves, Supports 

Valve 1 Specify Spacing Basic / Valves, Supports 

Valve 1 Type Basic / Valves, Supports 
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Field Name Location (tab or menu item) 

Wall Thickness (Vessel) Basic / Vessel Properties 

Warning Label Interval Project Settings / Design 

Wind Speed Reference 

Zone Area Class 
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Glossary of Terms 

ambient sensing 

A control method where the heating cable system power is controlled by input from 

a temperature sensor measuring the ambient temperature. 

ambient temperature 

The temperature in the area where the pipe is located, outside of the thermal 

insulation. 

artificial hotspot 

A method of installing a high-temperature limit sensor that measures the heating 

cable sheath temperature under “worst case” conditions. The heating cable in the 

immediate vicinity of the sensor is intentionally installed such that it is not in contact 

with the surface to be heated and will, therefore, be representative of the highest 

temperature attained for the entire pipe. 

auto-ignition temperature 

The AIT is the minimum temperature required to cause self-sustained combustion, 

independent of a flame or a heated element. This is different from the flash point of a 

liquid, which is the lowest temperature at which the liquid gives off sufficient vapor 

to form an ignitable mixture with air near the surface of the liquid or within the 

vessel used. The flash point of gasoline is -50ºF (-45°C) and the AIT is 536ºF 

(280°C). 

available area 

The percentage of the total surface area that could be used to apply heater.  It is 

considered as a maximum; TraceCalc Pro will calculate a heater length and spacing 

that will never require more than the available area.  If you prefer for all of the 

available area be used, then you must select the ‘Use All Available Area’ option, 

which is located on the Heater Options dialog box. 

bill of materials 

List of parts needed to fabricate a design created with TraceCalc Pro. 
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cable set 

A heating cable length between components. A pipe line traced with three cables, 

each with end seals, is considered to have three cable sets. The same line traced three 

times with a single cable run is considered to have only one cable set. 

calculated results pane 

The TraceCalc Pro pane that users use to preview online calculated results for a 

project. This window lists specific information related to heating cable length, type, 

performance, and electrical operating characteristics. 

CB load factor 

The factor that is applied to calculate the maximum permissible load for a circuit 

breaker. Standard practice, in accordance with the U.S. National Electric Code and 

Canadian Electrical Code CEC, is to load a circuit breaker to no more than 80% of 

its nominal current rating (for example, a 30 amp circuit may be loaded to 24 

amperes). In Europe, the maximum load is normally 100% of the nominal rating. 

CENELEC 

European Committee for Electrotechnical Standardization. An approval organization 

that sets industrial safety standards. 

chemical exposure 

Identifies whether significant exposure to chemicals is anticipated and limits heating 

cables selected to those having the appropriate outer jacket. 

child 

Also can be thought of as a subline. A user-defined identification of a pipe segment 

for the purposes of organizing or simplifying the heat-tracing design. A segment of a 

pipe system that is connected to, and is typically downstream of, a parent segment 

for either electrical or flow purposes. It takes on the design-related characteristics of 

the parent unless overridden by the user. For instance, a bypass loop on a fire water 

line could be a “child” of the water line. 

circuit breaker 

A device that opens and closes a circuit by non-automatic means; it also opens the 

circuit automatically on a predetermined overcurrent condition without damage to 

itself.  

circuit breaker size 

This is the nominal rating or size of the circuit breaker typically specified in 

amperes. It is the highest continuous current the breaker will pass.  

circuit load 

Either power or current supplied through one circuit breaker (or a group of circuit 

breakers) and associated distribution wiring at the maintain temperature. 
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cladding 

An outer jacket, usually metallic, encasing the thermal insulation to provide 

mechanical and environmental protection. 

Class I 

North American classification for Hazardous Areas where the explosive danger 

consists of flammable gases or vapors. 

Class II 

North American classification for Hazardous Areas where the explosive danger 

consists of combustible dusts. 

Class III 

North American classification for Hazardous Areas where the explosive danger 

consists of combustible fibers or fillings. 

classified location 

See hazardous location.  

cold lead 

Electrically insulated conductors that connect a heating cable conductor to the 

branch-circuit; it does not produce any appreciable heat. Series type heating cables, 

such as mineral insulated cables, require the use of cold leads. 

component 

The device that provides mechanical, electrical and environmental protection to the 

exposed ends of a heating cable segment and a means for making necessary electrical 

connections. Typical components include power connections, splices, tees and end 

seals.  

conduction  

One of the three methods of heat transfer (the others: radiation and convection). The 

transfer of heat by molecular motion without the bulk movement of material. 

Conduction is the only way that heat can be transferred within a solid. 

conductor 

A long thin piece of metal used to carry current. An insulated conductor is a wire. 

continuous load 

An electrical load in which the maximum current is expected to continue for more 

than three hours. 
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controller 

A device that regulates the heat-tracing system by comparing the signal from a 

sensor to a predetermined value and adjusts its output accordingly. Controllers that 

regulate temperature are referred to as temperature controllers or thermostats. 

Temperature sensors can be mechanical (bulb and capillary, bimetallic) or electronic 

(thermocouple, RTD, thermistor). 

control limited design 

A control method option requiring, for sheath temperature prediction purposes, the 

use of a temperature control device to limit the maximum temperature. The need for 

failure annunciation and a separate high-temperature limit controller varies. Be sure 

to check local codes and standards for your specific requirements.  

control method 

The particular user-selected method of temperature control used for a heat-tracing 

systems. See ambient sensing, line sensing, and uncontrolled. 

cross-sectional area 

The amount of vessel surface that is in direct contact with the vessel support. 

CSA 

Canadian Standards Association. An approval organization that sets industrial safety 

standards. 

design pane 

The TraceCalc Pro pane that users use to enter line parameter and design data. This 

window contains six tabs: Basic, Reference, Area Class, Heater Options, 

Components, and Controls. Each tab represents a screen where the user enters 

specific design data for a project. 

Division 1 

Terminology used for classification of an industrial area in which flammable gases 

or combustible dusts can be present under normal conditions, or from frequent 

breakdowns, or where failure of equipment could release materials and create 

simultaneous failure of electrical equipment. Refer to the NEC for a detailed 

definition. 

Division 2 

Terminology used for classification of an industrial area in which flammable gases 

or combustible dust will only be present under abnormal conditions. Refer to the 

NEC for a detailed definition. 

earth plate 

A means for making a conducting connection in a component between a heating 

cable ground and a conducting path to earth.  



 

TraceCalc Pro User Guide H57159 (01/14) Glossary of Terms    145 

electric heat-tracing system 

A system of electric heating cables, components, and a power distribution system 

that may include cables, panelboards, and transformers whose purpose is to maintain 

a piping system at or above a given temperature. The system may also include a 

control system with sensors, alarms, and controllers. Electric heat-tracing systems 

are sometimes referred to as electric pipe heating or trace-heating systems. 

end seal 

A component used to seal the unpowered end of a heating cable circuit. See 

component. 

filter 

Algorithm with user-supplied criteria for sorting results to prepare desired reports or 

export data. 

flange 

A projecting rim on a pipe end used to connect to another pipe, valve or other piping 

component. 

fluid 

A substance, such as water or air, that flows readily and assumes the shape of the 

container. 

FM 

Factory Mutual Research Corporation. An approval organization that sets industrial 

safety standards. 

FM Approved 

Meets a specific set of criteria established and confirmed by Factory Mutual 

Research Corporation.  

force trace ratio 

Instructs the program to use the trace ratio defined by the user. See trace ratio. 

grounded 

Electrically connected to earth or to some conducting body that serves in place of the 

earth. 

ground fault 

The passage of current from a circuit to earth-ground. 

ground-fault circuit breaker 

A device that protects equipment and property from damage from electrical faults or 

fire; it turns off a circuit (within an established period of time) when the current to 
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ground exceeds some predetermined value (typically 30 mA) which is less than that 

required to operate the overcurrent protective device of the supply circuit. Its use is 

required by codes and standards for most heat-tracing applications. Consult Pentair 

Thermal Management or local codes and standards, as applicable, for details. 

hand hole 

Small entry port into a vessel. 

hazardous location 

Also referred to as hazardous (classified) location. An area where fire or explosive 

situations may exist due to the presence of flammable gases or vapors, flammable 

liquids, combustible dusts, or ignitable fibers or filings. For a detailed description, 

refer to the relevant sections of national codes and standards such as the National 

Electrical Code, Articles 500 through 503, the Canadian Electrical Code, Part 1, 

Section 18 and Cenelec EN 50014. 

hazardous location divisions  

See Division 1 and Division 2. 

hazardous location groups 

Groups A, B, C, D, E, F, and G in the National Electrical Code Article 500 

classification system, and Groups IIA, IIB and IIC in the National Electrical Code 

Article 505 method of classification. For purposes of testing, approval, and area 

classification, various air mixtures (not oxygen-enriched) are grouped together 

because they have similar explosion characteristics. 

heat loss 

The rate of thermal energy lost from a pipe, vessel, or equipment to the surrounding 

environment due to the difference in temperature between the pipe and the 

surrounding environment. The heat loss needs to be calculated for heat-tracing 

designs because the heat-tracing must maintain the desired temperature by replacing 

the heat lost. 

heat loss safety factor 

User-specified increase in the calculated heat loss to ensure that the heating cable 

provides extra heat. It is one way to compensate for important design variables that 

cannot be controlled or quantified. See safety factor. 

heated area 

Portion of vessel surface covered by heater. 

heater operating voltage 

The nominal voltage applied at the power supply point for a specific heating cable. 
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heater technology 

For the purposes of TraceCalc Pro, heating cables are divided into two technology 

groups, series and parallel, based on the type of electrical circuitry employed in their 

construction. Typical series cables, such as MI cable, use an electrical resistance wire 

to generate heat and their power output is determined, in part, by their length. 

Parallel cables, such as self-regulating and zone cables, use conductive polymers or 

resistance wires between bus wires to generate heat and can typically be cut to length 

during installation without affecting their power output per unit length.  

heating cable circuit 

In TraceCalc Pro, all the heating cable segments that are powered through a single 

circuit breaker. More commonly, a discrete length of heating cable that is directly 

wired to a single power connection component at one end and terminated with an 

end seal component. Intermediate branch heating cables connected to the heating 

cable with a tee connection are considered part of the heating cable circuit. Note that 

multiple-entry power connection components will accommodate multiple heating 

cable circuits. 

heatsink 

A part that conducts and dissipates heat away from the pipe or equipment. Typical 

examples are pipe supports and valve operators. 

indoor location 

The installation is sheltered and not subject to wind conditions. For TraceCalc Pro 

purposes, it does not describe whether the location is indoors or not, but rather 

whether there is any wind. If the shelter is heated, the minimum ambient temperature 

will differ from the outdoor minimum ambient temperature. 

inner insulation 

The thermal insulation installed closest to the heated surface in two layer insulation 

installations. See two layer insulation. 

insulation height 

The vertical extent to which the side walls of the vessel are insulated.  It is the 

distance between the lower edge of the side wall and the upper edge of the 

insulation.  If the side walls are fully insulated, then the Insulation Height is the same 

as the vessel height (or diameter, if it is a horizontal cylinder). 

insulation thickness 

Dimension from the inner diameter to the outer diameter of the thermal insulation on 

a pipe or the linear thickness of thermal insulation on the surface of a tank or other 

flat surface. See inner insulation and outer insulation. 

jacket 

A thermoplastic or thermosetting plastic covering, sometimes fabric-reinforced, 

applied over the insulation, core, metallic sheath, or armor of a cable. 
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K-factor 

Characteristic of thermal insulation that specifies the thermal conductivity of the 

thermal insulation. 

line sensing 

A control method where the heating cable system power is controlled by input from 

one or more temperature sensor(s) measuring the temperature of the pipe or 

equipment under the thermal insulation at specific representative locations . 

local control equipment 

Control or monitoring equipment mounted in the vicinity of the pipes or power 

connections. 

maintain temperature 

Specified temperature of the surface that the heat tracing is designed to hold at 

equilibrium under specified design conditions. The desired pipe equipment 

temperature at the minimum ambient temperature. 

manhole 

Vessel entry port, large enough for a person. 

maximum allowable temperature 

The maximum temperature permitted by the user for the process/fluid or piping. This 

temperature is used by the program to determine whether temperature controls are 

required. It is typically the lowest value of the fluid degradation temperature, the 

piping expansion temperature, or the piping material withstand temperature 

(especially in the case of plastic piping).  

maximum ambient temperature 

The highest ambient temperature expected to occur at the location of the pipe or 

equipment using heat tracing.  

maximum CB (circuit breaker) size 

The largest circuit breaker the user is willing to use. The TraceCalc Pro program will 

only design heating cables circuits that are compatible with the lower of  (1) this 

breaker size or (2) factory defined circuit requirements.  

maximum equilibrium temperature 

The highest predicted equilibrium pipe temperature that occurs when the heating 

cable is continuously energized at the maximum ambient temperature (defined as 

runaway pipe temperature by IEEE 515). 

maximum fill height 

The height of the wet surface when the vessel is at its maximum fill level.  It is the 

distance between the lower edge of the side wall and the wet/dry surface interface.  
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Since the wet surface must be insulated, the Insulation Height must always be greater 

than or equal to the Maximum Fill Height. 

maximum heater exposure temperature 

The highest temperature to which the heating cable may be exposed intermittently. 

Defined as high-temperature excursions of not more than 48 hours in duration, with 

total cumulative exposure of less than 1000 hours.  This temperature is ignored for 

the purpose of predicting maximum heating cable sheath temperatures. 

maximum intermittent exposure temperature (power on or off) 

See maximum heater exposure temperature. 

maximum operating temperature 

The highest temperature of the heat-traced fluid during normal process operating 

conditions. Excursions of less than 1000 hours may be ignored. 

maximum spiral ratio 

Upper limit to the spiral ratio the program can consider for a particular heating cable. 

See spiral ratio. 

minimum ambient temperature 

The lowest expected ambient temperature at the location of the pipe or equipment 

using heat tracing. 

minimum heating cable spacing 

Minimum center-to-center distance of heating cables on a pipe. 

minimum fill height 

The height of the wet surface when the vessel is at its minimum fill level.  It is the 

distance between the lower edge of the side wall and the wet/dry surface interface.  

The minimum wet surface area is calculated using the minimum fill height to 

establish whether any part of the heated surface will ever be dry. 

non-hazardous  

An area where explosive or flammable materials are not present. Generally 

synonymous with ordinary area and unclassified location. See classified location. 

nozzle 

A section of pipe attached to the side or bottom of a vessel. 

off-pipe 

A component installation method where the component is not in contact with the 

pipe. 
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operating voltage 

The actual voltage applied to the heating cable when in service. 

ordinary area  

An area where explosive or flammable materials are not present. Generally 

synonymous with non-hazardous and unclassified location. See classified location. 

outdoor location 

The installation is subjected to environmental extremes, including exposure to a 

wind . 

outer insulation 

The thermal insulation installed farthest from the heated surface in two layer 

insulation installations. See two layer insulation. 

oversize insulation 

A term applied to thermal insulation when the thermal insulation inner diameter must 

be larger than the nominal outer diameter of a particular pipe in order to 

accommodate the heating cable. 

panelboard 

A single panel or group of panel units assembled in a single panel; it includes buses, 

automatic overcurrent devices. A panelboard may or may not have switches for the 

control of light, heat, or power circuits. Designed to be placed in a cabinet or cutout 

box placed in or against a wall or partition and accessible only from the front. 

parallel heating cable 

A heating cable with heating elements that are electrically connected in parallel, 

either continuously or in zones, such that watt density per unit length is 

approximately equal along the length of the heating cable (allowing for the drop in 

voltage down the length of the heating cable). 

parent 

A single heating cable with a power connection. Also referred to as a main-line. A 

user defined identification of a pipe segment for the purposes of organizing or 

simplifying the heat-tracing design. A segment of a pipe system that is isolated, or is 

connected to, and upstream of, a child segment for either electrical or flow purposes. 

For instance, a main fire water line would be the parent in a water line system 

containing main line and a branch. 

perimeter 

The distance around the cross-sectional area of the vessel support. 

pipe size 

The nominal diameter of the pipe. For tubing, the size and outside diameter are the 

same. 
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pipe support 

A device for supporting a section of pipe. 

pipe type 

Material construction of a pipe.  

power connection 

The means for making an electrical connection between a heating cable and the 

power distribution system. See component. 

power output 

The heat produced by a heating cable, typically expressed in watts. 

power-limiting heating cable 

A type of heating cable that shows PTC behavior based on the properties of a 

metallic heating element. The PTC behavior exhibited is much less (a smaller change 

in resistance in response to a change in temperature) than that shown by self-

regulating heating cables. 

project 

A TraceCalc Pro database file that contains the design parameters, specifications and 

components for a heat-traced application that the user designs. From this file, the 

user can generate useful reports for building/implementing the heat-traced 

application. 

project explorer pane 

TheTraceCalc Pro pane that users use to manage all the pipe lines and the electrical 

panels for a project. 

safety factor 

Degree of engineering conservatism. The additional confidence that the thermal 

design will meet or exceed the practical needs of the designer.  See heat loss safety 

factor. 

segment 

Section of piping system. 

self-regulating 

The inherent capability of polymer-core heating cables to inversely vary their power 

output in response to an increase or decrease in the actual temperature in the 

immediate vicinity of the heating cable. 
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sensor, sensing element 

The first system element that responds quantitatively and performs the initial 

measurement. In electrical heat-tracing systems, sensors respond to the temperature 

of the system and may be directly connected to controllers. Sensors can be 

mechanical (bulk and bellows, bimetallic) or electrical (thermocouple, RTD, 

thermistor). 

series heating cable 

Heating elements that are electrically connected in series with a single current path 

and have a specific resistance at a given temperature for a given length. See heater 

technology. 

setpoint 

Control variable used to determine required pipe system temperature. 

sheath 

The outermost continuous covering for the cable. 

sheath temperature 

The temperature of the outermost heating cable jacket covering that may be exposed 

to the surrounding atmosphere. 

signal light 

Light connected to heating cable circuit to give visual confirmation of available 

voltage. 

skirt wall thickness 

The thickness of a vessel skirt support. 

slab thickness 

The thickness (depth) of a vessel slab support. 

spiraling 

method of installing heating cable such that more than one, and typically less than 

two, lengths of heating cable are used for every unit length of pipe. See trace ratio. 

splice 

Electrical connection joining two heating cable segments. See component. 

stabilized design 

A design option for predicting the maximum sheath temperature of the heating cable 

without thermostatic control in a worst-case condition - no wind, highest pipe 

operating temperature, and the higher of highest ambient temperature or 104°F 

(40°C). 
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start-up temperature 

The lowest anticipated pipe equipment temperature at which the heating cable circuit 

will be energized.  

style 

The vessel body style is one of: horizontal cylinder, vertical cylinder, rectangle or 

sphere.  Top and bottom styles include flat, floating, half dome, full dome, cone, 

truncated cone and truncated pyramid. 

summary pane 

The TraceCalc Pro pane that users use to see summary results for a project or set of 

lines or vessels within a project.  This window lists specific information such as 

number of records needing recalculation, total pipe length and total heater length. 

support attachment 

Physical attachment used to anchor pipes and other pipe components to support 

structures. 

tee connection 

Electrical connection joining three heating cable segments. See component. 

thermal insulation 

Material that is designed to have a low thermal conductivity. Thermal insulation is 

placed on the outside of pipes and vessels to reduce the rate of heat loss. 

thermostat 

An electromechanical switch device that senses its surrounding temperature and 

activates a relay to control the flow of current to a downstream device. 

T-Rating 

Standards associations have established the T-rating, or temperature rating, as a 

means of classifying electrical equipment based on the maximum temperature an 

exposed surface may attain. The T-rating is identified as the “Temperature 

Identification Number” in the National Electrical Code (U.S.), as the “Temperature 

Code” in the Canadian Electrical Code, and as the “Temperature Class Number” in 

IEC standards. The purpose of the T-rating is to ensure that electrical equipment 

does not exceed the auto-ignition temperature of flammables that might be present in 

a hazardous location. 

trace ratio 

A design variable that describes the amount of heating cable used in a design per unit 

length of pipe. Fractional trace ratios will typically be installed by spiraling, while 

whole number trace ratios will typically be installed by running multiple lengths 

along the pipe. See spiraling. 
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two layer insulation 

An  insulation system where two insulation types are used, rather than one, to take 

advantage of the benefits (lower cost, higher temperature resistance, higher k-value, 

etc.) of each.  

UL 

Underwriters Laboratory. An approval organization that sets industrial safety 

standards. 

unclassified location 

An area where explosive or flammable materials are not present. Generally 

synonymous with ordinary area and non-hazardous location. See classified location. 

uncontrolled 

A control method where the heating cable system power is not controlled by input 

from any temperature sensor. 

uncontrolled temperature 

Maximum temperature a pipe or piping system will attain at maximum ambient 

temperature with nominal voltage applied and no electrical control of the circuit. 

under insulation 

Physical location under the thermal insulation and touching the pipe. 

units 

Dimension system used for design, either Metric or English. 

valve 

Piping device used to control flow. 

voltage 

The voltage available to power a heating cable.  

wind speed 

Scalar value of velocity of airflow over piping system. 

Zone 1 

Terminology used for classification of an industrial area in which an explosive 

atmosphere is likely to exist under normal operation. (Refer to the NEC, Article 505, 

and IEC 79-10 (1995) [B12] for a detailed definition.) 
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Zone 2 

Terminology used for classification of an industrial area in which an explosive 

atmosphere is not likely to occur in normal operation, and if they do, they will exist 

only for a short period. (Refer to the NEC, Article 505, and IEC 79-10 (1995) [B12] 

for a detailed definition.) 
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